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Chapter 1:

The APL Environment

Introduction

The Dyalog APL Development Environment includes a Session Manager, an Editor,
and a Tracer all of which operate in windows on the screen. The session window is
created when you start APL and is present until you terminate your APL session. In
addition there may be a number of edit and/or trace Windows, which are created and
destroyed dynamically as required. All APL windows are under the control of Win-
dows and may be selected, moved, resized, maximised and minimised using the stand-
ard facilities that Windows provides.

APL Keyboards

The Classic and Unicode Editions of Dyalog APL for Windows use different tech-
niques for mapping keystrokes to APL characters and to special command shortcuts.

The Classic Edition uses a proprietary technique for these mappings. The Unicode
Edition uses Microsoft’s IME (Input Method Editor) technology. Many other applic-
ations use the same technology, which means that the Dyalog Unicode IME may be
used not only with Dyalog APL for Windows Unicode Edition, but also with word
processing applications, spreadsheets, terminal emulators etc. Therefore with the
Dyalog Unicode IME installed, and with a suitable font selected, APL characters can
be entered and viewed in many other applications.

In both Classic and Unicode Editions APL characters are generated when the user
presses certain combinations of meta keys in conjunction with the normal character
keys. Meta keys include Shift, Ctrl and Alt.

For both input techniques it is possible to alter the mapping of keystrokes to APL
characters, and to add support for new languages. It is also possible to alter the key-
strokes which define special command keyboard shortcuts. For further details, see
Unicode Edition Keyboard on page 6 or Classic Edition Keyboard on page 10
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Unicode Edition and the Dyalog Unicode IME

The Dyalog Unicode IME is the input mechanism for generating APL characters for
Unicode editions of Dyalog APL. The version of the IME supplied with version 15.0
can be used with version 12.1 and later, provided that they are patched to a version
created on or after 15t April 2011.

The Dyalog Unicode IME defines the mapping of keystrokes to Unicode characters.
Only keystrokes which resolve to characters that either do not appear on the standard
keyboard or which differ from those that appear on the standard keyboard are
included in the selectable translate table. In effect the Dyalog Unicode IME can be
regarded as an overlay of the standard keyboard which contains just APL characters.

The Dyalog Unicode IME supplied with Version 15.0 includes support for Belgian,
Danish, Finnish, French, German, Italian, Spanish Swedish and British and American
English keyboards, based on the Dyalog hardware keyboard layout; these keyboard
layouts are described at http://dfns.dyalog.com/n_keyboards.htm. Note that for Dan-
ish, British and American English keyboards the older layouts, based on the Dyalog
APL Ctrl Keyboard, are included in the UnicodeIME\aplkeys directory.

The default keyboard mapping for unsupported languages is American English.

The IME translate tables include mappings for the special command keystrokes used
by Dyalog APL.

These command keystroke mappings are ignored by applications unless the applic-
ation is explicitly named in the Dyalog Unicode IME configuration. It is expected
that only terminal emulators used for running UNIX-based versions of Dyalog APL
will use this feature.

In particular, Dyalog APL for Windows Unicode Edition does not use the mappings
in the translate tables; the mappings are defined under Options/Configure/Keyboard
Shortcuts (see Installation & Configuration Guide: Configuration Dialog: Key-
board Shortcut Tab).

Note that the Dyalog Unicode IME replaces any previous IME, as well as the Dyalog
Ctrl and Dyalog AltGr keyboards.

Classic Edition

The mapping for each of the [JAV positions and its associated keystroke is defined by
a selectable translate table. JAV includes all the APL symbols used by Dyalog APL
as well as all the (non-APL) characters which appear on a standard keyboard. This
mapping only works with Classic Edition.

The Classic Edition installation also includes the Dyalog Unicode IME (described
below) so that users may enter APL characters into other applications; the Dyalog
Unicode IME is however not used by the Classic Edition itself.
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The Classic Edition includes support for Danish, Finnish, French, German, Italian,
Swedish, and both British and American English keyboards. The default keyboard
mapping for unsupported languages is American English.

Session Manager

The Dyalog APL/W session is fully configurable. Not only can you change the
appearance of the menus, tool bars and status bars, but you can add new objects of
your choice and attach your own APL functions and expressions to them. Functions
and variables can be stored in the session namespace. This is independent of the act-
ive workspace; so there is no conflict with workspace names, and your utilities
remain permanently accessible for the duration of the session. Finally, you may set
up different session configurations for different purposes which can be saved and
loaded as required.

The session window is defined by an object called JSE. This is very similar to a
Form object, but has certain special properties. The menu bar, tool bar and status bars
on the session window are in fact MenuBar, ToolControl and StatusBar objects
owned by [JSE. All of the other components such as menu items and tool buttons are
also standard GUI objects. You may use [JWC to create new session objects and you
may use OWS to change the properties of existing ones. OWG and OWN may also be
used with JSE and its children.
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Components of the session that perform actions (Menultem and Button objects) do so
because their Event properties are defined to execute system operations or APL
expressions. System operations comprise a pre-defined set of actions that can be per-
formed by Dyalog APL/W. These are coded as keywords within square brackets. For
example, the system operation [WSClear] producesa clear ws, after first dis-
playing a dialog box for confirmation. You may customise your session by adding or
deleting objects and by attaching system operations or APL expressions to them.

Like any other object, [JSE is a namespace that may contain functions and variables.
Furthermore, JSE is independent of the active workspace and is unaffected by

)LOAD and ) CLEAR. It is therefore sensible to store commonly used utilities, par-
ticularly those utilities that are invoked by events on session objects, in [JSE itself,
rather than in each of your application workspaces.

The possibility of configuring your APL session so extensively leads to the require-
ment to have different sessions for different purposes. To meet this need, sessions are
stored in special files with a .DSE (Dyalog Session) extension. The default session
(i.e. the one loaded when you start APL) is specified by the session_file parameter.
Y ou may customise this session and then save it over the default one or in a separate
file. You can load a new session from file at any stage without affecting your active
workspace.

Positioning the Cursor

The cursor may be positioned within the current APL window by moving the mouse
pointer to the desired location and then clicking the Left Button. The APL cursor
will then move to the character under the pointer.

Selection

Dragging the mouse selects the text from the point where the mouse button is
depressed to the point where the button is released. When you select multiple lines,
the use of the left mouse button always selects text from the start of the line. A con-
tiguous block of text can be selected by dragging with the right mouse button.

Double-clicking the left mouse button to the left of a line selects the whole line,
including the end-of-line character.

Scrolling

Data can be scrolled in a window using the mouse in conjunction with the scrollbar.
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Invoking the Editor

The Editor can be invoked by placing the mouse pointer over the name of an editable
object and double-clicking the left button on the mouse. If you double-click on the
empty Input Line it acts as "Naked Edit" and opens an edit window for the sus-
pended function (if any) on the APL stack. For further details, see Invoking the Editor
on page 115. See also "Installation and Configuration Guide: DoubleClickEdit".

The Current Object

If you position the input cursor over the name of an object in the session window,
that object becomes the current object. This name is stored in the CurObj property of
the Session object and may be used by an application or a utility program. This
means that you can click the mouse over a name and then select a menu item or click
a button that executes code that accesses the name.

The Session Pop-up Menu

Clicking the right mouse button brings up the Session pop-up menu. This is
described later in this chapter.

Drag-and-Drop Editing

Drag-and-Drop editing is the easiest way to move or copy a selection a short distance
within an edit window or between edit windows.

To move text using drag-and-drop editing:

1. Select the text you want to move.

2. Point to the selected text and then press and hold down the left mouse but-
ton. When the drag-and-drop pointer appears, drag the cursor to a new loc-
ation.

3. Release the mouse button to drop the text into place.

To copy text using drag-and-drop editing:

1. Select the text you want to move.

2. Hold down the Ctrl key, point to the selected text and then press and hold
down the left mouse button. When the drag-and-drop pointer appears, drag
the cursor to a new location.

3. Release the mouse button to drop the text into place.

If you drag-and-drop text within the Session window, the text is copied and not
moved whether or not you use the Ctrl key.
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Interrupts

To generate an interrupt, click on the Dyalog APL icon in the Windows System
Tray; then choose Weak Interrupt or Strong Interrupt. To close the menu, click
Cancel. Altematively, to generate a weak interrupt, press Ctrl+Break, or select
Interrupt from the Action menu on the Session Window.

Unicode Edition Keyboard

Introduction

Unicode Edition supports the use of standard Windows keyboards that have the addi-
tional capability to generate APL characters when the user presses Ctrl, Alt, AltGr (or
some other combination of meta keys) in combination with the normal character
keys.

Dyalog APL is supplied with the Dyalog Unicode IME keyboard for a range of dif-
ferent languages as listed below. The intention is that only APL characters and char-
acters that appear in locations different from the underlying keyboard are defined;
any other keystroke is passed through as is.

Installation

During the Installation of Dyalog APL Unicode Edition, setup installs the Dyalog
Unicode IME (IME). For any given Input Language the IME consists of an additional
service for that Input Language, and a translate table which maps keystrokes for the
appropriate keyboard to Unicode code points for APL characters

An IME service is installed for every Input Language that the user who installs
Dyalog APL has defined, as well as every Input Language for which Dyalog has sup-
port.

The keyboard mappings are defined for the following national languages: Belgian,
Danish, Finnish, French, German, Italian, Spanish, Swedish and British and Amer-
ican English

These mappings are described at http://dfns.dyalog.com/n_keyboards.htm.

For any other Input Language the American English translate table is selected. Note
that some Input Languages are defined to be substitutes for other Input Languages;
for example Australian English Input is a substitute for American English Input, Aus-
trian German Input a substitute for German German Input. In these cases the IME will
install the appropriate translate table. It is also possible to create support for new lan-
guages or to modify the existing support. See the IME User Guide for further details.
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Configuring the Dyalog APL IME

The Dyalog Unicode IME is added as an additional service to all keyboards defined
to the user and the administrator at the time that the IME was installed.

For each IME the underlying keyboard layout file will be the same as that defined for
the base keyboard. The layout file is a DLL created by Microsoft.

The language specified in the description of the IME is the name of the IME translate
table that has been associated with the IME for the specific keyboard. In the case of
languages not supported by the IME the keyboard will default to en-US.

IME Properties

To change the properties of the IME go to Options/Configure/Unicode Input tab
and select Configure Layout:

% Dyalog APL/W-64 Configuration

Log Trace/Edit Auto Complete SALT User Commands Object Syntax
General Unicode Input Keyboard Shortcuts Workspace Help / DMX Windows Session

Dyalog can automatically load pour selected kepboard when the session window is made visible:

Activate selected keyboard [ Shaw keyboards for all languages
k.epboard:
|D_l,lalog APL IME [erGE] -

Configure Lapout. ..

==
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Dyalog APL Input Method Editor Properties

General  Ahout

Input Translate T able:

I:Z:"-.F'n:u:uarn FilezhDyalogiUnicodel ME\aplkeyshen-GB.din Browse. .

Enable Overstrikes
[] Overstrikes do not require the 05" introducer key [experimental]

[] Use Overstiike popup

Cancel Apply

Input translate table:

The translate table defines the mapping between APL characters and the keystrokes
that generate those APL characters. It is possible to alter the mapping or to create sup-
port for new keyboards by altering the translate table, or by selecting a different trans-
late table. See the IME User Guide for more details.

Overstrikes:

In the original implementations of APL, many of the special symbols could only be
generated by overstriking one character on top of another as is reflected in the appear-
ance of the glyphs. For example, the symbol for Grade Up (4) is actually the symbol
for delta (A) superimposed on the symbol for vertical bar (])

In Dyalog APL such symbols can be generated either by a single keystroke, or (in
Replace mode) by overtyping one symbol with another. For example 4 may be gen-
erated using Shift+Ctrl+4, or by switching to Replace mode and typing the three key-
strokes Ctrl+h, Left-Cursor, Ctrl+m.

Using the Dyalog Unicode IME the character can also be entered by pressing
Ctrl+Bksp, Ctrl+m, Ctrl+h. Note that Ctrl+Bksp is the default Overstrike Introducer
Key (key code OS).
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Use Overstrike popup:

With this option selected, when the character following the Overstrike Introducer
Key is pressed, a popup box displays all the overstrikes which contain the last char-
acter typed: in the example below Ctrl+Bksp has been followed by Ctrl+h:

A CLEAR WS - Dyalog APL/W-564

File Edit View Windows Session Log Action Options Tools Threads

Help
Ws 5 @ M % | Object [} g1 &= 7 Bi |4 Tool | Edit |- Session
Language Bar x | X
== =s | [
[ BIEl[oBlel'[2] [MILS[H s[RI MR [t | g
A ~
A
7
v|| 8
-
Debugger 90 x |W
Ready... Ins NUM

CurObj: A (U &:1 OoQ:0 OTRAP  [OSI:0 [OI0:1 [OML:1

Note the fine (red) line under the A in the Session window. This indicates that an
overstrike creation operation is in progress.

The input of the symbol A can be completed by pressing Ctr+m, or by moving the
selection up and down the pop-up list using Cursor-Up or Cursor-Down.

Overstrikes do not require the OS introducer key (exper-
imental):

With this option selected, the IME identifies characters which are part of a valid over-
strike, and when such a character is entered into the session, begins an overstrike cre-
ation operation. This mode remains experimental in Version 15.0.
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Classic Edition Keyboard

The standard Version 13.2 Classic Edition keyboard tables are files supplied in the
aplkeys sub-directory named cc.din where cc is the standard 2-character country
code,e.g. uk.din.

Note that the standard tables do not support the entry of APL underscored characters
AABCDEFGHIJKLMNOPQRSTUVWXYZ.

The standard table supports two modes of use; traditional (mode 0) and unified
(mode 1). The keyboard starts in mode 1 and may be switched between modes by
clicking the Uni/Apl field in the status bar or by keying * on the Numeric-Keypad.

Unified Layout

The following picture illustrates the standard UK keyboard Unified layout.

File Edt Wiew Keyboard Options Help
| F1] F2| F3| Fa Fs

| F?l : | F9 [ Fll"| Fl“ll E,..M:l

'I1|2l31‘*lﬁlﬁl?|ﬂlﬂlﬂl-l=l

oo ef ] t] ol o] ifo]elefa]™
| o s|afelofn]sfkfa]:] " ]u]
1] 5 o] o | ]
™ ctrl| | {Blank> | m | ™ ctr1|
| COMO oM

C:\Program Files\DyaloghDivalog APL 12.1 Classichaplkeys'uk.din - Keyboard=UK 241




Chapter 1: The APL Environment 11

APL symbols are entered using the Ctrl and Ctrl+Shift keys as illustrated below.

File Edt View Keyboard Options Help
Esc | F25| F2e| F27| F28| F23| Fao| Fa1| F3z| F33| F34| Fas| Fas
23 10| | s ] = ) ] ) el ] )

Exec
Sl Il N I N I N N N I S

L2 NS L T R A A
LI A N A S N U O S e i
M Ctrl | | ¢Blank> | miaiter | = ctel |

| CMo & |

|C:\Program Files\Dyalog\Dyalog APL 12.1 Classichapkeys\uk.din - Kegboard=UK * | 1241

File Edt View Keyboard Options Help

ese || ||

T

|
&Ie
|

=l ef o] sl ofafelofxfe] fa]
) O O | =|_|#]o]s]

L2 O O N R
B0 NN A N ) e i
¥ Ctrl | | {Blank} | miaiter | = ctrl|

| C MO M1

|C:\Program Fies\Dyalog\Dyalog APL 12.1 Classichapkeys\uk.din - Keyboard=UK * | 24,1
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Traditional Layout

The following picture illustrates the standard UK keyboard Traditional layout.

Fle Edt View Keyboard Options Heb
esc| F1| F2| Fa| Fa| rs| Fe| F7 | Fa| Fa| Fio| F1| Fiz|

o 1]2f|af4ls|e|2]efofof ||
ol afm]|efm] | v]u|1]o]r|]-]

el s|o|F]s]u]a]k]]c]a] e

Ft | el z|x|c]uls|n|n|l.].-| |rt]
I~ ctrl | | {Blank} | miaiter | - ctrl
| o cw

|L'.t‘\F'1wm Files\DyaloghDyalog APL 12,1 Classichaplkeysuk. din - Keyboard=LIK |24.1

APL symbols are entered using the Shift and Ctrl+Shift keys as illustrated below.

Fle Edt Vew Keyboard Options Heb
Esc | F13| F14| Fis| Fie| F17| F18| 13| F2o| F21| F22| F23| Fa4f

38l il S S N N TN N U
Sl I N N I N S N
L2 S L Y N R - e
R M S NS N S O N O N
I ctrl | | CBlank> | Iriaiter | Fictel|
| & MO C M|

|Et‘-.Fmgun Files\DyaloghDyalog APL 12.1 Classichaplkeysuk.din - Keyboard=UK * |24
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Fle Edk View Keyboard Options Help
YR e v o e v v o
g2 | K I | et ) S e I e I
T 0 1
A O O N U
S0 N U U Y Y O N
@ ctrl | | (Blank> | = | = cte1]
| MO M
C:\Program Files\Dyalog\Dyalog APL 12.1 Classichaplkeys\uk. din - Keyboard=UK * 241

Line-Drawing Symbols

Classic Edition includes 12 single-line graphics characters for drawing lines and
boxes. Line-drawing characters are entered using the keys on the numeric keypad in
conjunction with the Ctrl key as shown below. NumLock must be on.

Normal Ctrl
7 8 9 r T L
4 5 6 |— _|. _|
1 2 3 L 4 4
0 : | -

Note: in order to accommodate other characters, line-drawing symbols are located in
the non-printable area of the font layout. Although these characters can normally be
used in output to the session (function: DISP in the UTIL workspace uses them),
many printer drivers and some display drivers will not display characters from
these positions in the font.
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Keyboard Shortcuts

The terms keyboard shortcut (Unicode Edition) and command (Classic Edition) are
used herein to describe a keystroke that generates an action, rather than one that pro-
duces a symbol.

Unicode Edition

Unicode Edition provides a number of shortcut keys that may be used to perform
actions. For compatibility with Classic Edition and with previous Versions of
Dyalog APL, these are identified by 2-character codes; for example the action to start
the Tracer is identified by the code <TC>, and mapped to user-configurable key-
strokes.

In the Unicode Edition, Keyboard Shortcuts are defined using Option-
s/Configure/Keyboard Shortcuts and stored in the Windows Registry. Note that the
Unicode IME translate tables have definitions for the Keyboard Shortcuts too; these
are ignored by the interpreter, and are intended for use with terminal emulators being
used in conjunction with non-GUI versions of Dyalog APL.

To the right of the last symbol in the Language Bar is the Keyboard Shortcut icon

. If you hover the mouse over this icon, a pop-up tip is displayed to remind you
of your keyboard shortcuts as illustrated below.
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File Edit View Windows Session Leg Action Options Tools Threads Help
W5 5 & W % | Object (3 4] @& A |Tool P 57 iZ @ Edit § & 9 Q  Session APL285 Unicod= NG HIRGE

LETTTERRIEETT sovsomsrsasiassnnss st o s soosss T T ——— ) ]
[ FERE=B[T] (TR FEREEE [0 [l [Elelefe [ DOBERELR R0 &g

Dyaleg APL/W-6% Yersion 15.0.27165
Seriasl No : 000042
Unicede Edition © Keyboard Shortcuts
Beta relesse QT: Quit (end lose changes): Shift+Esc
Tue Apr 19 15:16:54% 2016 TB: Tab between windows: (None)
clear ws BT: Back Tab between windows: (None)
£P: Exit (and save changes): £sc
RS: Right Screen: (None)
LS: Left Screen: (None)
CT: Cut: (None)
CP: Copy: (None}
PT: Paste: (None}
RD: Reformat: Num divide
DK: Delete Block: Control+Delete
FD: Forwerd or Rede: Control+Shift+Enter
8K: Backward or Undo: Control+5hift+Back
SC: Search: (Nene}
RP: Replace: (None)
NX: Next: (None)
PV: Previous: (None)
ED: Edit: Shift+Enter
TC: Trace: Control+Enter
FX: Fix the current function: (None}
LN: Toggle Line numbers: Num -
BH: Run to exit (in tracer): (None}
8P: Toggle breakpoint: (None)
RM: Resume execution (in tracer):  (Nene)
TL: Teggle localisation: Control+Up
UA: Undo all changes: (Nene}
A0: Add comments: (None)
DO: Del comments: (None)
GL: Go to Line: (None)
Sa: Select all: (None)
RZ: Snap window size: (None)
AC: Align Comments: (None}
MA: Resume all threads (in tracer): (None)
OF: Open file in editor: (None)
$F: Save File in editor: (None)
SF: Save File "As” in editor: (Nene)
TO: Teggle outline: (Nene}
MO: Gote matching outline: (None)
Si: Fix script and exit editor: (Nene)
§2: Fix script but remain in editor: (None) =
DEBUGEEr e @0 % W

Ready. .. Ins  NUM
Cur0bj+ g1 OpQ:0 ' OTRAP | [SI:0  DOIO:1 [OML:t
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Classic Edition

Commands fall into four categories, namely cursor movement, selection, editing dir-
ectives and special operations, and are summarised in the following tables. The input
codes in the first column of the tables are the codes by which the commands are iden-
tified in the Input Translate Table.

Table 1: Cursor Movement Commands

Input .

Code Keystroke Description

LS Ctrl+PgUp Scrolls left by a page

RS Ctrl+PgDn Scrolls right by a page

us PgUp Scrolls up by a page

DS PgDn Scrolls down by a page

LC Left Arrow Moves the cursor one character position to the left

RC Right Arrow Moves the cursor one character position to the
right

DC Down Arrow Moves t.he cursor to the currenF character position
on the line below the current line

uc Up Arrow Moves t_he cursor to the curreth character position
on the line above the current line

UL Ctrl+ Home M.ove the cursor to the top-left position in the
window

DL Ctrl+End Move.s the cursor to the bottom-right position in
the window

RL End Moves the cursor to the end of the current line

LL Home Moves the cursor to the beginning of the current
line

LW Ctrlt Left Arrow Moves the cursor to the beginning of the word to
the left of the cursor

Ctrl+Right Moves the cursor to the end of the word to the
RW .
Arrow right of the cursor
TB Ctrl+Tab Switches to the next session/edit/trace window
BT Ctrl+Shift+Tab | Switches to the previous session/edit/trace window
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Table 2: Selection Commands

Input N
Code Keystroke Description
Le Shifi+ Left Arrow Extends the selection one character position to
the left
Re Shift+Right Extends the selection one character position to
Arrow the right
Ctrl+Shift+Left | Extends the selection to the beginning of the
Lw
Arrow word to the left of the cursor
Ctrl+Shift+Right | Extends the selection to the end of the word to
Rw .
Arrow the right of the cursor
Uc Shift+Up Arrow Eth—‘:I.ldS the sele(j‘tlon to the current cha.racter
position on the line above the current line
De Shift+Down Extends the selection to the current character
Arrow position on the line below the current line
Ll Shifi+ Home Extends .the selection to the beginning of the
current line
RI Shifi+End Extends the selection to the end of the current
line
Ul Ctrl+ Shift+ Home Extel.lds the gelectlon to the beginning of the first
line in the window
DI Ctrl+Shift-End Exten.ds the selection to the end of the last line in
the window
Us Shift+PgUp Extends the selection up by a page
Ds Shift+PgDn Extends the selection down by a page
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Table 3: Editing Directives

ICn;);l: Keystroke Description
DI Delete Deletes the selection
Del he current line in an Edit win .
DK Ctrl+Delete DZIZE: ;efez?edeliiles ?n thi Se:sito:;v LS;W
CT Shifi+ Delete E{I?Ir:;oox;iz the selection and copies it to the
CP Ctrl+Insert Copies the selection into the clipboard
FD Ctrl+Shift+Enter | Reapplies the most recent undo operation
BK Ctrl+Shift+Bksp | Performs an undo operation
PT Shifi+ Insert C(?pies the contents .of the clipboard into a
window at the location selected
OP Ctrl+Shifi-Insert :Ls:r(t:dziltzia;rll(bl/i)ne immediately after the current
HT Tab Indents text
TH Shift+Tab Removes indentation
RD Keypad-slash Reformats a function (editor only)
TL Ctrl+Alt+L Toggles localisation of the current name
GL Ctrl+Alt+G Go to [line]
AO Ctrl+Alt+, Add Comments
DO Ctrl+Alt+. Delete Comments
AC Align Comments
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Table 4: Special Operations

21(?(111: Keystroke Description

IN Insert Insert on/off

LN Keypad-minus | Line numbers on/off
ER Enter Execute

ED Shift+Enter Edit

TC Ctrl+Enter Trace

EP Esc Exit

QT Shift+Esc Quit
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The Session Colour Scheme

Within the Development Environment, different colours are used to identify different
types of information. These colours are normally defined by registry entries and may
be changed using the Colour Configuration dialog box as described later in this
chapter.

In the Classic Edition, colours may alternatively be defined in the Output Translate
Table (normally WIN.DOT). This table recognises up to 256 foreground and 256
background colours which are referenced by colour indices 0-255. These colour
indices are mapped to physical colours in terms of their Red, Green and Blue intens-
ities (also 0-255). Foreground and background colours are specified independently as
Cnnn or Bnnn. For example, the following entry in the Output Translate Table
defines colour 250 to be red on magenta.

C250: 255 0 O + Red foreground
B250: 255 0 255 + Magenta background

The first table below shows the colours used for different session components. The
second table shows how different colours are used to identify different types of data
in edit windows.

Table 5: Default Colour Scheme - Session

Colour Used for Default

249 Input and marked lines Red on White

250 Session log Black on White

252 Tracer : Suspended Function Yellow on Black

253 Tracer : Pendent Function Yellow on Dark Grey
245 Tracer : Current Line White on Red
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Table 6: Default Colour Scheme Edit windows

Colour |Array Type Editable |Default

236 Simple character matrix Yes Green on Black
239 Simple numeric No White on Dk Grey
241 Simple mixed No Cyan on Dk Grey
242 Character vector of vectors Yes Cyan on Black
243 Nested array No Cyan on Dk Grey
245 0OR object No White on Red

248 Function or Operator No White on Dk Cyan
254 Function or Operator Yes White on Blue

Syntax Colouring in the Session

As an adjunct to the overall Session Colour Scheme, you may choose to apply a syn-
tax colouring scheme to the current Session Input line(s). Y ou may also extend syn-
tax colouring to previously entered input lines, although this only applies to input
lines in the current session; syntax colouring information is not remembered in the

Session Log.

Syntax colouring may be used to highlight the context of names and other elements
when the line was entered. For example, you can identify global names and local

names by allocating them different colours.

See Installation & Configuration Guide: Colour Selection Dialog for further details.
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The Session Window

The primary purpose of the session window is to provide a scrolling area within
which you may enter APL expressions and view results. This area is described as the
session log. Normally, the session window will have a menu bar at the top with a
tool bar below it. At the bottom of the session window is a status bar. However, these
components of the session may be extensively customised and, although this chapter
describes a typical session layout, your own session may look distinctly different. A
typical Session is illustrated below.
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A typical Session window

Window Management

When you start APL, the session is loaded from the file specified by the session_file
parameter. The position and size of the session window are defined by the Posn and
Size properties of the Session object JSE, which will be as they were when the ses-
sion file was last saved.

The name of the active workspace is shown in the title bar of the window, and
changes if you rename the workspace or ) LOAD another.

You can move, resize, minimise or maximise the Session Window using the standard
Windows facilities.
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In addition to the Session Window itself, there are various subsidiary windows
which are described later in the Chapter. In general, these subsidiary windows may
be docked inside the Session window, or may be stand-alone floating windows. You
may dock and undock these windows as required. The standard Session layout illus-
trated above, contains docked Editor, Tracer and SIStack windows.

Note that the session window is only displayed when it is required, i.e. when APL
requests input from or output to the session. This means that end-user applications
that do not interact with the user through the session will not have an APL session
window.

Docking

Nearly all of the windows used in the Dyalog APL IDE may be docked in the Ses-
sion window or be stand-alone floating windows. When windows are docked in the
Session, the Session window is split into resizable panes, separated by splitters. The
following example, using the Status window, illustrates the principles involved.
(The use of the Status window is described later in this Chapter.)

To start with, the Status window is hidden. You may display it by selecting the
Status menu item from the Tools menu. It initially appears as a floating (undocked)
window as shown below.
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Language Bar X | X

= T - |0
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Dyalog APL/W-6% Version 15.0.27165 ~
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Unicode Edition
Bets release
Tue Apr 19 15:36:42 2016
clear ws

™ Status

File Options

Close

Editor

Debugger a0 x
Ready. . . Ins NUM

Cur0bj: B:1 ObQ:0 OTRAP [OSI:0 [0IO:1 [ML:1
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If you press the left mouse button down over the Status window title bar, and drag it,

you will find that when the mouse pointer is close to an edge of the Session window,
the drag rectangle indicates a docking zone as shown below. This indicates the space
that the window will occupy if you now release the mouse button to dock it.

Editor

B clear L/W-64 — u] X
File Edit View Windows Session Log Action Options Tools Threads Help
Ws 5 Gl gl Wl %y | Object (] £) @ B (R
T e e 53 E
o e Y A S e S DR B S e lg] o
Byalog APLJW-€4 Version 15.0.27165 | .
erial No : 000042
nicode Edition
eta relesse
ue Apr 19 15:36:42 2016
lear ws -
oW Status — [m]
R
Close
v
Deb a0 x
Ready. .. Ins  NUM
2:1 0DQ:0 [OTRAP [OSI:0 OIO:1 [ML:t

CurObj+
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The next picture shows the result of the docking operation. The Session window is
now split into 2 panes, with the Status window in the upper pane and the Session log
window in the lower pane. You can resize the panes by dragging with the mouse.

You will notice that a docked window has a title bar (in this case, the caption is
Status) and 3 buttons which are used to Minimise, Maximise and Close the docked

window.
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The next picture shows the result of minimising the Status window pane. All that
remains of it is its title bar. The Minimise button has changed to a Restore button,

which is used to restore the pane to its original size.
- CLEARWS - Dyalog APL/W-64
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You can pick up a docked window and then re-dock it along a different edge of the
Session as illustrated below.
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Docking the Status window along the left edge of the Session causes the Session win-
dow to be split into two vertical panes. Notice how the title bar is now drawn ver-

tically.
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If you click the right mouse button over any window, its context menu is displayed.
Ifthe window is dockable, the context menu contains the following options:

Undocks the docked window. The window is displayed at

Undock .. . . . .

ndoc whatever position and size it occupied prior to being docked
Hlde. Hides the title bar of the docked window
Caption

Specifies whether the window is currently dockable or is locked
Dockable | in its current state. You can use this to prevent the window from
being docked or undocked accidentally

The last picture shows the effect of using Hide Caption to remove the title bar. In this

state, you can resize the pane with the mouse, but the Minimise, Maximise and Close

buttons are not available. However, you can restore the object's title bar using its con-
text menu.
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Entering and Executing Expressions

Introduction

The session contains the input line and the session log. The input line is the last line
in the session, and is (normally) the line into which you type an expression to be eval-
uated.

The session log is a history of previously entered expressions and the results they pro-
duced.

If you are using a log file, the Session log is loaded into memory when APL is started
from the file specified by the log_file parameter. When you close your APL session,
the Session log is written back out to the log file, replacing its previous contents.

In general you type an expression into the input line, then press Enter (ER) to run it.
After execution, the expression and any displayed results become part of the session
log.

You can move around in the session using the scrollbar, the cursor keys, and the
PgUp and PgDn keys. In addition, Ctrl+Home (UL) moves the cursor to the begin-
ning of the top-line in the Log and Ctrl+End (DL) moves the cursor to the end of the
last (i.e. the current) line in the session log. Home (LL) and End (RL) move the cursor
to the beginning and end respectively of the line containing the cursor.

Deleting Lines

You may delete one or more lines from the Session using the DK command (Ctrl+De-
lete). This action removes the current line or the selected block of lines from the Ses-
sion window and from the Session log. The removal is permanent and you will be
prompted to confirm:

Meodify Session Log

This will permanently modify the sessicn log
i l % Areyou sure you want to do this?
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Language Bar

The Language Bar is an optional window which is initially docked to the Session
Window, to make it easy to pick APL symbols without using the keyboard.

If you hover the mouse pointer over a symbol in the APL Language Bar, a pop-up tip
is displayed to remind you of'its usage. If you click on a symbol in the Language Bar,
that symbol is inserted at the cursor in the current line in the Session.
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Auto Complete

Asyou start to enter characters in an APL expression, the Auto Complete suggestions
pop-up window (AC for short) offers you a choice based upon the characters you
have already entered and the current context.

For example, if you enter a [1, AC displays a list of all the system functions and vari-
ables. If you then enter the character r, the list shrinks to those system functions and
variables beginning with the letter r, namely (refs,dr |, and Ort L. Instead of
entering the remaining characters, you may select the appropriate choice in the AC
list. This is done by pressing the right cursor key.

If you begin to enter a name, AC will display a list of namespaces, variables, func-
tions, operators that are defined in the current namespace. If you are editing a func-
tion, AC will also include names that are localised in the function header.

If the current space is a GUI namespace, the list will also include Properties, Events
and Methods exposed by that object.
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As an additional refinement, AC remembers a certain number of previous auto com-
plete operations, and uses this information to highlight the most recent choice you
made.

For example, suppose that you enter the two characters ) c. AC offers you )clear
thru' ) cs, and you choose ) cs from the list. The next time you enter the two char-
acters ) ¢, AC displays the same list of choices, but this time ) cs is pre-selected.

You can disable or customise Auto Completion from the Auto Complete page in the
Configuration dialog box which is described later in this chapter.

Executing an Expression

To execute an expression, you type it into the input line, then press Enter (ER).
Alternatively, you can select Execute from the Action menu. Following execution,
the expression and any displayed results become part of the session log.

Instead of entering a new expression in the input line, you can move back through
the session log and re-execute a previous expression (or line of a result) by simply
pointing at it with the cursor and pressing Enter. Alternatively, you can select
Execute from the Action menu. You may alter the line before executing it. If you do
so, it will be displayed using colour 249 (Red on White), the same as that used for
the input line. When you press Enter the new line is copied to the input line prior to
being executed. The original line is restored and redisplayed in the normal session
log colour 250 (Black on White).

An alternative way to retrieve a previously entered expression is to use
Ctrl+Shift+Bksp (BK) and Ctrl+Shift+Enter (FD). These commands cycle backwards
and forwards through the input history, successively copying previously entered
expressions over the current line. When you reach the expression you want, simply
press Enter to re-run it. These operations may also be performed from the Edit menu
in the session window.

Executing Several Expressions

You can execute several expressions, by changing more than one line in the session

log before pressing Enter. Each line that you change will be displayed using colour

249 (Red on White). When you press Enter, these marked lines are copied down and
executed in the order they appear in the log.

Note that you don't actually have to change a line to mark it for re-execution; you
can mark it by overtyping a character with the same character, or by deleting a lead-
ing space for instance.
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It is also possible to execute a contiguous block of lines. To do this, you must first
select the lines (by dragging the mouse or using the keyboard) and then copy them
into the clipboard using Shift+Delete (CT) or Ctrl+Insert (CP). You then paste them
back into the session using Shift+Insert (PT). Lines pasted into the session are always
marked (Red on White) and will therefore be executed when you press Enter. To
execute lines from an edit window, you use a similar procedure. First select the lines
you want to execute, then cut or copy the selection to the clipboard. Then move to
the session window and paste them in, then press Enter to execute them.

Session Print Width (PW)

Throughout its history, APL has used a system variable [JPW to specify the width of
the user's terminal or screen. Session output that is longer than [JPW is automatically
wrapped and split into multiple lines on the display. This feature of APL was
designed in the days of hard-copy terminals and has become less relevant in modern
Windows environments.

Dyalog APL continues to support the traditional use of JPW, but also provides an
alternative option to have the system wrap Session output according to the width of
the Session Window. This behaviour may be selected by checking the Auto PW
checkbox in the Session tab of the Configuration dialog box.

Using Find/Replace in the Session

The search and replace facilities work not just in the Editor as you would expect, but
also in the Session. For example, if you have just entered a series of expressions
involving a variable called SALES and you want to perform the same calculations
using NEWSALES, the following commands will achieve it:

Enter SALES in the Find box,and NEWSALES in the Replace box. Now click the
Replace All button. You will see all occurrences of SALES change to NEWSALES.
Furthermore, each changed line in the session becomes marked (Red on White). Now
click on the session and press Enter (or select Execute from the Action menu).

Once displayed, the Find or Find/Replace dialog box remains on the screen until it is
either closed or replaced by the other. This is particularly convenient if the same oper-
ations are to be performed over and over again, and/or in several windows. Find and
Find/Replace operations are effective in the window that previously had the focus.
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Value Tips

If you hover the mouse pointer over a name in the Session or Debugger window,
APL will display a pop-up window containing the value of the symbol under the

mouse pointer.

For example, in the following picture the mouse pointer was moved over the name of
the variable HW in the Session window.
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The next picture illustrates the Value Tip displayed when the mouse is hovered over
the name of the variable MAT.
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Similarly, if you hover the mouse pointer over the name of a function, the system dis-
plays the body of the function as a pop-up, as illustrated below.
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Value Tips for External Functions

Value Tips can also be used to investigate the syntax of external functions. If you
hover over the name of an external function, the Value Tip displays its Function Sig-

nature.

For example, in the example below, the mouse is hovered over the external function

dt.AddMonths and shows that it requires a single integer as its argument.
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Should the external function provide more than one signature, they are all shown in
the Value Tip as illustrated below. Here the function ToString has four different
overloads.
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Configuring Value Tips

You may enable/disable Value Tips and select other options from the General tab of
the Configuration dialog box as shown below.

You may experiment by changing the value of the delay before which Value Tips are
displayed, until you find a comfortable setting.

Note that the colour scheme used to display the Value Tip for a function need not
necessarily be the same colour scheme as you use for the function editor.

s Dyalog AP

Log Trace/Edit Auto Complete SALT User Commands Object Syntax
General Unicode Input Keyboard Shortcuts Workspace Help / DMX Windows Session

Recently usad fils list size; EI Show message box if gearch wraps
Underling URLs and links

Dizplay Yalue Tips after: I:I [ms]
Colowr Scheme: Diefauilt w

Enable Mative Look and Feel

Enable DPI Scaling of the interpreter and development enviranment

[ Enable DP Scaling of GUI application

Configuration saved in:
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Cancel
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Array Editor

The Array Editor! allows you to edit arbitrary arrays. It is invoked by either:

o Clicking the & icon in the Session toolbar when the mouse pointer is over
the name of a suitable variable.

« Calling the user command Jarray.edit, specifying the name of a suit-
able variable as its argument.

o Calling it directly via ONA

The Array Editor draws data using a format that is similar to the output of the
DISPLAY function. For example:

Array Editor

File Edit Actions Insert Options Help
MEH&S| 28 ~ Q| E|AC 123 a ¥ |

o =c BB BE B 2 | @

et cad e 1235 ,[''] c[ppw]

~
ICharacters IhBC aguy
INumbers: |0 1 I;, 56 |3.1q 5.6£723 [0J1
IScaI.ars:
IFector5= IFour score and seven years ago
IHatrices: 1 2 3 4
5 & 7 B
9 10 11 12
]
Type: Nested array =: 3 =fp: 5 pp: 2 p: 51 =:

I Array Editor Version 1 Release 1 © Copyright davidliebtag.com 2012, 2015
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Documentation

Full documentation for the Array Editor, including a list of the keystrokes it uses, is
available from the Help menu in the Array Editor's window.

Supported Arrays

The Array Editor supports arrays that consist solely of characters and/or numbers.
You may not use it to edit an array that contains an object reference or a [JOR.

Reject unsupported data

The way that the Arrays Editor reacts to unsupported arrays is determined by the
value of the Reject unsupported data option which is accessed by the
Options/Reject unsupported data menu item on the Array Editor menubar.

Ifthis is set to true (the default), and you try to edit an array containing an object ref-
erence, the Array Editor will refuse to start and the system will generate an error mes-
sage.

[SE.NumEd.numed: Unexpected error in array editor:

DOMAIN ERROR Argument contained data that is
neither simple or nested.

Ifthis option is cleared, the Array editor will start but you will not be able to do any-
thing. It is therefore advisable that you leave this option set.

Notes

o The Array Editor is supplied only with Unicode Editions of Dyalog
APL/W. Please visit www.davidliebtag.com for details about availability
and support for Classic Editions of Dyalog APL/W.

« Namespaces are not supported.

« Internal representations returned by [JOR are not supported.

« Only one instance of the Array Editor may be executed at a time.

o All calls to interpreter primitives use a value of 3 for (ML.

« Negative numbers must be represented using high minus signs. For example,
~3 not -3.
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Implementation

The Array Editor is implemented by a DLL named dlaedit.d11 (32-bit) or
dlaedit64.dll (64-bit).

The DLL exports two functions: DyalogEditArray and

DyalogEditArrayTitle. The latteris used when you click the é icon in the
Session toolbar (via the APL function JSE .NumEd.numed) and by the user com-
mand Jarray.edit

Calling the Array Editor Directly
If you wish to use the Array Editor directly, you may do so as follows using ONA1.

Forboth DyalogEditArray and DyalogEditArrayTit le the first argument
is the array to be edited, while the second argument is a place holder and should
always be 0

ForDyalogEditArrayTit le the 3rd argument is a character vector whose con-
tents are displayed in the caption of the array editor window.

The result is the newly altered array.

Examples

ONA'dlaedit.dl Ll |DyalogEditArray <pp >pp' A 32-bit
ONA'dlaedit.dll|DyalogEditArrayTitle <pp >pp <0C2[]' ~nm 32-bit

ONA'dlaeditélt.dll|DyalogEditArray <pp >pp' A 64-bit
ONA'dlaeditél.dlL|DyalogEditArrayTitle <pp >pp <0C2[]'A 64-bit

New«DyalogEditArray Old O
New<DyalogEditArrayTitle Old O Name

INote that these are not standard [INA calls, but rather use an extension to [NA, called Direct
Workspace Access. Dyalog does not intend to make this feature generally available at present: if
you are interested in this feature please contact sales@dyalog.com.



42 Ul Guide

SharpPlot Graphics Tools

Introduction

Included with Dyalog APL is the SharpPlot graphics library which is part of the
RainPro graphics package.

The Session toolbar includes a button Iﬁwhich calls SharpPlot to generate graphical
pictures of the contents of the Current Object (identified by the name under or to the
left of the cursor).

For example, if you have a numerical matrix in a variable called MAT, you can plot it
by first positioning the cursor on the name MAT in the Session window, and then

clicking the SharpPlot button [ in the Session toolbar.

Data Structures

The charting function can plot variables with the following data structures:

a simple numeric vector

a vector of simple numeric vectors

a simple numeric matrix

a matrix whose first row contains simple character vectors and whose other
elements are simple numerics. In bar and line charts, the column headings in
row 1 are used as x-axis labels.

a matrix whose first column contains simple character vectors and whose
other elements are simple numerics. In bar and line charts, the row headings
in column | are used as legends to annotate the different series.

a matrix whose first row and first column both contain simple character vec-
tors and whose other elements are simple numerics. In bar and line charts,
the column headings in row 1 are used as x-axis labels, and the row head-
ings in column 1 are used as legends annotate the different series.
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Example: Bar Chart Lk
Wine_Prices
1961 1964 1966
Lafite 8800 1342 1210
Latour 15400 2357.5 4600
Margaux 5980 672.5 920
Mouton Rothschild 6710 713 2070
Haut-Brion 13225 1840 1323
o5 Causeway chart viewer g@
File Zoom
Wine Prices
L6000
14000
12000
10000
BO00
G000
4000
2000
0 -
1961 1964 1966
T T aour R hlargaux B Movion Rothschild [ Haui-Brion
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Example: Line Chart £

First_Growths
1961 1964 1966 1970 1975 1976 1978 ...
Lafite 8800 1342 1210 605 1380 2070 920 ...
Latour 15400 2357.5 4600 2760 1552 978 1058
Margaux 5980 672.5 920 632 900 800 1208

o Causeway chart viewer
File  Zoom
First Growths
L8000
[ 6000 -
14000 ~
12000 -
10000 4
000
|'II|'.
.Il Il !
6000 4 /
|I ‘\\ II \ I'
I|II III-'l \\ fl' IIII A |l|ll
(I . [ \ / ,
4000 1 f ! y ; \/{ |
| ’-' \‘-\ 1 1 i
2000 ~ \ f W = g
EI | | | | | | | | | |
964 1970 1976 1981 1983 1986 1989 1994 1996 2000
— Lafie —— Latour —— Murgauy
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Implementation

The SharpPlot Wizard is called by clicking on the SharpPlot button in the Session
toolbar. The button has a Select callback which runs the function
[JSE.Chart.DoChart, which in turn calls the Jchart user command.

(SE.Chart.MyChart uses an instance of the SharpPlot graphics class to produce

a chart of your data, which it saves as a temporary file. It then calls the SharpPlot

viewer to display the file on your screen. SharpPlot can also be started using the
Jchart user command.

SharpPlot is a library of graphical subroutines, (originally written in APL and
machine-translated into C#) which is implemented as a .NET Namespace named
Causeway and supplied in the sharpplot.dll inthe Dyalog program directory.

Notes

Although JSE.Chart.MyChart is overwritten by successive uses of the graphical
button, it is deliberately not erased each time. This allows you to use MyChart asa
simple template to develop your own custom graphics function.

The image is stored in Microsoft Enhanced Metafile Format in a temporary file
whose name and location are generated automatically. The system does not delete
the temporary file after use. For further details, See Get TempFileName in the Win-
dows documentation.

The default program used to display the EMF file is SharpView.exe. You can opt
to use a different EMF viewer by setting the Charts\ViewCMDregistry key to
name another program, such as Windows Picture and Fax Viewer.

An attempt to plot the contents of a variable with an unsupported data structure (see
above) is handled entirely by error trapping and will result in an error message box
and perhaps messages in the Status window.
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The Session GUI Hierarchy

As distributed, the Session object JSE contains two CoolBar objects. The first,
named [JSE . cbtop runs along the top of the Session window and contains the tool-
bars. The second, named [JSE . cbbot, runs along the bottom of the Session win-
dows and contains the statusbars.

The menubar is implemented by a MenuBar object named [JSE . mb.

The toolbars in [JSE . cbtop are implemented by four CoolBand objects, bandtb1,
bandtb2,bandtb3 and bandtbk each containing a ToolControl named tb.

The statusbars in [JSE . cbbot, are implemented by two CoolBand objects ,
bandtb1 and bandtb2, each containing a StatusBar named sb.
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The Session MenuBar

The Session MenuBar (SE . mb) contains a set of menus as follows. Note that, unless
specified, the screen-shots are taken using Unicode Edition and the keyboard short-
cuts will be different in Classic Edition.

The File Menu

The File menu (OSE . mb . fi L e) provides a means to execute those APL System
Commands that are concerned with the active and saved workspaces. The contents of
a typical File menu and the operations they perform are illustrated below.

Mew

Open...

Save

Save As...

Export...

Export to Memaory

Close AppDomain
Drop...
Edit Text File...

Print...
Print Setup...

Continue

Exit

1 CAPrograrn Files\DyaloghDyalog APL-84 15.0 Unicodelws\buildse.dws
2 ChUsers\Pete’\Documents\Filos\useful DW5
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Table 7: File Menu Operations

Item Action Description

Prompts for confirmation, then clears

New [WSClear] the workspace

Prompts for a workspace file name,
Open [WSLoad] then loads it

Prompts for a workspace file name,
Copy [WSCopy] then copies it
Save [WSSave] Saves the active workspace

Prompts for a workspace file name,

Save As [WSSaveas] .
then saves it

Creates a bound executable, an OLE
Server, an ActiveX Control, or a NET
Export [Makeexe] Assembly. See Installation &
Configuration Guide: Creating
Executables and OLE Servers.

Export to [MakeMemory

Memory Assembly] Creates an in-memory NET Assembly

Close ) ‘

AppDomain [CloseAppDomain] | Closes NET App Domain

Drop [WSDrop] Prompts for'a workspace file name,
then erases it

E,dit Text [EditTextFile] Displays the Open Source File dialog

File to select a file to exit.

Print [PrintFnsInNS] Prints functions and operators in
current namespace

Print Setup |[PrintSetup] Invokes the print set-up dialog box

i the acti k i
Continue [Continue] Saves the active workspace in

CONTINUE.DWS and exits APL

Exit [Off] Exits APL
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Edit Text File

The Edit Text File menu item allows you to edit a Dyalog script file (.dyalog) or an
arbitrary text file. The system prompts you to choose the file as shown below:

A Open source file

&« v P e« OS({C) » MiServer_Alonissos » webcam v O Search webcam 2
Organize = MNew folder = @ @
MadCapl15.0 * MName Date modified Type S
MadcapOutpu Admin 19/04/201517:10  File folder
MiServer Code File folder
MiServer_Aloni Config File folder
confreg Data File folder
Core Examples File folder
. images File folder
Documentati
jbgames File folder
ErrorP
rerrages MiCart File folder
Bxtensions Scripts 19/04/2015 17: File folder
Intro Styles 19/04/2015 17:10 File folder
Pluglns @ index.dyalog 7/12/2014 16:47 Dyalog APL Script File
ServerData @ timelapse.dyalog 15/05/2015 12:31 Dyalog APL Script File
Utils @ webcam.dyalog 18/05/2015 17:00 Dyalog APL Script File
webcam
LI S p—, J_.._Iv < >
File name: |webcam.dya|og V| Dyalog source files (*.dyalog)  ~

The file is then displayed in the Editor, allowing you to change it and save it. See
Editing Scripts and Text Files on page 149.
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The Edit Menu

The Edit menu (OSE .mb . edi t) provides a means to recall previously entered input
lines for re-execution and for copying text to and from the clipboard.

Back Control+5hift+Back
Forward Control+Shift+Enter
Cut Control+Delete
Copy Control+Insert
Paste Shift+Insert
Find...
Replace...

Unicode Edition
Back Ctrl+Shift+Bksp
Forward Ctrl+Shift+Enter
Cut Ctrl+Delete
Copy Ctrl+c

Paste Unicode

Paste Mon-Unicode

Find...

Replace...

Classic Edition
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Table 8: Edit menu operations

Item Action Description
Displays the previous input line. Repeated
Back [Undo] use of this command cycles back through the
input history.
Displays the next input line. Repeated use of
Forward | [Redo] this command cycles forward through the
input history.
Cut [Delete] Cuts the selected text to the clipboard
Copy [Copy] Copies the selection to the clipboard
Pastes the text contents of the clipboard into
th ion log at th t location. Th
Paste [Paste] ¢ session log at the current location. The
new lines are marked and may be executed
by pressing Enter.
Paste Same as Paste, but gets the Unicode text from
. [Pasteunicode] |the clipboard and converts to JAV. Classic
Unicode .
Edition only
Paste Same as Paste, but gets the ANSI text from
Non- [PasteAnsi] the clipboard and converts to [JAV. Classic
Unicode Edition only
Find [Find] Displays the Find dialog box
Replace | [Replace] Displays the Find/Replace dialog box
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The View Menu

The View menu (OSE .mb . view) toggles the visibility of the Session Toolbar,
StatusBar, and Language Bar.

"  Toolbar
«  Statusbar

~  LanguageBar

Table 9: View menu operations

Item Action Description

Toolbar Shows/Hides Session toolbars
Statusbar Shows/Hides Session statusbars
LanguageBar Shows/Hides Language Bar

The Windows Menu

This contains a single action (OSE .mb . windows) which is to close all of the Edit
and Trace windows and the Status window.

Close all windows

Language Bar
Debugger b
Editor

Table 10: Window menu operations

Item Action Description

Close all Windows |[[CloseAll] |Closes all Edit and Trace windows

Note that [CloseAl L ] removes all Trace windows but does noft reset the State
Indicator.

In addition, the Window menu will contain options to switch the focus to any sub-
sidiary windows that are docked in the Session as illustrated above.
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The Session Menu

The Session menu (OSE .mb . session)provides access to the system operations
that allow you to load a session (JSE) from a session file and to save your current ses-
sion ((SE) to a session file. If you use these facilities rarely, you may wish to move
them to (say) the Options menu or even dispense with them entirely.

Open...
Save

Save As..,

Table 11: Session menu operations

Item | Action Description

Prompts for a session file name, then loads the session
from it, replacing the current one. Sets the File
property of [JSE to the name of the file from which the
session was loaded.

Open | [SELoad]

Saves the current session (as defined by [JSE) to the

Save | [SESave] session file specified by the File property of JSE

Prompts for a session file name, then saves the current
[SESaveAs] |session (as defined by [OSE) in it. Resets the File
property of JSE.

Save
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The Log

Menu

The Log menu (OSE .mb . Log) provides access to the system operations that manip-
ulate Session log files.

Mew

Open...

Save

Save

As...

Print...

Table 12: Log menu operations

Item | Action Description

New | [NewLog] Prorr.lpts for confirmation, then empties the current
Session log

Open | [OpenLog] Prompts for a Sgssion log file, then'loads it into
memory, replacing the current Session log

Save |[SaveLog] Saves .the .current .Session log in the current log file,
replacing its previous contents

Save Prompts for a file name, then saves the current

[SavelLogAs] } ..
As Session log in it
Print | [PrintLog] |Prints the contents of the Session log
The Action Menu

The Action menu (OSE .mb . act ion) may be used to perform a variety of operations
on the current object or the current line. The current object is the object whose name
contains the cursor. The current line is that line that contains the cursor. The Edit,
Copy Object, Paste Object and Print Object items operate on the current object. For
example, if the name SALES appears in the session and the cursor is placed some-
where within it, SALES is the current object and will be copied to the clipboard by
selecting Copy object or opened up for editing by selecting Edit.
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Edit... Shift+Enter
Trace...
Execute
Copy Object
Paste Object
Print Object...
Clear Stops
Interrupt
Reset
Table 13: Action menu operations
Item Action Description
Edit [Edit] Edit the current object
Executes the current line under the control of the
Trace [Trace]
Tracer
Execute | [Execute] Executes the current line
Copy . Copies the contents of the current object to the
Object [ObjCopy] clipboard
Pasjce [ObjPaste] Pastes the .contents of the. clipbogrd into the
Object current object, replacing its previous value
Print [ObjPrint] |Prints the current object
Object JFr ]
Cl 1 11 0STO ONITO TRACE
ear [ClearTSM] Cegrsa [JsTop, DMON Rand [
Stops settings
Interrupt | [Interrupt] | Generates a weak interrupt
Reset [Reset] Performs )RESET
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The Options Menu

The Options menu (OSE .mb.options)provides configuration options.

Ohbject Syntax

" Line Mumbers Mum -

~*  [Disable traps in sessicn

Configure...

Colours...

Table 14: Options menu operations

~  Expose GUI Properties
Expose Root Properties

Expose Session Properties

Item Action Description
Expose Exposes the names of
GUI [ExposeGUI] properties, methods and
Properties events in GUI objects
Expose Exposes the names of the
Root [ExposeRoot] properties, methods and
Properties events of the Root object
Expose Exposes the names of the
Session [ExposeSession] properties, methods and
Properties events of [JSE
. Toggle the display of line
Line . . .
[LineNumbers] numbers in edit and trace
Numbers .
windows on/off
Disables the error trapping
Disable mechanism used by
traps in [DisableTrapsAtSuspension]| :Trap and OTRAP. This
session can be useful in
debugging applications.
. Displays the
Confi .
onfigure | [Configure] Configuration dialog box
Displays the Col
Colours [ChooseColors] 1P a.ys .e otours
Selection dialog box
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The values associated with the Expose GUI, Expose Root and Expose Session
options reflect the values of these settings in your current workspace and are saved in
it. When you change these values through the Options menu, you are changing them
in the current workspace only.

The default values of these items are defined by the parameters default_wx, Prop-
ertyExposeRoot and PropertyExposeSE which may be set using the Object Syntax
tab of the Configuration dialog.

The Tools Menu

The Tools menu (OSE .mb . tools)provides access to various session tools and dia-
log boxes.

Explorer...
Search...
Status...

~  AutoStatus

Event Viewer

Properties...

Table 15: Tools Menu Operations

Item Action Description

Explorer |[Explorer] Displays the Workspace Explorer tool
Search [WSSearch] Displays the Workspace Search tool
Status [Status] Displays or hides the Status window

Toggle; if checked, causes the Status
AutoStatus | [AutoStatus] [window to be displayed when a new
message is generated for it

Event

. [EventViewer] |Displays or hides the Event Viewer
Viewer

Displays a property sheet for the current

Properties | [ObjProps] object
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The Threads Menu

The Threads menu (OSE .mb . threads) provides access to various session tools
and dialog boxes.

Show Threads...

~  Show Stack...
Show Token Pool...
Auto Refresh

"  Pause on Error
Pause all Threads
Resume all Threads

Restart all Threads

Table 16: Threads Menu Operations

Item Action Description
Show .
Threads [Threads] Displays the Threads Tool
Show Stack [[Stack] Displays the SI Stack window
Show Displays the Token Pool
Token Pool [TokenPool] window
Auto Refreshes the Threads Tool on
Refresh [ThreadsAutoRefresh] every thread switch
P
ause on [ThreadsPauseOnError] | Pauses all threads on error
Error
Pause all
[ThreadsPauseAll] Pauses all threads
Threads
Resume all
[ThreadsResumeAll] Resumes all threads
Threads
Restart all

[ThreadsRestartAll] Restarts all threads
Threads
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The Help Menu

The Help menu (OSE .mb . he L p) provides access to the help system which is pack-
aged as a single Microsoft HTML Help compiled help file named

help\dyalog.chm.

Documentation Centre

Read Me

Latest Enhancements
Language Help

Gui Help

Third Party Licences

Dyalog Web Site
Email Dyaleg

About Dyalog APL

Table 17: Help menu operations

Label Action Description

Opens your web browser on
Documentation help\index.html which displays an

DocCenter . . .

Center [ ] index to the on-line PDF documentation

and selected internet links

Opens help\dyalog. chm, starting at
Latest the first topic in the Version 15.0

[RelNotes] Release Notes section. Note that

Enhancements .

previous Release Notes are also

included for your convenience.

Opens help\dyalog.chm, starting at
Language Help | [LangHelp] the first topic in the Language

Reference section

Opens help\dyalog. chm, starting at
Gui Help [GuiHelp] the first topic in the Object Reference

section
Third Party ‘ Opens hel}.)\.dyalog .chm, startigg at

. [LicenceHelp] |the first topic in the Licences for third-

Licences

party components
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Label Action Description

Dyalog Web
Site

Opens your web browser on the Dyalog

[DyalogWeb] home page

Opens your email client and creates a
new message to Dyalog Support, with
information about the Version of
Dyalog APL you are running

Email Dyalog |[DyalogEmail]

About Dyalog

APL [About] Displays an About dialog box
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Session Pop-Up Menu

The Session popup menu (SE . popup) is displayed by clicking the right mouse but-
ton anywhere in the Session window.

Edit

Chart Wizard

Cut Shift+Delete
Copy Control+Insert
Paste Shift+|nsert

Paste Unicode
Paste Mon-Unicode
Copy Object

Paste Object

W Line Mumbers Mum -

Align Comments

Explorer...
Search...
Event Viewer...
Threads...
Status...
Colours...

Interrupt

Ifthe mouse pointer is over a visible object name, the popup menu allows you to
edit, print, delete it or view its properties. Note that the name of the pop-up menu is
specified by the Popup property of JSE.
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Table 18: Session popup menu operations

Item Action Description
Edit [Edit] Edits the current object
Chart . .
. Ose.Chart.DoChart [ Opens Chart Wizard on current object
Wizard
Print [ObjPrint] Prints the current object
Delete [ObjDelete] Erases the current object
. Displays the Object Properties dialog
Properties [GUIHelp] box for the current object
Displays the help topic associated
Help [Help] with the current object or the APL
symbol under the cursor
Cut [Cut] Deletes selected text
Copy [Copy] Copies the selection to the clipboard
Pastes the text contents of the
clipboard into the session log at the
Paste [Paste] current location. The new lines are
marked and may be executed by
pressing Enter.
Paste Same as Paste, but gets the Unicode
. [PasteUnicode] text from the clipboard and converts
Unicode
to JAV
Paste Same as Paste, but gets the ANSI text
Non- [PasteAnsi] from the clipboard and converts to
Unicode dAav
Line [LineNumbers] Toggles line numbers on/off
Numbers ! £g
Copy ) Copies the contents of the current
Object [ObjCopy] object to the clipboard
Paste ) Pastes the contents of the clipboard
Object [ObjPaste] into the current object




Chapter 1: The APL Environment 63

Item Action Description
Align . .
[AlignComments] Aligns Comments to current column
Comments
Explorer [Explorer] Displays the Workspace Explorer
Search [WSSearch] Displays the Find Objects tool
Eyent [EventViewer] Displays the Event Viewer
Viewer
Threads [Threads] Displays the Threads Tool
Status [Status] Displays the Status window
Colours [ChooseColors] Displays the Colour Selection dialog
Interrupt [Interrupt] Generates a weak interrupt
Opens the URL or link using the
Open link | [OpenLink] appropriate program. Unicode Edition
only.
Conv link Copies the URL or link to the
py [CopyLink] Windows Clipboard. Unicode Edition
to clipboard only

For the last two items, see Installation & Configuration Guide: Configuration Dia-

log: General Tab)
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The Session Toolbars

The Session toolbars are contained by four separate CoolBand objects, allowing you
to configure their order in whichever way you choose. The tool buttons appear dif-
ferently according to whether or not Native Look and Feel is enabled.

The bitmaps for the buttons displayed on the session tool bar are implemented by
three ImageList objects owned by the CoolBar [JSE . cbtop. These represent the
ToolButton images in their normal, highlighted and inactive states and are named
iln,ilhand ili respectively. These images derive from three bitmap resources
contained in dyalog.exe named tb_normal, tb_hot and tb_inactive.

If Native Look and Feel is enabled all three bitmap resources are mapped to a dif-
ferent set of images which are capable of reflecting the Visual Styles in use.

Native Look and Feel Enabled
WS g & W %y =

Object [J) o] =& & & A
Tool P g i=

Edit 7 & 2 ©

Session il [APL385 Unicode  ~[  16/2]

Native Look and Feel Disabled
ws M HEHYA S

Ohiect B B B V B[R
ool @ G W
CEdit By (@« o

CSession (B APL3SS Unicode s 16/2
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Workspace (WS) Operations

« [
Clear Workspace
=

Load Workspace

& O
Copy Workspace

Save Workspace

I

Export Workspace

- &

Print Functions

Executes the system operation [WSClear ] which asks
for confirmation, then clears the workspace

Executes the system operation [WSLoad] which
displays a file selection dialog box and loads the
selected workspace

Executes the system operation [WSCopy ] which
displays a file selection dialog box and copies the
(entire) selected workspace

Executes the system operation [WSSaveas ] which
displays a file selection dialog box and saves the
workspace in the selected file

Executes the system operation [MakeExe] which re-
exports the workspace using the settings, parameters
and options that were previously selected using the
Create Bound File dialog

Executes the system operation [PrintFnsInNS] that
prints all the functions and operators in the current
namespace
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Object Operations

o B
Copy Object

ol B
Paste Object

= g
Print Object

P,

Edit Object

2
Edit Array

SharpPlot

Executes the system operation [Ob jCopy ] which
copies the contents of the current object to the
clipboard

Executes the system operation [Ob jPaste] which
copies the contents of the clipboard into the current
object, replacing its previous value

Executes the system operation [Ob jPrint] that prints
the current object

Executes the system operation [Edit] which edits the
current object using the standard system editor

Executes a defined function in [JSE that edits the
current object using the Array Editor (Unicode Edition)
or a spreadsheet-like interface based upon the Grid
object (Classic Edition). See Array Editor on page 39

Executes a defined function in [JSE that runs the
SharpPlot Graphics Tools to plot the current object. See
SharpPlot Graphics Tools on page 42.
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Tools

ey

Explorer

p Q

Search

=

Line Numbers

@ X

Clear all Stops

Edit Operations
B

Copy Selection

SERNE

Paste Selection

2w

Recall Last

(Sl ="

Recall Next

Executes the system operation [Explorer] which
displays the Workspace Explorer tool

Executes the system operation [WSSearch] which
displays the Workspace Search tool

Executes the system operation [LineNumbers ]
which toggles the display of line numbers in edit and
trace windows on and off

Executes the system operation [ClearTSM] which
clears all STOP, JMONITOR and [JTRACE settings

Executes the system operation [ Copy] which copies
the selected text to the clipboard

Executes the system operation [Paste] which pastes
the text in the clipboard into the current window at the
insertion point

Executes the system operation [Undo] which recalls
the previous input line from the input history stack

Executes the system operation [Redo ] which recalls
the next input line from the input history stack
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Session Operations

)

= Executes the system operation [ SELoad] which
displays a file selection dialog box and loads the
selected Session File

Load Session

APLIES Unicode + Selects the font to be used in the Session window
Select Font

16 [ Selects the size of the font to be used in the Session

.
) window
Select Font Size
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The Session Status Bar

The session status bar is represented by two CoolBands each of which contains a
StatusBar object. There are a number of StatusFields as illustrated below. Y our own
status bar may be configured differently.

Ready. ..

CurObj:

Classic Edition

Ready. ..
CurObj:

Unicode Edition

Ins NUM  Uni
8&:1 Opq:0 OTRAP [OSI:0 [OI0:1 [OML:1

Ins NUM
&:1 Ope:0 OTRAP 0OSI:0 DOIO:=1 DOML:1

The StatusField objects owned by the session StatusBar may have special values of
Style, which are used for operations relevant only to the Session. These styles are
summarised in the tables shown below.

Table 19: Session status fields: first row

StatusField | Style Description
hint None Displays hlpts fo.r .the session objects, or "Ready...
when APL is waiting for input
insrep InsRep Displays the mode of the Insert key (Ins or Rep)
Displays the keyboard mode. This is applicable only
to a multi-mode keyboard. The text displayed is
KeyM L
mode eyMode defined by the Mn= string in the Input Table.
Classic Edition Only
Indicates the state of the Num Lock key. Displays
fum NumLock "NUM" if Num Lock is on, blank if off
Indicates the state of the Caps Lock key. Displays
caps CapsLock "Caps" if Caps Lock is on, blank if off
Displays a flashing red "Pause" message when the
pause Pause . .
Pause key is used to halt session output
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Table 20: Session status fields: second row

StatusField | Style Description
. . Displays th f th t object (th

curobj CurObj isplays the name of the curren object (the name
last under the input cursor)

e ThreadCount Dl'sp'lays thp number of threads currently running
(minimum is 1)

dqlen DQLen Displays the number of events in the APL event
queue

trap Trap Turns red if OTRAP is set

si SI Displays the length of JSI. Turns red if non-zero

. Displays the value of JI0. Tums red if JIO is

io 10 .
not equal to the value of the default_io parameter
Displays the value of OML. Tums red if OML is

ml ML not equal to the value of the default ml
parameter

Toggle Status Fields

In the default Session files distributed with this release, the Statusfields used to dis-
play the value of JI0, the state of the Insert key (Ins/Rep) and the current keyboard
mode (e.g. Apl/Uni) have callback functions attached to MouseDbIClick. This
means that you can toggle the state of these fields by double-clicking with the left

mouse button.

Ifyou dislike this behaviour, you may set the Event property of the StatusFields to 0
and re-save the Session file. Alternatively, you may modify the buildse workspace
and rebuild the Session from scratch.
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Status Window

The Status window is used to display system messages and supplementary inform-
ation. These include the operations that take place when you register an OLEServer
or ActiveXControl.

The Status window is also used to display supplementary information about errors.
For exampleif you attempt to use a NET method with incorrect argument(s) you will
get a suitable error message in the Status window, in addition to the DOMAIN

ERROR message in the Session.

Example

'OUSING<«'System'

bd<[JNEW DateTime (2015 4) A Typo (2015 4 30)
DOMAIN ERROR

bd<[INEW DateTime(2015 4) A Typo (2015 4 30)

A

JA Status

File Options

Void .ctor({Inté%, System.DateTimeKind) ~
Yoid .ctor(Int32, Int32, Intd2)

Void .ctor{Int32, Int32, Int32, System.Globalization.
Void .ctor(Int32, Int32, Int32, Int32, Int32, Intd2)
Yoid .ctor(Int32, Int32, Int32, Int32, Int3d2, Int32,
Yoid .ctor(Int32, Int32, Int32, Int32, Int3d2, Int32,
Yoid .ctor(Int32, Int32, Int32, Int32, Int3d2, Int32,
Yoid .ctor(Int32, Int32, Int32, Int32, Int3d2, Int32,
Yoid .ctor(Int32, Int32, Int32, Int32, Int3d2, Int32,
Yoid .ctor(Int32, Int32, Int32, Int32, Int3d2, Int32,

Close

The Status window can be explicitly displayed or hidden using the [Status] sys-
tem operation which is associated with the Tools/Status menu item. There is also an
option to have the Status window appear automatically whenever a new message is
written to it. This option is selected using the [AutoStatus ] system operation
which is associated with the Tools/AutoStatus menu item.

Note that when you close the Status window, all the system messages in it are
cleared.
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The Workspace Explorer Tool

The Explorer tool is a modeless dialog box that may be toggled on and off by the sys-
temaction [Explorer]. In a default Session, this is attached to a Menultem in the
Tools menu and a Button on the session toolbar.

The Explorer contains two sub-windows. The one on the left displays the namespace
structure of your workspace using a TreeView. The right-hand window is a ListView
that displays the contents of the namespace that is selected in the TreeView.

& ChProgram Files\DyaloghDyaleg APL-64 15....

File Edit Options View Tools

TERXQE| | EBEEE] 4 elol

Workspace Tree Contents of #.WDesign.PropFmt
EICI WDesign || Name Type 2

'@ [Fns/Ops] FlAnimation Function

-] [Vars) #)8TNS Variable

H-] Bitmaps ]

- BMED F]BTNSCONY Functien

|:| Buttons .@Hi tmap Function

|:| ColourPic .@Hrouseﬂnx Function

w3 Events ¥ CHOICES Variable

[:| GridTitle |[#]Calendar Function

|:I GWiz ElCheck Function

D ILWiz .@CircLe Function

D PropFmt Elcombo Function

[:I ::QT?EL .@CombnEx Functien

Qe [Bootser ucton
< > < >
75 object(s). 681.12Mb free. 409168 bytes used (0 bytes

The Explorer is closely modelled on the Windows Explorer in Windows and the facil-
ities it provides are very similar. For Windows users, the operation of this tool is prob-
ably self-explanatory. However, other users may find the following discussion

useful.



Chapter 1: The APL Environment 73

Exploring the Workspace

The TreeView displays the structure of your workspace. Initially it shows the root
and Session namespaces # and [JSE. The icon for # is open indicating that its con-
tents are those that appear in the ListView. You can expand or collapse the
TreeView of the workspace structure by clicking on the mini-buttons (labelled + and
-) or by double-clicking the icons. A single click on a closed namespace icon opens
it and causes its contents to be displayed in the ListView. Another way to open a
namespace is to double-click its icon in the ListView. Only one namespace can be
open at a time. The icons used in the display are described below.

Class

Namespace (closed)
GUI Namespace (closed)
Namespace (open)

GUI Namespace (open)

geolUE

Function

Variable

Operator

Indicates an object that has been erased

Type Library

NET object
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Viewing and Arranging Objects

The ListView displays the contents of a namespace in one of four different ways
namely Large Icon view, Small Icon view, List view or Details view. Y ou can switch
between views using the View menu or the tool buttons that are provided. In the first
three views, the system displays the name of the object together with an icon that
identifies its type. In Details view, the system displays several columns of additional
information. You may resize the column widths by dragging or double-clicking the
lines in the header. To hide a column, drag its width to the far left. The additional
columns are:

This is the namespace containing the object. By definition, this
Location is the same for all of the objects shown in the ListView and is
normally hidden

For a function or operator, this is the function header stripped of
localised names and comment. For a variable, the description
indicates its rank, shape and data type. For a namespace, the
description indicates the nature of the namespace; a plain
namespace is described as namespace, a GUI Form object is
described as Form, and so forth.

Description

Size The size of the object as reported by JSIZE.

Modified | For functions and operators, this is the timestamp when the
on object was last fixed. For other objects this field is empty.

Modified | For functions and operators, this is the name of the user who
by last fixed the object. For other objects this field is empty.

In any view, you may arrange the objects in ascending order of name, size, timestamp
or class by clicking the appropriate tool button. In Details view, you may sort in
ascending or descending order by clicking on the appropriate column heading. The
first click sorts in ascending order; the second in descending order.
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Moving and Copying Objects

You can move and copy objects from one namespace to another using drag-drop or
from the Edit menu.

To move one or more objects using drag-and-drop editing:

1. Select the objects you want to move in the ListView.

2. Point to one of the selected objects and then press and hold down the left
mouse button. When the drag-and-drop pointer appears, drag the object(s) to
another namespace in the TreeView. To indicate which of the namespaces is
the current target, its name will be highlighted as you drag the selected
object(s) over the TreeView.

3. Release the mouse button to drop the objects into place. The objects will
disappear from the ListView because they have been moved to another
namespace.

To copy one or more objects using drag-and-drop editing, the procedure is the same
except that you must press and hold the Ctrl key before you release the mouse but-
ton.

You may also move and copy objects using the Edit menu. To do so, select the
object(s) and then choose Move or Copy from the Edit menu. You will be prompted
for the name of the namespace into which the objects are to be moved or copied.
Enter the namespace and click OK.

Editing and Renaming Objects

You can open up an edit window for a function or variable by double-clicking its
icon, or by selecting it and choosing Edit from the Edit menu or from the popup
menu. You may rename an object by clicking its name (as opposed to its icon) and
then editing this text. You may also select the object and choose Rename from the
Edit menu or from the popup menu. Note that when you rename an object, the ori-
ginal name is discarded. Unlike changing a function name in the editor, this is not a
copy operation.
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Using the Explorer as an Editor

If you open the Fns/Ops item, the names of the functions and operators in the
namespace are displayed below it alphabetically in the left (tree view) pane. When
you select one of these names, the function itselfis opened in the right (list view)
pane.

B C:\Program Files\Dyalog\Dyalog APL-64 15.0 Unicode\ws\wdesign.dws Explorin...  — O

File Edit Options View Tools
TR XQE| | EDEEA| 4 e
Workspace Tree

& INSCOL = g;||5ear.:h... v| % & aA
4] INSROW
4] KEYPRESS [1] OML~0

] LAST_BTN [2] T :Tf 2=[INC'DESCRIBE"

4| LIST_0BJ [3] tDESCRIBE
4] LOCATE [4] :EndIf

-] LOWER
,@ LX
2] MAKE

{2 MAKE_BTN
B MAKE_EXEC
B MAKE_FMT_F
B MAKE_FMT_F
-] MAKE_FN

-] MAKE_FN_FC ,
< = > Function P..

413 object(s). 61.12Mb free, 1725784 bytes used (0 bytes selected)

You may use this feature to quickly cycle through the functions (or variables) in a
namespace, pressing cursor up and cursor down in the left (tree view) pane to move
from one to another.

You may also edit the function directly in the right (list view) pane before moving
on to another.
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The File Menu

Print...

Print setup...

Delete

Rename

Properties

Close

F2
Alt Enter

The File menu, illustrated above, provides the following actions. All but Print setup

and Close act on the object or objects that are currently selected in the ListView.

Print Prints the object(s).

Print Displays the Print Configuration dialog box

setup play g g .

Delete Erases the object(s).

Rename Re.namf:s the object. This option only applies when a single
object is selected.

Properties | Displays a property sheet; one for each object that is selected.

Close Closes the Explorer
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The Edit Menu
Edit Enter
Copy Ctrl €
Maowe
Select >

Select Functions

Select Variables

Select Mone
Select All Ctrl A

|nvert Selection

The Edit menu, illustrated above, provides the following actions. The Edit, Copy and
Move operations act on the object or objects that are currently selected in the

ListView.
Edit Opens an edit window for each of the objects selected.
Copy Prompts for a namespace and copies the object(s) there.
Move Prompts for a namespace and moves the object(s) there.
Select . . R

. Selects all of the functions and operators in the ListView.

Functions
Sele‘ct Selects all of the variables in the ListView.
Variables

Select None | Deselects all of the objects in the ListView.

Select All Selects all of the objects in the ListView.

Invert Deselects the selected objects and selects all those that were
Selection not selected.
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The Options Menu

+  Toolbar

Towolbar Captions

«"  Status Bars

Expand All

Refresh Mow F5
" Auto Refresh

The Options menu, illustrated above, provides the following actions.

Toolbar |Displays or hides the Explorer toolbar.
Tool . . .
00 Par Displays or hides the button captions on the Explorer toolbar.
Captions
StatusBar | Displays or hides the Explorer statusbar.
Type . . . .
Libraries Enables/disables the exploring of Type Libraries
Expands all namespaces and sub-namespaces in the TreeView,
Expand . . . .
All providing a complete view of the workspace structure, including
or excluding the Session object [JSE.
Redisplays the TreeView and ListView with the current structure
Refresh . .
and contents of the workspace. Used if Auto Refresh is not
Now
enabled.
Auto Specifies whether or not the Explorer immediately reflects
Refresh | changes in the active workspace.

If Auto Refresh is checked the Explorer is updated every time APL returns to desk-cal-
culator mode. This means that it is always in step with the active workspace. If you
have a large number of objects displayed in the Explorer, the update may take a few
seconds and you may wish to prevent this by un-checking this menu item If you do
so, the Explorer must be explicitly updated by selecting the Refresh Now action.
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The View Menu

Columns s | Name
Large lcons ~  Location
Small lcons v Type
List lcons ~*  Descripticn

® Details | Size

~  Modified on

il al Meodified by
Arrange lcons »

Line up lcons

~ Autc Arrange

The View menu, illustrated above, provides the following actions.

Columns | Allows you to select which columns you wish to display.
L . . R
arge Selects Large Icon view in the ListView.
Icons
Small Selects Small Icon view in the ListView.
Icons
List Icons | Selects List view in the ListView.
Details Selects Details view in the ListView.
Scope Allows you to choose whether the Explorer displays objects in
P local scope or in global scope.
A . . R .
Icl(‘)l;lasnge Sorts the items in the ListView by name, type, size or date.
Line up Rearranges the icons into a regular grid
Icons & & grc.
Auto If checked, the icons are automatically re-arranged when
Arrange |appropriate
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The Tools Menu

Find...
Goto..

F3
Ctrl G

Go to Session Space

Set Session space

The Tools menu, illustrated above, provides the following actions.

Find Displays the Find Objects Tool
Prompts for a namespace and then opens that namespace in the
Go to . . L . s
TreeView, displaying its contents in the ListView
Go to . . .
Session Opens the namespace in the TreeView control corresponding to
the current space in the Session.
Space
Set Session | Sets the current space in the Session to be the namespace that is
Space currently open in the TreeView.
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Browsing Classes

Classes are represented by icons. The picture below shows 3 classes: Bird,
Parrot and DomesticParrot.

& C:h\Dyalog15.0\Core\ws\Parrots.dws Exploring [#]

File Edit Options View Tools

A BRXQE| | EEES| e

Workspace Tree Contents of # (Global Scope)

+-[e] #
S o st

ﬁil Typelibs Bird LS ld Parrot
Ji'?‘l‘ MetaData Parrot

3 object(s). 62.83Mb free. 92312 bytes used (47408 bytes selected)

If you open the # node in the left-hand pane, you see the contents of # as a tree.

& C:hDyalogl5.0\Corelws\Parrots.dws Exploring [#]

File Edit Options View Tools

TRXQE| | EEEE| 46 elal

Workspace Tree Contents of # (Global Scope}

--EJ DomesticParrot Bird LLTEASES Parrot
m Parrot Parrot
=--[E9) 0dse

@45 Typelibs
Ea--Ji"I MetaData

3 object(s). 62.83Mb free, 92312 bytes used (47408 bytes selected)
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Browsing Class Scripts

Selecting DomesticParrot in the left-hand pane brings up its Class Script in the
right-hand pane.

tn C:\Dyalog15.0\Corehws\Parrots.dws Exploring [#.DomesticParrot]

File Edit Options View Tools

TBRXQE| | HEEE] 4 6ea

Workspace Tree Contents of #.DomesticParrot

i= ﬁ‘ﬁgHSearch... v| % "paA|"i}"‘o
:Class DomesticParrot: Parrot
Lol tField Public name
[o] = v eggl(nzme species)
[1] :Access Public
Jét MetaData [2] :Implements Constructor :Base species

[3] ODF Name+name
[+] L v
[0] = v eggl
[1] tAccess Public
[2] :Implements Constructor :Base 'Generic'
[3] OOF Name~'Polly'’
[4] L v
[0] = v Speak
[1] tAccess Public
[2] R+[IBASE, Speak ‘Who''s a pretty boy then!’
[3] v

:EndClass A DomesticParrot

Modified Class Pos: 19/21,4

3 object(s). 62.83Mb free. 92312 bytes used (47408 bytes selected)
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... and selecting Parrot in the left-hand pane brings up the Class Script for
Parrot.

yalog15.0%Corelwsh| . xploring [#.Parrot]

File Edit Options View Tools

PBRXQE| | EEEE| 4 s

Workspace Tree Contents of #.Parrot
C-Em # = 0 @& QHSearch... v|')p *n aA| 1 e 11
EdBird

:Class Parrot: Bird

E:l [o] =] vV egg species

(2q OSE [1] :hccess Public Instance
s{:lTypeL"lbs [2] :Implements Constructor :Base 'Parrot: ' species

[3] ODF Name+name

[4] L v

[0] =) v Spesk

[1] :hccess Public

[2] R+~'Squark!’

[3] L v

[0] =] v kill

[1] :Implements Destructor
[2] 'This Parrot is dead'
[3] v

T iEndClass A Parrot

Class Pos: 0/18,0
3 object(s). 62.82Mb free. 92312 bytes used (47408 bytes selected)
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... and finally, selecting B i rd in the left-hand pane brings up the Class Script for
Bird.

alog15.00Core\ws\Parrots.dws Exploring [#.Bird]

File Edit Options View Tools

TR X S e = s = T T AT
Workspace Tree Contents of #.Bird
=0 A @ |[search... v e Eaalth e
:Class Bird
& :Field Public Species
[0l =] v egg spec
[1] iAccess Public Instance
w-Jiét MetaData [2] :Implements Constructor
[3] Species~'spec’
[4] L v
[o] = v Speak
[1] :Access Public
[2] R+'Tweet, tweet!’
[3] v

:EndClass m Bird

Meodified Class

Pos: 13/154

3 object(s). 62.82Mb free. 92312 bytes used (47408 bytes selected)
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Ifyou open a Class node, a tree appears to help you to navigate within the Class
script. In the picture below, the user has opened the [Methods ] node and then
clicked on Speak. The system has responded by scrolling to (if necessary) and high-
lighting the appropriate section of the script.

Br C:\Dyalog13.00Core\ws\Parrots.dws Exploring [#.DomesticParrot]

File Edit Options View Tools
TBRXQE| | EEEE| 46 el
Workspace Tree Contents of #.DomesticParrot
=0 @ Q@ |[search... B e Eal e s

:Class DomesticParrot: Parrot
:Field Public name

[0 DomesticParrot &
4% [Constructor

-4 [Fields] [0] =] v egg(name species)
2451 [Methods] [1] :Access Public
: i a [2] :Implements Constructor :Base species
[S:l Parrot [3] ODF Name+nzame
- OSE [+] L 7
2 -
U"ﬁ :1"235125 [01 | @ v eggo
- etalata [1] thccess Public
[2] iImplements Constructor :Base 'Generic’
[3] [ODF Name+'Polly'
[4] L v
o1 | |o e
[1] :Access Public
[2] R+[IBASE,Speak 'Who''s & pretty boy then!'
[3] L v
:EndClass A DomesticParrot
< 3 | Class Pos: 15/21,0

3 object(s). 62.82Mb free. 92312 bytes used (47408 bytes selected)
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Browsing Type Libraries

When the View/Type Libraries option is enabled, the Workspace Explorer allows
you to:

o Browse the Type Libraries for all the COM server objects that are installed
on your computer, whether or not they are loaded in your workspace.

o Load Type Libraries for COM objects

o Browse the Type Library associated with an OLEClient object that is
already instantiated in the workspace.

If the Microsoft NET Framework is installed, you may in addition:

o Load Metadata for specific NET classes
o Browse the loaded Metadata, viewing information about classes, methods,
properties and so forth.

Ifthe Type Libraries option is enabled, the Workspace Explorer displays a folder
labelled TypeLibs which, when opened, displays two others labelled Loaded
Libraries and Registered Libraries as shown below.

BN CLEAR WS Explering [#]

File Edit Options View Tools

reXQE | EDEmEE 6l

Workspace Tree Contents of # (Global Sce
£ =1k MName Type
0OsE

-4 Typelibs
{31 Loaded Libraries

: ﬁil Registered Libraries
JE'T MetaData

< >
0 ohject(s). 62.24Mb free. 0 bytes used (0 bytes selected)
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Browsing Registered Libraries

If you open the Registered Libraries folder, the Workspace Explorer will display in
the tree view pane the names of all the Type Libraries associated with the COM
Server objects that are installed on your computer.

Ifyou select one of these Library names, some summary information is displayed in
the list view pane.

For example, the result of selecting the Microsoft Excel 12.0 Object Library is illus-
trated below.

B CLEAR WS Exploring [Registered Libraries]

File Edit Options View Tools

FTRXQE | EEEE 4o elel

Workspace Tree Contents of Registered Libraries
I Microsoft DirectX a|| Attribute Value )
) - -
~gd Microseft Disk Ouc fLCTh [00N2084 2-00AN-AAAN-CANA-AG )]

ﬂ{j Microseft Excel 12.0 Object Library. [Versicn:i.ﬁ,LccaLe:O}[
os
g Microsoft Excel 5. =

I Microsoft Fax Sers HelpDir C:\Program Files (x86)\Micros
I Microsoft Feeds 2. HelpFile C:\Program Files (x86)\Micras
g1 Microsoft Forms 2., | HelplD 0x0000FFFf v
£ > £ >
0 object(s). 62.84Mb free, 0 bytes used (0 bytes selected)

Ifinstead, you select the Registered Libraries folder itself, the list of Registered Type
Libraries is displayed in the list view pane

B CLEAR WS Exploring [Registered Libraries]

File Edit Options View Tools

FRXQE | EEEE 40 e o

Workspace Tree Contents of Registered Libraries
A || Name &
Microsoft DirectX Transforms Image Tra...
Microsoft Disk Quota 1.0
Lg% . (Version:1.0,Loc Microsoft Excel 5.0 Object Library
(Version:2.0,Loc Microsoft Fax Serwvice Extended COM Typ...
(VYersion:=3.0,Loc Microsoft Feeds 2.0 Object Library
_ (\’ersion:ll.O,LocV Microsoft Forms 2.0 Object Library v
(: —————zL =z zL.. fl)i_E .(. - - - - - . - - )I

0 object(s). 62.84Mb free, 0 bytes used (0 bytes selected)
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Loading a Type Library

You can load a library shown in the tree view pane by selecting Load from its con-
text menu.

In either case, a message box will appear asking you to confirm. The operation to
load a Type Library may take a few moments to complete.

Notice that if the selected Library references any other libraries, they too will be
loaded. For example, loading the Microsoft Excel 12.0 Object Library brings in the
Microsoft Office 12.0 Object Library and the Microsoft Visual Basic for
Applications Extensibility 5.3 Library too. It also contains references to a general lib-
rary called the OLE Automation Type Library, so this is also loaded.

When you ) SAVE your workspace, all of the Type Libraries that you have loaded
will be saved with it. Note that type library information can take up a considerable
amount of workspace.
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Browsing Loaded Libraries

If you have already loaded any Type Libraries into the workspace, using the Work-
space Explorer or as a result of creating one or more OLEClient objects, you can
select and open the Loaded Libraries folder.

The picture below illustrates the effect of having loaded the Microsoft Excel 12.0
Object Library.

B CLEAR WS Exploring [Loaded Libraries]

File Edit Options View Tools

YR XQE| | @0 EE e

Workspace Tree Contents of Loaded Libraries
{5 # ~ || Name Loaded CLSID
=@ ESE " OLE Automation Yes {00020%
-4 Typelibs
: Unk T Y 2FC63B
Es{il Loaded Libraries n nown ypes_ - &s - { |
siil Microsoft Excel 12.0 Microsoft Office 12.0 Object Library lBDO
siil Microsoft Office 12.0 Microsoft Visuwal Basi... Yes {0002E19
s{il Microsoft Visual Basi Microsoft Excel 12.0 ... Yes {000208
s{il OLE Automation
@-3' Registered Libraries v
< > < 3
0 object(s). 62.24Mb free. 0 bytes used (0 bytes selected)

Notice that any external references to other libraries causes these to be brought in
too.

If you select a loaded Type Library, summary information is displayed in the list
view pane.

If you open a loaded Type Library, four sub-folders appear named Object CoClasses,
Objects, Enums and Event Sets respectively.
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Object CoClasses

A Type Library describes a number of objects. Typically, all of the objects have prop-
erties and methods, but only some of them, perhaps just a few, generate events.
Objects which generate events are represented by CoClasses, each of which has a
pointer to the object itself and a pointer to an event set.

For example, the Microsoft Excel 12.0 Object Library contains seven CoClasses
named Application, Chart, Global etc as shown below.

B CLEAR WS Exploring [Loaded Libraries]

File Edit Options View Tools

TERXQE| | DEEE| e

Workspace Tree Contents of Loaded Libraries
----- & # A || Name CLSTD

sEse Application {00024500-0000-¢
EI"N;-ET_ZL;{;:LZ Libraries Chart {00020821-0000-0
: .4 Microsoft Excel 12.0 Global {00020812-0000-¢
siil Object CoClasses OLEOb ject {00020818-0000-0
: #% Objects QueryTable {59191DA1-EALT -1
%1 Enums Workbook {00020819-0000-0
. a8 Event Sets v || Worksheet {00020820-0000-(
£ > £ >

0 object(s). 62.84Mb free, 0 bytes used (0 bytes selected)
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Opening the Application folder you can see that the Application CoClass comprises
the Application object coupled with the AppEvents event set as shown below.

B CLEAR WS Exploring [Loaded Libraries]

File Edit Options View Tools
[ EBEXQ@ o EEER dals

Workzspace Tree Contents of Loaded Libraries
..... # "N |
[]--- OsE Name Application
Elﬁil Typelibs CLSID {00024500-0000-00
049 Loaded Libraries HelpString
|_=_|s{il Microsoft Excel 12.0 Object Library HelpFile C:\Program Files
B-&' Object CoClasses HelpID 0x00020001
L—"_Isfil Application
EHliil Event Sets
s{il .kppEvents
EHNiI Interfaces
sfil _Application
w45 Chart
w4 Global
w4 OLEObject
[]--s{:l QueryTable
-4 Workboak
[i]-3°1 Worksheet
< > < >
[1 object(s). 60.16Mb free. |20536 bytes used (0 bytes selected)

4

The specific methods, properties and events supported by the CoClass object can be
examined by opening the appropriate sub-folder. The same information for these and
other objects is also accessible from the Objects and Event Sets folders as discussed

below.
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Objects

The Objects folder contains several sub-folders each of which represents a named
object defined in the library.

Each object folder contains two sub-folders named Methods and Properties. Select-
ing one of these causes the list of Methods or Properties to be displayed in the list
view pane. The picture below shows the Methods exposed by the Microsoft Excel
12.0 Range object.

ploring [Loaded Libraries]

File Edit Options View Tools

TERXQE| | HEEE| e
Workspace Tree Contents of Loaded Libraries
w41 Points || Name Result G
@41 Protection Activate VT_VARIANT
D"m:' Pub L._I ShOb!ECt AddComment Comment
-8 PublishObjects
-4 QueryTables AdvancedFilter VT_VARIANT
2% Range ApplyNames VT_VARIANT
I Met hods ApplyOutlineStyles VT_VARIANT
s{il Properties AutoComplete YT_BSTR
E]--s{il Ranges AutoFill VT_VARIANT
-4 RecentFile AutoFilter VT_VARIANT
EJ"“‘%‘ RecentFiles AutoFit VT_VARIANT
i) Rectangle AutoFormat VT_VARIANT
i) Rectangles Y| autadutline VT VARTANT ¥
< > < >

0 ohject(s). 62.51Mb free. 0 bytes used (0 bytes selected)
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If you open the Methods or Properties subfolder, you can display more detailed
information about individual Methods and Properties. For example, the following
picture shows information about the SaveAs method exposed by the Microsoft Excel
12.0 Worksheet object.

5 Exploring [Loaded Libraries]

File Edit Options View Tools

TR XQE| | BEEE e

Workspace Tree

Contents of Loaded Libraries

g PrintOut
2 - -
s{:l PrintPreview Name SaveAs
-3 Protect Help Stri
e rin
-1 Rectangles P 9
3% ResetAl lPageBreaks HelpID 0x00010785
N s ovehs) DispID 0x00000785
3% Scenarios
-#% Scrol lBars Result VT_VOID
3% Select
-3 SetBackgroundPicture Arguments:

2
s{:l ShowAllData Filename VT_BSTR [in]
+33 ShovDataform FileFormat VT_VARTANT [Optionall,[in]
-1 Spinners _ _

" Password VT_VARIANT [Optienal],[in]
-3 TextBoxes i ! !
L Unprotect WriteResPassword VT_VARIANT [Optienal],[in]
%) XmlDataQuery ReadOnlyRecomm... VT_VARIANT [Optienal],[in]
-5 XmlMapQuery CreateBackup YT_VARIANT [Optional]l,[in]
I Properties AddToMru VT_VARIANT [Optienal],[in]
boveAverage TextCodepage VT_VARIANT [Optienal],[in]
ction TextVisuallayout  VT_VARIANT [Optienal],[in]
ctions Local VT_VARIANT [Optionall,[in]
£

0 ohject(s). 62.51Mb free.

0 bytes used (0 bytes selected)

This tells you that the SaveAs method takes up to 10 parameters of which the first,
Filename, is mandatory and is of data type VT BSTR (a character string). Note that
[in] indicates that the parameter is an input parameter.
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Incidentally, the optional Fileformat parameter is an example of a parameter whose

value must be one of a list of Enumerated Constants. Even without looking at the

documentation, the possible values can be deduced by browsing the Enums folder,
with the results shown below.

B CLEAR WS Exploring [Loaded Libraries]

File Edit Options View Tools
TRXQE | REOE| 4 oelal

Workspace Tree

Contents of Loaded Libraries

L4

41 XlEnableCancelKey ]
4% XlEnableSelection

-3 XLEndStyleCap

4% XlErrorBarDirection

4% XlErrorBarInclude
mﬁilKLErrorEarType

41 ¥ ErrorChecks

451 XLFileAccess

o (IRIP

-3 XLFiLlWith

38 XLFilterAction

-] XLFilterAllDatesInPeriod
-2 X[FindLookIn

451 XLFixedFormatQuality
mﬂilKLFixedFormatType
mﬂilKLFormatConditionOpers
mﬁilKLFormatConditionType
mﬁilILFormatFiLterTypes
41 XLFormControl

41 XlFormulalabel

Name

xLAddIn
xLC5Y
xLCS¥Mac

x LCSYMSDOS
xLCESVWindows
xLDBF2

x LDBF3

x LDBFL

x LDIF

xlExcel?

wefa e I R

xlExcel2FarEast
xlExceld
xlExcell
xLlExceld
xlExceld
xlExcel8795
xlExcel4Workbook
L4

Value
18
4]
22
24
23
7
g
11
9
16
27
29
33
39
39
b3
35

A

0 object(s). 62.51Mb free,

0 bytes used (0 bytes selected)

You can therefore deduce that the following expression, executed in the namespace

associated with the currently active worksheet, will save the sheet in comma-sep-

arated format (CSV) in a file called mysheet.csv:

or

SaveAs 'MYSHEET.CSV'

xLCSV

SaveAs 'MYSHEET.CSV' 6



96

Ul Guide

Event Sets

The Event Sets folder contains several sub-folders each of which represents a named
set of events generated by the objects defined in the library.

If you open one of these event sets, the names of the events it contains are displayed
in the tree view pane. If you then select one of the events, its details are displayed in
the list view pane as shown below.

BN CLEAR WS Exploring [Loaded Libraries]

File Edit Options View Tools

1B XQE| | EEMEE| Y e

Workspace Tree Contents of Loaded Libraries
(g # ~
o Ose Name SheetActivate

E—J--S{il Typelibs

: Help 5tri
=41 Loaded Libraries =P ring

G4t Microsoft Excel 12.0 Obj, | HelPID 0x00010619
--s{ilﬂbject CoClasses DisplD 0x00000619
-1 Objects
-4 Enums Result VT_VOID
Elsfil Event 5Sets

E“ﬂ' AppEvents Arguments:
E"ﬁ;' Events Sh VT_DISPATCH

s{il AfterCalculate
451 NewMorkbook
FilSheetActivate

%1 SheetBeforeDout

: {ﬂl SheetBeforeRighw
a >, ||« 2

0 object(s). 62.51Mb free. 0 bytes used (D bytes selected)

This example shows that when it fires, the SheetActivate event invokes your call-
back function with a single argument named S# whose datatype is VT _DISPATCH
(in practice, a Worksheet object).
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Enums

The Enums folder will typically contain several sub-folders each of which represents
anamed set of enumerated constants.

Ifyou select one of these sets, the names and values of the constants it contains are
displayed in the list view pane as shown below.

B CLEAR WS Exploring [Loaded Libraries]

File Edit Options View Tools

TRXQE | EEEE|H oleloal

Workspace Tree Contents of Loaded Libraries
e # ~ || Name Value *
=-E ESE " x124HourClock 33
-3 Typelibs igi
; L4D ty &3
0-#%1 Loaded Libraries * 1gTEiEars
Y Microsoft Excel 12.0 Obj: xlAlternateArraySepar... 16
B{il Object CoClasses xlColumnSeparator 14
mo) Objects xLCountryCode 1
=-#%1 Enums xlCountrySetting 2
.31 Constants % lCurrencyBefore 37
.31 Xl AboveBelow xlCurrencyCode 25
L) -
a{II XlActionType x| CyrrencyDigits 27
E i:::F’P::-';:;;Zgi;;‘:rnahonal irrencyLead"lngIeros 40
s{ilXLAppb? Mod ®LlCurrencyMinus5ign ki
rabicModes
e XlArrangeStyle v ®xLCurrencyNegative 28 v
< > < >

0 object(s). 62.51Mb free. 0 bytes used (0 bytes selected)
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Browsing .NET Classes

Microsoft supplies a tool for browsing NET Class libraries called TLDASM.EXE]L.

As a convenience, the Dyalog APL Workspace Explorer has been extended to per-
form a similar task as TLDASM so that you can gain access to the information within
the context of the APL environment.

The information that describes NET classes, which is known as its Metadata, is part
of'the definition of the class and is stored with it. This Metadata corresponds to Type
Information in COM, which is typically stored in a separate Type Library.

To gain information about one or more .NET Classes, open the Workspace Explorer,
right click the Metadata folder, and choose Load.

BN CLEAR WS Exploring []

File Edit Options View Tools

TBXQE| | EDEEE|Holela

Workspace Tree

: OsE
‘5{1' Typelibs There is no viewable contert for the selected item

JE"[ MetaData

0 object(s). 48.79Mb free. 0 bytes used (0 bytes sele

I ILDASM.EXE can be found in the NET SDK and is distributed with Visual Studio
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This brings up the Browse .NET Assembly dialog box as shown below. Navigate to
the .NET assembly of your choice, and click Open.

B Browse NET Assembly

- v e« Frameworktd » w4.0.30319 v | 0 Search v4.0.30319 o
Organize New folder = » [H 0
Media -~ MName Date modified
medias Microsoft. Windows.ApplicationServer.Ap...  30/10/2015 09:13
Microsoft. NET MrncAspEst.dll 30/10/2015 0%:19
assembly mscordacwhs.dll 24/03/2016 04:20
authman mscordbi.dil 24/03/2016 04:20
mscoreei.dll 30/10/2015 0
Framewaork .
mscoreeis.dll 30/10/201509:19
F lofd
ramewer mscorlib.dll 24/03/2016 04:20
Managed Directx mscorpe.dll 30/10/2015 09:19
Migration mscarpehost.dll 30/10/2015 09:19
MiracastView mscorre.dll 30/10/2015 09:19
ModemLogs mscorsecimpl.dll 30/10/2015 09:19
ocR mscorsn.dil 30/10/2015
Panther mscorsve.dll 30/10/2015 9
ngentasklauncher.dll 30/10/2015 09:19
Performance [ I e i
- v < >
File name: | mscorlib.dll V| MET Azzemblies (*.dll) ~

Cancel

L]



100

Ul Guide

The .NET Classes provided with the NET Framework are typically located in
C:\WINDOWS\Microsoft.NET\Framework64\vV4.0.30319 (on a 64-bit

computer). The last named folder is the Version number.

The most commonly used classes of the NET Namespace System are stored in this
directory in an Assembly named mscorlib.dl1, along with a number of other fun-

damental .NET Namespaces.

The result of opening this Assembly is illustrated in the following screen shot. The
somewhat complex tree structure that is shown in the Workspace Explorer merely

reflects the structure of the Metadata itself.

BN CLEAR WS Exploring []

File

Edit Options View Tools

TRXQE | RDEEE sl

Workspace Tree

E|Jﬁt MetaData
O-fét Loaded Metadata

BJ’@T mscorlib
aJﬁt Modules

Bm C:\Windows\Microsoft.NET\Frameworké4\v4.0.30319\mscorlib.dLlL

m-Tiét [Unnamed]

]M Microszsoft.Wind2

jm Microsoft.Win3d2.5afeHandles

H-HEt System

]M System.Collections

jm System.Col lections.Concurrent

H-Jét System.Collections.Generic

]M System.Collections.ObjectModel

j.li‘r System.Configuration.Assemblies

-t System.Deployment.Internal

jm System.Deployment.Internal.Isolation
]M System.Diagnostics

-t System.Diagneostics.CodeAnalysis

jm System.Diagnostics.Contracts

]M System.Diagnostics.Contracts.Internal
]M System.Dizgnostics.SymbalStore

- Tt System.Diagnostics.Tracing

q-Jét System.Globalization

]M System.IO

[E
[E
[E
[E
[E
£
[E
[E
£
[E
[E
£
[E
[E
[E
[E
£
[E

0 object(s). 48.79Mb free. 0 bytes used (0 bytes selected)
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Opening the System/ Classes

sub-folder causes the Explorer to display the list of

classes contained in the NET Namespace System as shown in the picture below.

B CLEAR WS Exploring []

File Edit Options View Tools

PTRXQE| » DEEE| 4 ool

Workspace Tree

o5t System

et System.
JE"[‘ System.
Tt System.
.Ii‘:'t System.
Ji’:‘t System.
&t System.
Ji’:‘l‘ System.
Tt System.
JH System.
Tt System.
Tiét System.
Jﬁ"l‘ System.
i et System.
N =4 System.
Tt System.
.Ii‘:'t System.
Ji’:‘t System.
&t System.
Ji’:‘l‘ System.
Tt System.
JH System.
Tt System.
Tiét System.
Jﬁ"l‘ System.

L4

_ ComObject

_AppDomain
AccessViolationException
Action

Action™i

Action™2

Action™3

Action™4

Action’5

Action’é

Action7

Action™8

ActivationContext

Activator

Aggregatebtxception
AppContext

AppDomain
AppDomain+CAPTCASearcher
AppDomain+EvidenceCol lection
AppDomzin+NamespaceResolverForIntrospection
AppDomzinlnitializer
AppDomainlnitializerInfo+ltemInfo
AppDomainManager
AppDomainSetup

0 object(s). 42.79Mb free.

0 bytes used (0 bytes selected)
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The Constructors folder shows you the list of all of the valid constructors and their
parameter sets with which you may create a new instance of the Class by calling
New. The constructors are those named .cfor; you may ignore the one named .cctor,
(the class constructor) and any labelled as Private.

For example, you can deduce that DateT ime . New may be called with three
numeric (Int32) parameters, or six numeric (Int32) parameters, and so forth. There
are in fact seven different ways that you can create an instance ofa DateTime.

B CLEAR WS Exploring []

File Edit Options View Tools

TRXQE| | DEEE| Mol alb)
Workspace Tree
Base Class
=-digt Constructors
Tt (Private)Void .cctor()
Mt (Private)Void .ctor(Inté4, System.DateTimeKind, Boolean)
Mt (Private)Void .ctor{System.Runtime.Serialization.Serialization
Bt (Private)Void .ctor(UInté4)
BBt Void .ctor(Int32, Int32, Int32)
L0t Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32)
.Mt Void .ctor{Int32, Int32, Int32, Int32, Int32, Int32, Int32)
.0t Void .ctor{Int32, Int32, Int32, Int32, Int32, Int32, Int32, Sy
-0t Void .ctor{Int32, Int32, Int32, Int32, Int32, Int32, Int32, Sy
LBt Yoid .ctor{Int32, Int32, Int32, Int32, Int32, Int32, Int32, Sy
L Bi#t Void .ctor{Int32, Int32, Int32, Int32, Int32, Int32, System.Da
Tt Void .ctor{Int32, Int32, Int32, Int32, Int32, Int32, System.Gl
Tt Void .ctor{Int32, Int32, Int32, System.Globalization.Calendar)
Tt Yoid .ctor(Inté4)
Ji#t Void .ctor(Inté4, System.DateTimeKind)

@5t Fields

-5t Methods

[]--]@T Properties v
< >
0 object(s). 48.79Mb free. 0 bytes used (0 bytes selected)

For example, the following statement may be used to create a new instance of
DateTime (09:30 in the morning on 30th April 2001):

mydt<[NEW DateTime (2001 4 30 9 30 0)

mydt
30/04/2001 09:30:00
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The Properties folder provides a list of the properties supported by the Class. It
shows the name of the property followed by its data type. For example, the
DayOfYear property is defined to be of type Int32.

B CLEAR WS Exploring []

File Edit Options View Tools
TR XQE| | EEEE| 4 ela
Workspace Tree
Ji‘?t Base Class
Ji'?r Constructors
m-Jit Fields
f-Jét Methods
ElJi‘?t Properties
J#&t (Private)InternalKind : System.UInték4
-di&t (Private)InternalTicks : System.Intéb
Jét Date : System.DateTime
Tt Day : System.Int32
Tt DayOfWeek @ System.DaylfWeek
Tt DayOfYear @ System.Intd2
J#t Hour : System.Int32
LBt Kind s System.DateTimeKind
~J#t Millisecond : System.Int32
-Ji&t Minute : System.Int32
Bt Month : System.Int32
- Jt Now = System.DateTime
.J#t Second : System.Int32
diEt Ticks System.Intél
Tt TimeOfDay : System.TimeSpan
Tt Today : System.DateTime
~J#t UtcNow : System.DateTime

0t Year : System.Int32 N
< >

0 object(s). 48.79Mb free. 0 bytes used (0 bytes selected)

You can query a property by direct reference:

mydt.DayOfWeek
Monday
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Notice too that the data types of some properties are not simple data types, but

Classes in their own right. For example, the data type of the Now property is itself
System.DateTime. This means that when you reference the Now property, you
get back an object that represents an instance ofthe System.DateTime object:

mydt.Now
07/11/2001 11:30:48
ars
2001 11 7 11 30 48 O

The Methods folder lists the methods supported by the Class. The Explorer shows the
data type of the result of the method, followed by the name of the method and the
types of its arguments. For example, the IsLeapYear method takes an Int32 para-
meter (year) and returns a Boolean result.

mydt.IsLeapYear 2000

B CLEAR WS Exploring []

File Edit Options View Tools
TR XQHE| | EEEE| el

Workspace Tree

-Jét Boolean Equals(System.DateTime} "
..Jé&t Boolean Equals(System.DateTime, System.
Xt Boolean Equals(System.Object)

Bt Boolean IsDaylightSavingTime()

..Jé&t Boolean cp_EquaLitf{sttem.DateTime, Sy
Xt Boolean cp_GreaterThan{Efstem.DateTime,
..J&t Boolean cp_GreaterThanﬂrEquaL{Srstem.Da
..J&t Boolean cp_InequaLitr{Srstem.DateTime,
..Jé&t Boolean cp_LessThan{sttem.DateTime, Sy
Xt Boolean cp_LessThanﬂrEquaL{sttem.DateT
..J&t Boolean TryParse(System.5tring, System.
..J&t Boolean TryParse(System.5tring, System.
..Jé&t Boolean TryParseExact(System.S5tring, Sy
Xt Boolean TryParseExact(System.5tring, Sy
..t Double ToOADate() v
£ >

0 object(s). 48.79Mb free. 0 bytes used (0 bytes selected)
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Many of the reported objects are listed as Private, which means they are inaccessible
to users of the class — you are not able to call them or inspect their value. For more
information about classes, see Language Reference Guide: Object Oriented Pro-
gramming.

B CLEAR WS Exploring [

File

B X QE

Options  View Tools

Workspace Tree

£

W) (Private)VYoid Finalize()

.Jét (Private)Void System.Runtime.Serializat
Bt Boolezn
..Jét Boolean
..Jét Boolean
.Jét Boolean
Bt Boolezn
..Jét Boolean
..Jét Boolean
.Jét Boolean
Bt Boolezn
..Jét Boolean
..Jét Boolean
.Jét Boolean
Bt Boolezn
..Jét Boolean
..Jét Boolean
-Jiét Double ToOADate()
Bt Int32 Ccmpare{System.DateTime, System.D .,

| EEEE| 4 M e

Equals(System.DateTime)
Equals(System.DateTime, System.
Equals(System.0Object)
IsDaylightSavingTime()
IslLeapYear(Int32)
op_EquaLity{System.DateTime, Sy
op_GreaterThan{System.DatETimE,
op_GreaterThanﬂrEquaL{System.Da
cp_Inequality{System.DateTime,
op_LessThan{System.DatETime, Sy
op_LessThanﬂrEquaL{System.DatET
TryParse(System.5tring, System.
TryParse(System.5tring, System.
TryParseExact(System.5tring. Sy
TryParseExact(System.5tring, Sy

>

0 object(s). 48.79Mb free.

0 bytes used (0 bytes selected)
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Find Objects Tool

The Find Objects tool is a modeless dialog box that may be toggled on and off by
the system action [WSSearch]. In a default Session, this is attached to a Menultem
in the Tools menu and a Button on the session toolbar. This tool allows you to search
the active workspace for objects that satisfy various criteria.

The first page allows you to specify the name of the object which you wish to find
and the namespace(s) in the workspace that are to be searched for it.

B Find Objects

File Edit Wiew Columns Search

x B B @ B # o = o
Delete Props Large Small List  Details | Mame 5Size Date Type
Name/Location Modfied Advanced
M amed: | | Stop
Wariahles Functions Operatars Mamespaces MNew Search
Look ir: | | Close
|hclude zub-namezpaces Ihciude Sezsion namezpace

You type the name of the object you wish to find into the field labelled Named. To
locate all objects beginning with a particular string, enter the string followed by a '*'
character. For example, if you enter the string FOOx, the system will locate all
objects whose name begins with FOO.

Four check boxes are provided for you to specify the types of objects you wish to loc-
ate. For example, if you clear Variables, Operators and Namespaces, the system will
only search for functions.
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You can restrict the search to a particular namespace by typing its name into the field
labelled Look in. Y ou can also restrict the search by clearing the Include sub-
namespaces and Include Session namespace check boxes. Clearing the former
restricts the search to the root namespace or to the namespace that you have specified
in Look in, and does not search within any sub-namespaces contained therein. Clear-
ing the latter causes the system to ignore [JSE in its search.

The second page, labelled Modified, allows you to search for objects that have been
modified by a particular user or at a certain time

= Find Objects

File Edit View Columns Search

X e | B B m | #4 4 sl Bl
Delete Props Large Small List Details | Mame Size Date Type

Mame/Location Modfied Advanced

tiodified Objects

Stop
Modified by: | |
New Search
() &y date i

(® between |EI?£IZI4£2EI1 E | Close

and | 0705/ 2016 |

() during the previous 1 > | monthz)

() during the previous 1 = day(s]

To make the search dependent upon modification, you must check the Modified
Objects check box.

To locate objects modified by a particular user, enter the user name in the field
labelled Modified by. Otherwise leave this blank.

To find objects which have been modified at a certain time or within a specified
period of time, check the appropriate radio button and enter the appropriate dates or
time spans.
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The third page, labelled Advanced, allows you to search for objects that contain a par-
ticular text string.

= Find Objects

File Edit Wiew Columns Search

X B B @ B # o = o
Delete Props Large Small List  Details | Mame 5ize Date Type
Name/Location Modfied Advanced
Containing Text: | ™ | Stop
[Itatch Case [ Match Whale ‘Word MNew Search
[TUse Reqgular Expressions [ ] Az Symbol Feference Close
[J5ize between 0 0

If you wish to search for objects containing a particular character string, type the
string into the field labelled Containing Text.

Match Case specifies whether or not the text search is case sensitive.

Use Regular Expressions specifies whether or not regular expressions are applicable.
For example, if you enter FOO* into the field labelled Containing Text and check
this box, the system will find objects that contain any text string starting with the 3
characters FOO. If this box is not checked, the system will find objects that contain
the 4 characters FOO*.

Match Whole Word specifies whether or not the search is restricted to entire words.

As Symbol Reference specifies whether or not the search is restricted to APL symbols.
If so, matching text in comments and other strings is ignored.

If you wish to restrict the search to find only objects whose size is within a given
range, check the box labelled Size is between and enter values into the fields
provided.
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When you press the Find Now button, the system searches for objects that satisfy all
of the criteria that you have specified on all 3 pages of the dialog box and displays
themin a ListView. The example below illustrates the result of searching the work-
space for all objects containing references to the symbol Speak.

& Find Objects

File Edit View Columns Search

= B8 @ 8 # o =i o

Delete Props Large Small List  Details| Mame 5Size Date Type

Mame/Location Modfied Advanced
Containing Test: |m V| Stop
[]Match Case [T Match whale \Ward Mew Search
[[] Use Regular Expressions  [+] As Symbol Reference Close

[ Size between | 0 1]

Name Location Type Description 5
Esird # Class Namespace 1%.0
EdDomesticParrot # Class Namespace k5.
Edparrot # Class Namespace 298
< >

3 chject(s) found in Local Scope

You may change the way in which the objects are displayed in the ListView using
the View menu or the tool buttons, in the same manner as for objects displayed in the
Workspace Explorer. You may also edit, delete and rename objects in the same way.
Furthermore, objects can be copied or moved by dragging from the ListView in the
Search tool to the TreeView in the Explorer.

If you wish to specify a completely new set of criteria, press the New Search button.
This will reset all of the various controls on the 3 pages of the dialog box to their
default values.
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Object Properties Dialog Box

The Object Properties dialog box displays detailed information for an APL object. It
is displayed by executing the system action [Ob jProps]. In a default Session, this
is provided in the 7ools menu, the Session popup menu and from the Explorer. An
example (for a function) is shown below.

Properties Tab

The Properties tab displays general information about the object. For a function, this
includes an extract from its header line, when it was last modified, and by whom.

ZH #CENTRE - Properties

Properties  Value = Monitor

a CENTRE

Type Function
Dezcription

Location  #

Size 1.727Kb (1768 bytes)

Modified 04 Movember 1398 14:35

By Dyadic
Locked External
Shared Exparted

Cancel
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Value Tab

For a variable, the Values tab displays the value of the variable. For a function, it dis-
plays its canonical representation.

2 #.CENTRE - Properties

Properties  Value  Manitor

v TEXT+-W CENTRE TEXT;SPCS;FORE:BACK =8 Centre TE:
[1] TEXT(( 14pTEXT) , WIHTEXT A Stretch t
[21] SPCS+TEXT=" ' A Identify
[31] FORE++/A\SPCS B Number of
[4] BACK++/a\D5SPCS A ..
[5] TEXT+{[0.5=FORE-BACK )OTEXT R Rotate ea
v
£ >
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Monitor Tab

The Monitor tab applies only to a function and displays the result of JMONITOR.
The Reset button resets JMONITOR for the lines on which it is currently set. The Set
All Lines button sets JMONITOR to monitor all the lines in the function. The Clear
All Lines switches JMONITOR off.

=& #.CENTRE - Properties

Propetties  Value Monitor

Line Mumber Count CPU time (ms) Elapsed time (ms)
0 43288 203 228
1 43238 7 57
2 43238 16 32
3 43288 0 20
4 43238 32 28
5 43238 3 32
Reset Set All Lines Clear All Lines

Cancel
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COM Properties Tab

The COM Properties tab applies only to a function in an OLEServer or Act-
iveXControl namespace. The tab is used to define arguments and data types for an
exported Method or Property. For further information, see Interface Guide.

= #.loan.CalcPayments - Properties

Propetties  Value Monitor  COM Properties

Faram Mame Type b odifier Optional
Result WT_RB w | WT_ARRAY

Loardmnt WT_I4 e e ]
Lenkdax YT 14 “ w ]
Lenkdin WT_I4 e e ]
[tk 2 WT_l4 e e |
Inthtin | TN v | O

Help | |ID| |

(® Method () Prop Get () Prop Set | |

Ex=ported

Cancel
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Net Properties Tab

The Net Properties tab applies only to a function in a NetType namespace. The tab is
used to define arguments and data types for an exported Method or Property. For fur-

ther information, see .NET Interface Guide: .

25 #APLClasses.[Primitives].IndexGen - Properties

Propetties  Value Monitor .MNET Properties

Faram Mame Type bl odifier Optional
Reszult Int32[] e e
Murmber Int32 - - |

(@) Method (iwieb Method () Prop Get () Prop Set ‘

Public [ 5tatic [ irtual [ Constructor
[]Protected

Cancel
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The Editor
Invoking the Editor

The editor may be invoked in several ways. From the session, you can use the system
command ) ED or the system function [JED, specifying the names(s) of the object(s) to
be edited. You can also type the name of the object and then press Shift+Enter (ED),
click the Edit tool on the tool bar, or select Edit from the Action menu. If you invoke
the editor when the cursor is positioned on the empty input line, with a suspended
function in the State Indicator, the editor is invoked on the suspended function and
the cursor is positioned on the line at which it is suspended. This is termed naked
edit. These ways of invoking the editor apply only in the session window

v Editor - [BUILD_SESSION]

_ﬁ File Edit Syntax Window Refactor View - 8 x
= ﬁf ﬁ| Search... w| % % ah

[0] {FILE}BUILD_SESSION LANG:O0BJ:MSG:0I0:OML:OLD:NEW:FN:MB » &
[1] B Build the session object and save if desired

[2] :If O=[NC'NoPrompt’' ¢ NoPrompt+0 ¢ :EndIf

[3] :If O=[ONC'FILE' o FILE+'"' © :EndIf

[%]

[5] OWX-OSE.OWX+~1 ¢ OML OI0+1 o [PATH+'#.Trans'

[&] OPW+122 ®r allows room for Status Bar

[7] LANG+upCase ,LANG R frans{ation assumes uppercase

[&] UNICODE=B0=[DR" '

[9]

[10] ("Unknown lLanguage, pick one of',sTrans.CODES)OSIGNAL{ »
[11]

[12] :Trap GUI+O

[13] 'OSE'OWS 'Coord' 'ScaledPixel’

[14] GUI+1

[15] :EndTrap

[1&] v
< > |
Function Pos: 071831

In addition, there is a general point-and-edit facility which works in edit and trace
windows too. Simply position the input cursor over a name and double-click the left
mouse button. Alternatively, you can press Shift+Enter or select Edit from the File
menu. The name can appear in the Session, in an Edit window, or in a Trace window;
the effect is the same. Note that, in the Session, typing a name and pressing
Shift+Enter is actually a special case of point-and-edit. Note also that a naked edit
can be invoked by double-clicking the left mouse button in the empty input line.
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The type of a new object defaults to function/operator unless the object is shadowed,
in which case it defaults to a variable (vector of character vectors). You can however
specify the type of a new object explicitly using ) ED or JED . For example, typing
")ED eLIST -MAT"ina CLEAR WS would create Edit windows for a vector of
character vectors named LIST and a character matrix called MAT. See ) ED or[JED for
details.

If the name is not already being edited, it is assigned a new edit window. If you edit a
name which is already being edited, the system focuses on the existing edit window
rather than opening a new one. Edit windows are displayed using the colour com-
bination associated with the type of the object being edited.



Chapter 1: The APL Environment 117

Window Management (Standard)

Unless Classic Dyalog mode is selected (Options/Configure/Trace/Edit), the Editor
is a Multiple Document Interface (MDI) window that may be a stand-alone window,
or be docked in the Session window. Each of the objects being edited is displayed in
a separate sub-window. Individual edit windows are managed using standard MDI
facilities.

Editor

File Edit Syntax Window Refactor View

Jp BUILD_SESSION

@ﬂQHSearch... vi% % H aa

[o] {FILE}BUILD_SESSION LANG;0BJ;MSG:;OI0:[OML:OLD:NE® A
[1] ! B Build the session object and save if desired

[2] :If O=[NC'NoPrompt' ¢ MNoPrompt~0 ¢ :EndIf

[3] | :If O=[ONC'FILE' & FILE<"'' & :EndIf

[4] :
[5]

Eg% @ :ﬂ[ _gHSearch... vl % ah

[8] [o] MB BUILD_MB_FILE LANG

[91 |13 Ocs M8

< 21
03] "file'OWC'Menu' (LANG TranslateString'&File’)

[4]

[5] 'file.clear 'OWC'Menultem’ (LANG TranslateString'&m

[6] 'file.clear 'OWS 'Event’ 'Select’ "[wsclear]’

[7] ‘file.clear 'OWS'Hint " (LANG TranslateString'Clearm

[8] v

- . . . —
Function Pos: 12/72,6 a

The first edit sub-window window is created at the position specified by the edit
first_y and edit_first x parameters which are specified in terms of the size of a char-
acter in the current font relative to the top-left comer of the main Editor window. Sub-
sequent ones are staggered according to the values of the edit_offset_y and edit_
offset_x parameters.

The initial size of an edit window is specified by the edit_rows and edit_cols para-
meters.
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By default, the Session has the Editor docked along the right edge of the Session win-
dow. When you edit a function, the Editor window automatically springs into view
as illustrated below.

File Edit View Windows Session Log Action Options Tools Threads Help
Ws % g Wy ot (DA @ S BR [Tool £ =R Ee D
Language Bar R S DS

([l ofelolt o] [PLafel}] [=lsl] Ji[=luals] [lefofle
Dyalog APL/W-64% Version 15.0.27293 ~
Serial No : 0000%2

Unicode Edition

Betz release

Sat Apr 30 12:45:55 2016

clear ws

C:\Program Files\Dyalog\Dyalog APL-6% 15.0 Unicode\ws\buildse.dws saved Thu Apr 28 17:23:52 2016

This workspace is used to reset the session according to some
international formats like German, French or English.
ff.Trans.CODES contains the list of supported languages. (Note
that the order of the contents of this variable is important
and should not be altered)

For example, to redefine the session with an Italian look try

BUILD_SESSION 'IT"

To meke the changes permanent, you should save your session
when prompted or via the menu item Session/Save or Save as...

You can alse reset SALT here by deing
BootSALT

Dyalog 2015
Version 3.06

v &g

5

Debugg apx W
Ready. .. Ins  NUM

CurObj: 2:1 OpQ:0 [OTRAP  [SI:0  OIO:1 [ML:0

Syntax Window Refactor View
o B %y [obea § 5 @ SBR[ Tool P 5
Language Bar oo T s X
Bl ) ML L]
Serial No : 000042 ~
Unicode Edition
Beta release : {FILE}BUILD_SESSION LANG;0813MSG3OL »
Sat Apr 30 12:%5:55 2016 A Build the session object and save »

clear ws g +If 0=0NC'NoPrompt' ¢ NoPrompt-0 o »
C:\Program Files\Dyalog\Dyalog APL-6% 15.0 Unicode E :If 0=0NC'FILE' o FILE+'' o :EndIf

This workspace is used to reset the session accord E =

international formats like German, French or Engli E Fl

. Trans.CODES contains the list of supported langu : =

that the order of the contents of this variasble is : Q |[search. .

and should not be sltered) E 15 BUTLD_MB_FILE LANG
: fdcs v8

% %

For example, to redefine the session with an Itali

‘file'DWC'Menu’ (LANG TranslateString

BUILD_SESSION "IT*
‘file.clear 'IWC'MenuTltem’ (LANG Trans

To mske the changes permanent, you should save you : [15] ‘file.clear'IMS'Event’' 'Select' '[ws
when prompted or via the menu item Session/Save or g [16] ‘file.clear 'IMS'Hint' (LANG Translate
: ra71
You can also reset SALT here by doing E < ‘file.load'OWC 'Menultem' (LANG Transl
E Function ‘file.load WS 'Event’ 'Select' '[wsl
BootSALT E ‘file.load'MS Hint'(LANG TranslateS
Dyalog 2015 i ‘file.copy '[MC'Menultem' (LANG Trans
Version 3.06 ;i ‘file.copy 'S 'Event’ 'Select’ '[wsc
JED BUILD_SESSION BUILD_MB_FILE g
v -
< > g Function
5
Debugger i s o i 5 i - aox W
Ready... Ins NUM

CurObj: BUILD_MB_FILE (Function) &:1 0pbQ:0 [OTRAP [O5I:0 0OIO:1 [OML:0
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You can resize the Editor pane to view more or less of the Session itself, by dragging
its title bar.

Using the buttons in the title bar, you can instantly maximise the Editor pane to
allow you to concentrate on editing, or minimise it to reveal the entire Session. In
either case, the restore button quickly restores the 2-pane layout.

The picture below shows the effect of maximising the Editor. The BUILD_SESSION
edit window is itself maximised within the Editor too.

7 C:AProgram Files\Dyalog\Dyalog APL-64 15.0 Unicod se. tyalog APL/W-64 - [BUILD_SESSION]
I File Edit Syntar Window Refactar View NI
ws % ol M %y | Object ] 51 @ S B[R Tool P 1S E Edit gl g1 9 @ |l Session 161=
x =0 P @ |[seerch... “]% % @ aa
IJ [o] {FILE}BUILD_SESSION LANG;0BJ:MSG:[IO:[JML;OLD;NEW;FN;MB;5B1;SB2:T8:5B:5SBH:tools:dyalogskin;ok;[PATH: font:bm;UNIm A
[11 & Build the session object and save if desired
i 1[2] :If 0=[INC'NoPrompt’ o NoPrompt«0 o :EndIf
2031 :If 0=[INC'FILE' ¢ FILE='' o :EndIf
[4]
=151 Owx~0se.Owx~1 ¢ OML OI0-1 ¢ OPATH='#.Trans'
[6] OPW~122 @ alfows room for Status Bar
2171 pCase,LANG A fransisiron sssumes uppercase
- [[8] 50<00R"
[9]
[10]
[11]
[12] Trap GUI-0
S l[13] ‘05 '0OWS 'Coord’ “"ScaledPixel’
2 1e] GUI=1
[15] :EndTrap
[16]
[17] Expunge MenuBar(s). StatusBar(s), ToolBar(s). TipField(s), [SE.WSDoc and [JSE.NumEd
[18] ~OWN 05
[19] (0BT OWG"<'Type')e 'Menuar' 'StatusBar' 'ToolBar' 'TipField’' 'Menu’ 'CoolBar')/08]
[20] OSE.WsDoc' ‘[SE.NumEd'
[21] J
[22]
[23]
S 2] I:1
S |[25] DQ'MSG'OWC'MsgBox ' 'BUILD_SESSION'w(’'Style' ‘Query'}('Event' 'ALL’ 1)
263 }
20271
[28] ? :If 0e=p0BJ-0SE.ONL 2 3 % 9
5291 0BJ+~e' '"40B] ©
% < >
W Function Last saved by: johnd: 22/04/2015  Pos: 0/183,1
Ready... Ins NUM
Cur0bj: BUILD_MB_FILE (Function) &:1 00Q:0 | OTRAP  OSI:0 [OI0:1 [ML:0

Note that when the Editor has the focus, the Editor menubar is displayed in place of
the Session menubar.
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Window Management (Classic Dyalog mode)

If Classic Dyalog mode is selected (Options/Configure/Trace/Edit) each Edit win-
dow is a top-level window created as a child of the Session window. This means that
normally Edit windows appear on top of the Session. However, if the SessionOnTop
parameter is set, the Session window, when given the focus, will appear on top of
Edit windows.

When the first Edit window is opened, its position is determined as follows:

« If the ClassicModeSavePosition parameter is set, the first Edit window is
displayed at the position that was previously occupied by the most recently
saved Edit window.

« Ifnot, the first edit window is created at the position specified by the edit_
first_y and edit_first x parameters which are specified in terms of the size
of a character in the current font relative to the top-left comer of the screen.

The initial size of an edit window is specified by the edit_rows and edit_cols para-
meters.

;m BUILD_SESSION

File Edit Syntax Refactor View

= | ﬁ‘f g| Cearch... w| * % ah
[0] {FILE}BUILD_SESSIOMN LANG:;OBI:MSG:0OI0:m &
[1] R Build the session object and save ifm
[2] :If O=[NC'NoPrompt’' ¢ NoPrompt+0 ¢ :Em
[3] :If O=[ONC'FILE' e FILE+'" & :EndIf

[%]

[5] OWx-{SE.OWx=1 ¢ OML OIC+1 ¢ [OPATH='#.m
[&] OPW+122 B a{lows room for Status Bar w
£ >
Function

Subsequent ones are staggered according to the values of the edit_offset_y and edit_
offset_x parameters.
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File Edit Syntax Refactor View

E'H File Edit Syntax Refactor View
[2] = ﬁ'f m||EEEFCh... w| ¥ % ah
[3] o7 BUILD_TC LANG:X:IL:TB:S ~
[410r1] n Build Tool Control
[5] [2] IL~'05E.cbtop.il e, " 'nhi"
[e] [3] Ti+~'[Jse.cbtop.bandtbl. tb’
< e T8 OWC'Toolcontrel'{'Divider' 0)('Show
Func|[ 5] L:ﬁ :tWith T8
=I[&] OWS 'Imagelist'IL W
< >
Function

Moving around an edit window

You can move around in the edit window using the scrollbar, the cursor keys, and

the PgUp and PgDn keys. In addition, Ctrl+Home (UL) moves the cursor to the begin-
ning of the top-line in the object and Ctrl+End moves the cursor to the end of the last
line in the object. Home (LL) and End (RL) move the cursor to the beginning and

end respectively of the line containing the cursor.

Closing an edit window

Closing an edit window from its System Menu has the same effect as choosing Exit
from the File Menu; namely that it fixes the object in the workspace and then closes
the edit window.

Minimising an edit window

Minimising an edit window causes it to be displayed as a Dyalog APL Edit icon,
with the name of the object underneath. The edit window can be restored in the nor-
mal way, or by an attempt to re-edit the same name.
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Editor ToolBar

=@ A m||EEEI'C"|...

V% % Eaal e i

In the table below, the first image shows the appearance of the toolbutton with Nat-
ive Look and Feel enabled; the second with it disabled.

Button

—
=

Toggle line numbers

A

Comment selected text

A

Uncomment selected text

2 x

Save changes and retumn

Search... e
| [~
Search Box

-‘F‘ f}{:}

Search for Next Match

ib a0

Search for Previous Match

Search hidden text

Description

Toggles Line numbers on/off

Adds a comment to the beginning
of the current line or all selected
lines

Removes a comment (if present)
from the current line or all selected
lines

Saves changes and closes the
current edit window

Enter search text and click one of
the following two buttons

Locates the next occurrence of the
search text

Locates the previous occurrence of
the search

Determines whether or not the
search examines collapsed blocks
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Button

asd  aa
Match case

T m

Refactor text as method

@

Refactor text as field

+
L] *p
Refactor text as property

Description

Specifies whether or not the search
is case-sensitive

Inserts a Method template for the
selected name

Inserts a Field template for the
selected name

Inserts a Property template for the
selected name
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The File Menu
Fix
Fix script
Open File...
Save

Save As..,

Always ask on close
Edit

Print...
Print Setup...

Properties

Exit (and Fix)
Exit (and fix script)

Shift+Enter

Esc

Exit and discard changes Shift+Esc

The File menu illustrated above is displayed when editing a simple object and
provides the following options.

Item Description
Fixes the object in the workspace, but leaves the edit

Fix window open. Edit history is also preserved. If the
data has changed and the confirm_fix parameter is set,
you will be prompted to confirm.

Fix Script (Disabled unless editing a script)

Open File Allows you to edit a Dyalog script file or an arbitrary
text file.

Save Saves the file being edited.

Save As Renames and saves the file being edited.

Always ask on close |Toggels the value of the confirm_fix parameter.

Edit Opens an Edit window on the name under the cursor
(Disabled when there is no such name).

Print Prints the current contents of the edit window
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Item Description
Print Setup Displays the Print Configuration dialog box
Properties Displays the Object Properties dialog box for the

current object

Exit (and Fix)

Fixes the object in the workspace and closes the edit
window. If the data has changed and the confirm exit
parameter is set, you will be prompted to confirm

Exit (and fix script)

(Disabled unless editing a script)

Exit and discard
changes

Closes the edit window, but does not fix the object in
the workspace. If the data has changed and the
confirm_abort parameter is set, you will be prompted
to confirm.

The File Menu (editing a script)

Fix whole script

Fix cnly functions

Open File...
Save
Save As..,

Always ask on close

Edit Shift+Enter
Print...

Print Setup...

Properties

Exit and fix whole script Esc

Exit and fix only functions

Exit and discard changes Shift+Esc
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Fix whole script Fixes the entire script

Fix only functions Fixes only the functions in the script.

Exit and fix whole . . . . .
Fixes the entire script, and exits the Editor.

script
Exit and fix only Fixes only the functions in the script and exits the
functions Editor.

Editing Scripts

Suppose that you have a Class that manages a list of items in a shared Field, so some-
where in the script would appear a line such as:-

:Field shared public List<«@

You run your application for a bit, and L i s t, which was initially empty, gets
updated as new instances of the Class are created. You then edit the Class to add a
new function, or fix a bug. In this instance, when you exit the editor you may not
want L st to be reset back to the empty vector although you do want the new ver-
sion of the function(s) in the Class to be fixed.

Nevertheless whenever you edit the Class when it is not suspended, you probably
always want the entire script to be re-fixed, and L i st re-initialised.

The options in the File menu shown above provide for these alternatives.

In addition, the Configuration Dialog (see Installation & Configuration Guide: Con-
figuration Dialog: Trace/Edit Tab) allows you to define the behaviour of the key-
strokes <EP> and <S1> for both the suspended case and the non-suspended case.
This association will be displayed against the appropriate action according to the
state of the script you are editing.
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The Edit Menu

The Edit menu provides a means to execute those commands that are concerned with
editing text. The Edit menu and the actions it provides are described below.

Reformat Mum divide
Reformat Scripts Automatically

Undeo Control+Shift+Back
Redo Control+Shift+Enter
Select 4ll

Cut Shift+Delete
Copy Control+Insert
Paste Shift+nsert

Paste Unicode
Paste Mon-Unicode

Clear Delete

Open Line
Delete Line Control+Delete
Goto Line

Find...
Replace...

Highlight All Matches

Comment Selected Lines

Uncomment Selected Lines

Teggle Local Name Control+Up
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Item

Description

Reformat

Reformats the function body in the edit window,
indenting control structures as appropriate.

Reformat Scripts

If checked, the Editor will automatically reformat a

Automatically Dyalog script when it loads it.
Undoes the last change made to the object. Repeated
Undo use of this command sequentially undoes each change
made since the edit window was opened.
Re-applies the previous undone change. Repeated use
Redo of this command sequentially restores every undone
change.
Select All Sejlects and highlights the entire contents of the Edit
window.
Copies the selected text to the clipboard and removes
Cut . .
it from the object.
Copy Copies the selected text to the clipboard.
Paste Copies the text in the clipboard into the object at the

current location of the input cursor.

Paste Unicode

Same as Paste, but gets the Unicode text from the
clipboard and converts to AV

Paste Non-Unicode

Same as Paste, but gets the ANSI text from the
clipboard and converts to [JAV.

Clear

Deletes the selection or the character under the cursor.
Has no effect on the clipboard

Open Line

Inserts a blank line immediately below the current one.

Delete Line

Deletes the current line.

Prompts for a line number, then positions the cursor on

Goto Line that line.
Find Displays the Find dialog box.
Replace Displays the Replace dialog box.

Highlight All
Matches

If checked, all strings in the object being edited that
match the search string are highlighted. The highted
items change dynamically as the seacrh string is
entered or changed.
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Item

Description

Comment selected
lines

Adds a comment symbol to the beginning of all
selected lines.

UnComment
selected lines

Removes a comment symbol from the beginning of all
selected lines.

Toggle Local name

Adds or removes the name under the cursor to/from the
function header line.

The Find and Replace items are used to display the Find dialog box and the
Find/Replace dialog box respectively. These boxes are used to perform search and
replace operations and are described later in this Chapter.

Once displayed, each of the two dialog boxes remains on the screen until it is either
closed or replaced by the other. This is convenient if the same operations are to be
performed over and over again, and/or in several windows. Find and Find/Replace
operations are effective in the window that previously had the focus.

The Syntax Menu
Mothing
v APL
JS0M
HML

The Syntax menu illustrated above provides options to specify how the data dis-
played in the Editor window is to be syntax coloured. For workspace objects, the
default is APL for functions and operators, and Nothing for variables.

Item Syntax Colour as
Nothing Variable

APL Function

JSON JSON array

XML XML array
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The Window Menu

The Window menu provides a means to control the display of the various edit win-
dows. The Window menu and the actions it provides are described below.

Close All Windows
Cascade

Tile Vertically

Tile Horizontally

Arrange lcons

Language Bar

Debugger >
Editor >
Item Description

Close All Windows

Closes all the edit windows. If Confirm on Edit
Window Closed is checked, you will be prompted to
confirm for any objects that you have changed.

Cascade

Arranges the edit windows in overlapping fashion.

Tile Vertically

Arranges the edit windows tiled one above the other.

Tile Horizontally

Arranges the edit windows tiled alongside one
another.

Arrange Icons

Arranges any minimised edit windows.

Editor

Allows you to Select the edit window corresponding
to the named object.
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The Refactor Menu

Add text as Field
Add text as Property
Add text as Method

The Refactor menu illustrated above applies only when editing a Class and provides
the following options. In each case, the user must highlight a name in the Edit win-
dow, and then select one of these options to insert the appropriate template for that
name into the body of'the Class.

Item

Description

Add text as Field

Inserts a Field template for the selected name.

Add text as Property

Inserts a Property template for the selected name.

Add text as Method

Inserts a Method template for the selected text name.

The View Menu
Trace
~  Stop
Manitor

»  Line Mumbers

Mum -

Function Line Mumbers

Tree View

Compiler Errors

~  Outlining
Expand All Outlines

Collapse All Outlines

Expand all Qutlines below here
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The View menu, illustrated above, provides the following actions.

Item Description
Trace Displays a column to the left of the function that
displays OTRACE settings
Displays a column to the left of the function that
Stop . .
displays STOP settings
. Displays a column to the left of the function that
Monitor . .
displays IMONITOR settings
Line Numbers Toggles the display of line numbers on/off.

Toggles the display of line numbers on individual
functions on/off. This option is only enabled when
editing a Class, Namespace script or Interface.

Function Line
Numbers

Toggles the display of the treeview in the left-hand
pane.

Tree View

If enabled, the Editor identifies which lines of code
would not compile. These are identified by a red
Compiler Errors vertical line to the left. Hovering over the red bargives
you a pop-up telling you what the compiler didn't like
about that line of the function.

Outlining Turns outlining on and off.

Expand All Outlines | Expands all outlines.

Collapse All

Outlines Collapses all outlines

Expand all Outlines | Expands all outlines below the level of the current
below here line.

Function Line Numbers

The Function Line Numbers option in the Editor menu provides an additional level
of line-numbering. If selected, line numbers are displayed independently on each indi-
vidual function (or operator) in the Class. This option is only enabled when you are
editing a Class, Namespace script or Interface, and is disabled for all other types of
object.

Note that function line-numbering and general line-numbering are independent
options and it is possible to have the entire Class numbered (from [0] to the number
oflines in the Class) in addition to having line-numbering on each individual func-
tion.
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Using the Editor

Creating a New Function

Type the name of your function and invoke the editor. To do this you may press
Shift+Enter, or select Edit from the Action menu, or double-click the left button on
your mouse, or click the Edit tool in the tool bar. A new window will appear on the
screen with the name you have chosen displayed in the top border. The name is also
inserted in the function header and the cursor positioned to the right. The new win-
dow is automatically given the input focus.

Line-Numbers onloff

Try changing the line numbers setting by clicking on the Line Numbers option in the
Options menu. Note that line-numbering on/off is effective for all edit windows.

Adding Lines

Ifthe keyboard is in Insert mode, pressing Enter at the end of a line opens you a new
blank line under the current one and positions the cursor there ready for input. You
can also open a new blank line by pressing Ctrl+Shift+Insert (OP).

Ifthe cursor is at the end of the last line in the function, pressing Enter adds another
line even if the keyboard is in Replace mode.

Indenting Text

Dyalog APL allows you to insert leading spaces in lines of a function and (unless the
AutoFormat parameter is set) preserves these spaces between editing sessions.
Embedded spaces are however discarded. You can enter spaces using the space bar or
the Tab key. Pressing Tab inserts spaces up to the next tab stop corresponding to the
value of the TabStops parameter. If the AutoIndent parameter is set, new lines are
automatically indented the same amount as the preceding line.

Reformatting

The RD command (which by default is mapped to Keypad-Slash) reformats a func-
tion according to your AutoFormat and TabStops settings. See Installation & Con-
figuration Guide: Configuration Dialog: Trace/Edit Tab.

Deleting Lines

To delete a block of lines, select them by dragging the mouse or using the keyboard
and then press Delete or select Clear from the Edit menu. A quick way to delete the
current line without selecting it first is to press Ctrl+Delete (DK) or select Delete
Line from the Edit menu.
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Copying Lines

Select the lines you wish to copy by dragging the mouse or using the keyboard. Then
press Ctrl+Insert or select Copy from the Edit menu. This action copies the selection
to the clipboard. Now position the input cursor where you wish to make the copy
and press Shift+Insert, or select Paste from the Edit menu. You can also use this
method to duplicate a ragged block of text.

To copy text using drag-and-drop editing:

1. Select the text you want to move.

2. Hold down the Ctrl key, point to the selected text and then press and hold
down the left mouse button. When the drag-and-drop pointer appears, drag
the cursor to a new location.

3. Release the mouse button to drop the text into place.

Moving Lines

Select the lines you wish to copy by dragging the mouse or using the keyboard. Then
press Shift+Delete or select Cut from the Edit menu. This action copies the selection
to the clipboard and removes it. Now position the input cursor at the new location
and press Shift+Insert, or select Paste from the Edit menu. You can also use this
method to move a ragged block of text.

To move text using drag-and-drop editing:

1. Select the text you want to move.

2. Point to the selected text and then press and hold down the left mouse but-
ton. When the drag-and-drop pointer appears, drag the cursor to a new loc-
ation.

3. Release the mouse button to drop the text into place.

Joining and Splitting Lines
To join a line to the previous one: select Insert mode; position the cursor on the first

character in the line; press Bksp.

To split a line: select Insert mode; position the cursor at the place you want it split;
press Return.

Toggling Localisation

The TL command (which by default is mapped to Ctrl+Up) toggles the localisation
of the name under the cursor. If the name is currently global, pressing Ctrl+Up causes
the name to be added to the list of locals in the function header. If the name is already
localised, pressing Ctrl+Alt+] removes it from the header.
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Aligning Comments

When you press the <AC> key, or select Align Comments in the Editor's context
menu, the alignment of the comments in every line in the function will be changed
so that the left-most comment (Lamp) symbol is in the same column as the cursor,
except that:

o Comment sysmbols that are preceded only by white space, i.e. comments in
lines that contain no code, are ignored and are not adjusted in any way.

« Comment symbols that lie between the first column and the first tab stop
will remain in or be moved to the first column. For information on setting
tab stops, see Installation & Configuration Guide: Configuration Dialog
(Edit/Trace Tab).

o Comment symbols will not move further left than the end of the statement.

When a comment is re-aligned, text to the right of the left-most comment symbol
(including spaces and other comment symbols) will remain fixed in relation to that
symbol.

Note that there is no keystroke associated with this command by default; the user
must define one. See Installation & Configuration Guide: Configuration Dialog
(Keyboard Shortcuts Tab).

White Space in Source Code

Settings that impact the automatic reformatting of code can cause changes to
whitespace — this can be interpreted as changes to the source code. This means that:

« opening a scripted object in the Edit window can cause the source of that
object to change (when closing an Edit window, you might be prompted to
save a function even though you have not made any changes to it).

« viewing an object can change its file timestamp; source code management
systems can subsequently report changes due to the changed file timestamp.

« source code changes resulting from reformatting will be evident in the res-
ults of system functions such as JAT, OSRC, [OCR, OVR and [NR.
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Outlining

When you are editing a function, outlining identifies the blocks of code within con-
trol structures, and allows you to collapse and expand these blocks so that you can
focus your attention on particular parts of the code

The picture below shows the result of opening the function JSE.cbtop.TB_

POPUP.

Jed [SE.cbtop.TB_POPUP

. Editor - [O5E.cbtop. TB_POPUP]

ﬁFiIe Edit Syntax Window Refactor View - &8 X
= G ﬂf Ql Search... w| % ah

[o] {FLAG}TB_POPUP M5G;TC

[1] R Popup menu on Session ToolControl

[2] E :If 0=[NC'FLAG'

[3] = :If (2=5=MS5G) A Right mouse button 7

[%] "popup.captions '[OWS 'Checked’

[5] 'popup.list'[WS'Checked'{'Flatlist's )

[a] "popup.multiline'OWS'Checked’

[7]1 0po ' popup’

[2] | 1End

[9] iElse

[10] TC+='bandtb1l.tb' 'bandtb2.tb' 'bandtb3.tb' 'bandtb&.tb'
[11] = :Select FLAG

[12] iCase 1

[13] A

[14] TC OWS"='ShowCaptions'

[15] iCase 2

[18] ~(1+"'FlatlList'=s )="FlatList' 'FlatButtons'
[17] TC OWS™="Style’

[18] :Case 3

[19] -

[20] TC OWS"="'Multiline’

[21]

[22] B :End

[23] [ :End

Function Pos: 3/24.6

Notice that the various control structure blocks are delineated by a treeview diagram.
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o When you hover the mouse pointer over one of the boxes that mark the
start of a block, the line marking the extent of that block becomes high-
lighted, as shown above.

« Ifyou click on a [=] box, the corresponding section collapses, so that only
the first line of the block is displayed, as shown below.

o Ifyou click on a H box, the corresponding section is expanded.

% Editor - [OSE.cbtop.TE_POPUP]

ﬂ File Edit Syntax Window Refactor View - 8 x
=0 & |5earch... w| % % ah,

[0] {FLAG}TE_POPUP MSG;TC

[1] A Popup menu on Session ToolControl

[2] I :If 0=[NC'FLAG’

[3] e :[[f (2=5>MSG) B Right mouse button 4

[9] tElse

[10] TC+'bandtbl.tb' 'bandtb2.tb' 'bandtb3.tb' 'bandtb&%.tb’
[11] = :Select FLAG

[12] :Case 1

[13] -

[14] TC OWs"='ShowCaptions’

[15] :Case 2

[16] ~(1+'Flatlist'= )J="FlatList' 'FlatButtons'
[17] TC OWS"<='Style’

[18] :Case 3

[19] -

[20] TC OWS"='Multiline’

[21]

[221: | :End

[23] L :End

Function Pos: 3/24.6
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Sections

Functions and scripted objects (classes, namespaces etc.) can be subdivided into Sec-
tions with : Section and : EndSection statements. Both statements may be fol-
lowed by an optional and arbitrary name or description. The purpose is to split the
function up into sections that you can open and close in the Editor, thereby aiding
readability and code management. Sections have no effect on the execution of the
code, but must follow the nesting rules of other control structures.

The following picture illustrates the use of sections in a function called
DumpWindow. The function is divided into 5 sections named Comments, Init,
NAs, MakeBitmapand CopyToClipBoard.

The first picture shows the function with all sections closed.

. Editor - [DumpWindow]

ﬁ File Edit Syntax Window Refactor View - & X
= | ﬁ‘f ﬁ| Search... w| ¥ % an
[0] DumpWindow ref:0IO0:0OML

[1] :Section Comments

[&] :Section Init

[10] :Section MAs

[25] :Section MakeBitmap

[37] :Section CopyToClipBoard

£ }I

Function
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The next picture shows the effect of opening the Comments section. Notice how this
is delineated by the statements:

:Section Comments

:EndSection Comments

@ Editor - [DumpWindow]

ﬁ File Edit Syntax Window Refactor View - 9 %
= O ﬁ‘f g||5earch... w|H ah

[o] DumpWindow ref;0I0;0ML

[1] :Section Comments

[2] A eg DumpWindew f A note unguoted name

[3] A Note only the visible part of the window is dumped

[4] A you may need to set "OnTop' to ensure total window visibility
[5] iEndSection

[&] :Section Inmit

[10] :Section NAs

[25] :Section MakeBitmap

[37] :Section CopyToClipBeard

< > |
Function Pos: 0/44,1

And with the Init section opened too:

/- Editor - [DumpWindow]

,ﬁ- File Edit Syntax Window Refactor View - 8 %
=@ A QHSearch... v B & an

[0] DumpWindow ref:0I0;0ML

[1] [ :5ection Comments

[2] A eg DumpHindew f A note unguoted name

[3] A Note only the visible part of the window is dumped

[%] A you may need to set "OnTop' to ensure total window visibility
[5] | :EndSection

[&] [l :5ection Inmit

[7] OML OI0-0

[&] OSHADOWt (='ref ' }~=" "~Z"4[REFS=[SI

[9] :EndSection

[10] :Section NAs

[25] :5ection MakeBitmap

[37] :5ection CopyToClipBoard

£ )I

Function Pos: /44,1
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Finally, with all the sections opened:

.m Editor - [Dum pWindow]

_ﬂFiIe Edit Syntax Window Refactor View - &

= G ﬁf QHSearch... vil®% % ah

[a] DumpWindow ref:;0I0:0OML

[1] [ :Section Comments

[2] A eg DumpWindow f @A note unguoted name

[3] A Note only the visible part of the window is dumped

[%] A you may need to set 'OnTop' to ensure total window visibility

[5] | :EndSection

[6] [E] :Section Init

[7] OML 0OI0+0

[&] OSHADOMWt (= ref ' )~~" "~2"4[REFS5=05I

[9] | :EndSection

[10] [F] :Section NAs

[11] ONA'P user3d2|GetWindowDC P 3
[12] ONA'UY% user3d?|GetWindowRect Po={U% U4 Uy% Us} 3
[13] ONA'U% user32|ReleaseDC PP »
[14] ONA'UY user32|OpenClipboard P 3
[15] ONA'UY user32|EmptyClipboard 3
[186] ONA'P  user32|SetClipboardData uy p [
[17] ONA'UY user32iCloseClipboard »
[18] ONa'P gdi3d2|CreateCompatibleDC P »
[19] ONa'P gdid2|CreateCompatibleBitmap P U4 U4 3
[20] Oma'e gdid2|5SelectObject PP 3
[21] ONA'U% gdi32|DeleteDC P »
[22] ONA'U+  gdid2|Deletelbject B [
[23] ONA'Us gdi32|BitBLt P U% U% U4 Uy P Us Us Uty »
[24] | :EndSection

[25] [l :Section MakeBitmap

[26] hwnd=ref .[OWG 'Handle'

[27] hde+GetWindowDC hwnd

[28] sze+——/%? 2pi=-GetWindowRect hwnd(4p0)

[29] mde+~CreateCompatibleDC hdc

[30] hbm-CreateCompatibleBitmap hdec,sze

[31] old+SelectObject mdc hbm

[32] jnk+~BitBlt mdec O O,sze,hdc O O 133698676 A SRCCRY

[33] jnk+SelectObject mde old

[34] jnk+ReleaseDC hdec O

[35] ink+~DeleteDC mde

[36] | :EndSection

[37] [ :Section CopyToClipBoard

[38] ink-OpenClipboard 0

[39] ink+EmptyClipbkoard

[40] jnk~5etClipboardData 2 hbm A 2 = CF_BITMAP

[%1] jnk+CloseClipboard

[42] jnk+DeleteObject hbm

[#3] :EndSection

< ).
Function Pos: 0/44,1
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Editing Classes

The picture below shows the result of opening the ComponentF i Le class. Notice
how each function is delineated separately and that each function is individually
line-numbered.

)ed ComponentFile

A Editor - [ComponentFile]

ﬁ File Edit Syntax Window Refactor View - 8 X
= A A Q|[sesrch. .. v % s @maal e
B--M#.Componentﬁle :Class ComponentFile ~
-85 [Constructors] & :Field Private Instance tie
& tField Private instance temp~0 m T
-2ty [Properties] Qio=t o Omi+t

[0] =] v Open filename

[1] A Open Named File

[2] :Implements Constructor

[3] tAccess Public Instance

(4]

[5] =] :Trap 0

[&] tie~filename OFSTIE O

[71 :Else

[&a] OFUNTIE filename OFCREATE O »

[9] tie~filename OFSTIE 0 3

[10] B :EndTrap

[11] B v

[0] =] v OpenTemp;[USING;:

[1] A Default: Open temporary file

[2] :Implements Constructor

[3] tAccess Public Instance

(4]

[5] OUSTNG='*

[a] z+System.I0.Path.GetTempFileName

[7] z ONERASE z [ONTIE O & Erase the ®

[8] tie-z OFCREATE 0

[9] temp+1

[10] B v

[0] v Close

[1] :Implements Destructer

[2] I tieclFNUMS

[3] :If temp ¢ Name [JFERASE tie

[%] :Else o [OFUNTIE tie

[5] tEndIf

[6] tEndTf

[7] v .

£ >

Class Pos: 4/113,4
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The outlining feature really comes into its own when editing classes because you can
collapse and expand whole functions. The picture below shows the effect of col-
lapsing all but the Append method.

.m Editor - [ComponentFile]

ED File Edit Syntax Window Refactor View - 8 X
i= @ @ @ |[search... v[% % @ aal e 11
E--E:I#.ComponentFiLe :Class ComponentFile
#-39 [Constructors] & :Field Private Instance tie
& :Field Private instance temp~0 B Twk
jo-l @ L+1
w4 [Properties] 3o O
v Open filename
v OpenTemp:[JUSING;:
v Close
R ——— Instance Methods --—-
[0] v r+Append data
[1] tAccess Public Instance
[2] r+datz OFAPPEND tie
[3] v
v Rename nzme
v Replace(comp data)
A --- Instance Properties ---
:Property Name
:Property Count
:Property Access
:Property Numbered Componer
R --- Shared Members
v Delete file;tie
:EndClass A Class ComponentFile
£ >

Class Pos 4/113,4
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When you edit a class, a separate treeview is optionally displayed in the left pane to
make it easy to navigate within the class. When you click on a name in the treeview,
the editor automatically scrolls the appropriate section into view (if necessary) and
positions the edit cursor at its start. The picture below illustrates the result of opening
the [Methods] section and then clicking on Rename.

.m Editor - [ComponentFile]

ﬂFiIe Edit Syntax Window Refactor View - 8 x
i= @ @ @ |[seerch... v S ®Eaal et
B--M#.Componentﬁle [0] v Close ~
-39 [Constructors] [1] :Implements Destructor
oy [Fields] [2] :If tieelFNUMS
P [3] :If temp ¢ Name [FERASE tie
= Method
[Ng—'[a‘: ° sd] [&] :Clse o OFUNTIE tie
el Appen [5] :EndIf
[6] tEndIf
[71 v
B Replace A --- Instance Methods ---
-2 [Properties]
[0] =] v r+Append dzta
[1] :Access Public Instance
[2] redztz OFAPPEND tie
[3] L v
[o] B] v Rename namel
[1] :Access Public Instance
[2] name [OFRENAME tie
[3] L v
[0] =] v Replace(comp data)
[1] :Access Public Instance
[2] data OFREPLACE tie,comp
[3] L v
A ——- Instance Properties ---
:Property Name
tAccess Public Instance
[o] v r+get
[1] (TF tiecOFNUMS ¢ ~~[FNAMES[Ow
[2] :Else & r='" ¢ :EndIf
[3] v
:EndProperty
:Property Count
:Access Public Instance
[0l v r~Get "
o P .

Class Pos: 47/113,0
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Sections within Scripts

Scripts can also be subdivided into Sections using : Section and :EndSection
statements. As with single functions, the purpose is only to split the script up into sec-
tions that you can open and close in the Editor. Sections have no effect on the exe-
cution of'the code.

The following picture illustrates a Class named actuarial which, for editing pur-
poses, has been sub-divided into five separate Sections named Main,
MenuHandlers,Validation,Utilities and OldCode. In this picture, all
the Sections are closed.

~m Editor - [actuarial]

ﬁ File Edit Syntax Window Refactor View - 8 X
= @ A Q|[searcn. .. vl e Eaal et
-0 #.actuarial :Class actuarial: Page
-3 [Sections] :Using System
T Main :Using System.HED.UE,Eystem.ueo.dLL
T MenuHandlers tUsing System.Web.UI.HtmlControls
:Using System.Web.UL.WebControls

TOLv.t.IC:_:dt_z :Using System.Data,system.data.dll
: % Utilities tAccess Public

Validation :Section Main

]

tSection MenuHandlers
:Section VYalidation
:Section Utilities
tSection OldCode
:EndClass
< > ]

Class Pos: 0/1500,0
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The next picture shows the effect of opening just the Ma i n section.

+m Editor - [actuarial]

ﬂ File Edit Syntax Window Refactor View - 8 x
i= @ @ @ |[search... v/ % Eaal e 1
=-ED #.actuarial :Class actuarial: Page
-2 [Sections] :Using System
EIT Main :Us?ng System.Heo.UE,systim.we:.dLl
Craf) [Methods] :Us?ng System.He:».U:.HtmLuﬂﬁtrols
BCALC FsL :Using System.Web.UI.WebControls
: — - :Using System.Data,system.data.dll
: BCALC—FSLT tAccess Public
. a Page_Load [ :Section Main
[j---T MenuHandlers v Page_Load; INT;AGE;DUR; TERM;TAE
[]---T OldCode v CALC_FSLTAB_RESULTS(obi ev)ii;e
EJ'"T Utilities v CALC_FSL_RESULTS(obj ev):;X;CHAR
EJ"'T Validation :EndSection
:Section MenuHandlers
:Section Validation
:Sectiom Utilities
:Section OldCode
tEndClass
< AR >
Modified Class Pos: 146/1497,3

Notice that this section is delimited by the two statements:

:Section Main

:EndSection Main
In this picture the 3 functions within the Mai n section are temporarily closed.
Similarly, the section called Val idation is delimited by:

:Section Validation

:EndSection Validation
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Editor - [actuarial]

b File Edit Syntax Window Refactor View

=/ A0 ||5&arch...

B

» S EHalt e

-0 #.actuarial

£ [Sections]
i Main
MenuHandlers
OldCode
Utilities
Validation
24681 [Methods]
..... ) VALIDATE_AGE
..... & VALIDATE_DUR
..... ) vaLIDATE_DURL | [LO]
..... ) VALIDATE_INT [;]
..... {£] VALIDATE_INT1 {3%
..... {] VALIDATE_INT2 | |[4]
..... £ VALIDATE_INTY ||[5]
..... ) VALIDATE_MPC1 | |[6]
..... ) VALIDATE_TERM ||[7]
..... & VALTDATE_TERM1 | [[8]

[10]

—E—EA—EA—E—8

o

[o]
[1]
[2]
[3]
[4]
[5]
[e]
[7]

ra

=

:Class actuarizl: Page
tUsing System
tUsing System.Meb.UI system.web.dll
:Using System.Web.UIL.HtmlControls
:Using System.Web.UI.WebControls
:Using System.Data,system.data.dll
ihccess Public

:S5ection Main

:5ection MenuHandlers

:5ection Yalidation

v YALIDATE_AGE(scurce args) A Val »
:Access Public

:Signature VALIDATE_AGE QObject =

iTrap 0

AGE~Convert.ToInt32 zrgs.Va »
:Else

args.IsValid«=0

tReturn
:EndTrap

args.IsValid+-{10sAGE)AB0zAGE

v YALIDATE_DUR(source args):DT & »
:Access Public
:Signature VALIDATE_DUR Object m
:If 2=GET_RUN_OPTION

DT=+/10 1=(TA TB).
tEndIf

Modified Class

Pos: 188/14328,0
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Find and Replace Dialogs

The Find and Find/Replace dialog boxes are used to locate and modify text in an
Edit window.

Find / Replace X

Search Far: | w | | Find Mesxt |
Replace 'Wwith: | w | Replace
Fieplace All
[] Match Casze [ ] Match whale Ward
. Jndo
[] Uze Regular Expressions Wrap Search
Atobove Llose
Direction
) Up (® Down
Enter the text string that you want to find. Note that the
text from the last 10 searches is available from the drop-
Search For down list. If appropriate, the search text is copied from the

Find Objects tool. This makes it easy to first search for
functions containing a particular string, and then to locate
the same string in the functions.

Enter the text string that you want to use as a replacement.
Replace With | Note that the text from the last 10 replacements is available
from the drop-down list.

Match Case Check this box if you want the search to be case-sensitive.

Match Whole | Check this box if you want the search to only match only
Word whole words.

Use Regular

; Check this box if you want to use wild card symbols.
Expressions

If checked, the Find or Find/Replace dialog box will
AutoMove automatically position itself so as not to obscure a matched
search string in the edit window.

Direction Select Up or Down to control the direction of search.
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Using Find and Replace

Find and Replace work on the concept of a current search string and a current
replace string which are entered using the Find and Find/Replace Dialog boxes.
These boxes also contain buttons for performing search/replace operations.

Suppose that you want to search through a function for references to the string
"Adam". It is probably best to work from the start of the function, so first position the
cursor there (by pressing Ctrl+Home). Then select Find from the Edit menu. The Find
Dialog box will appear on your screen with the input cursor positioned in the edit
box awaiting your input. Type "Adam" and click the Find Next button (or press
Return), and the cursor will locate the first occurrence. Clicking Find Next again will
locate the second occurrence. You can change the direction of the search by select-
ing Up instead of Down. You could search another function for "Adam" by opening
anew Edit window for it and clicking Find Next. You do not have to redefine the
search string.

Now let us suppose that you wish to replace all occurrences of "Adam" with
"Amanda". First select Replace from the Edit menu. This will cause the Find Dialog
box to be replaced by the Find/Replace Dialog box. Enter the string "Amanda" into
the box labelled Replace With, then click Replace All. All occurrences of "Adam" in
the current Edit window are changed to "Amanda". To repeat the same global change
in another function, simply open an edit window and click Replace All again. If
instead you only want to change particular instances of "Adam" to "Amanda" you
may use Find Next to locate the ones you want, and then Replace to make each indi-
vidual alteration.

Saving and Quitting

To save the function and terminate the edit, press Esc (EP) or select Exit from the File
menu. The new version of the function replaces the previous one (if any) and the edit
window is destroyed.

Alternatively, you can select Fix from the File menu. This fixes the new version of
the function in the workspace, but leaves the edit window open. Note that the his-
tory is also retained, so you can subsequently undo some changes and fix the func-
tion again.

To abandon the edit, press Shift+Esc (QT) or select Abort from the File menu. This
destroys the edit window but does not fix the function. The previous version (if any)
is unchanged.
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Editing Scripts and Text Files

The Editor may also be used to edit Dyalog script files (. dyalog files) and general
text files.

There are two ways to choose the file to be edited. If the file exists, you can select it
from the Open source file dialog by clicking File/Edit Text File from the Session
menu bar.

Alternatively, type ) ED followed by the pathname to the file. To identify the name
given as a file, it must either contain a slash character ("\" or "/") or be preceded by
one.

Examples
JED c:\Dyalogl5.0\myscript.dyalog
JED c:\Dyalogl5.0\pete.txt
JED /x.txt @A x.txt in current directory
Jed / x.txt a ditto
Jed / vy Ay in current directory

If the named file does not exist, you will be asked whether or not you want to create
it:

Dyalog APL/W-64

The specified file does not exist

Do you want to create it?

[] Do not ask this question again

If you edit a Dyalog script file, the editor will treat it as such and provide the same
formatting and syntax colouring as if it were a script in the workspace.

Otherwise, the file will be edited as if it were a character vector with embedded new-
lines.

When you exit the editor with Exit and fix, you will be offered a number of altern-
atives depending upon the type of file, as shown below.
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' —> Save as text in the workspace
: Create text variable in the workspace, and update the
file

—> Only save file to disk

This won't affect the contents of the workspace

—> Discard changes

L[] Savethis response for all files with a ".bt" extension Cancel

Saving a Text file.

Note that if you choose Save as text in the workspace, information about the file and
the text variable associated with it is retained in the workspace. This information
may be obtained using 5176I and 51771I. See Language Reference Guide: List
Loaded Files and List Loaded File Objects.
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c\miserveriywebcamiywebcam.dyalog

o Save file content

' —> Fix as code in the workspace
: Create objects in the workspace, and update the file

—> Save as text in the workspace
Create text variable in the workspace, and update the file

—> Only save file to disk

This wen't affect the contents of the workspace

— Discard changes

[] Save this response for all files with a ".dyalog" Cancel
extension

Saving a Script file.

Note that if you choose Fix as code in the workspace or Save as text in the
workspace, information about the file and the text variable associated with it is
retained in the workspace. This information may be obtained using 5176 and
51771. See Language Reference Guide: List Loaded Files and List Loaded File
Objects.
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Fix as code in the workspace

If you choose this option, the file will be updated and the script will also be fixed in
the workspace. Note that if the script refers to a base class or other external elements,
it cannot be fixed unless these elements are also present in the workspace.

Save as text in the workspace

If you choose this option, the file will be updated and the contents of the file will
also be saved to a variable in the workspace. First you will see the following waming
dialog, which may be disabled subsequently by checking Do not ask this question
again.

Saving as text will not update the file on subsequent
edits of the variable

[ Do not ask this question again Cancel

Then you will be prompted to supply its name, which may be a new name or the
name of an existing variable:

Save in Workspace

Mame of variable to save az

Only save file to disk

If you choose this option, the file will be updated but nothing will be changed in the
workspace.

Discard changes

If you choose this option, all changes will be discarded and nothing saved.
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The Tracer

The Tracer is a visual debugging aid that allows you to step through an application
line by line. During a Trace you can track the path taken through your code, display
variables in edit windows and watch them change, skip forwards and backwards in a
function. You can cutback the stack to a calling function and use the Session and
Editor to experiment with and correct your code. The Tracer may be invoked in sev-
eral ways as discussed below.

Tracing an expression

Firstly, you may explicitly trace a function (strictly an expression) by typing an
expression then pressing Ctrl+Enter (TC) or by selecting Trace from the Action
menu. This lets you step through the execution of an expression from the beginning.

In the same way as when you execute a statement by pressing Enter, the expression is
(if necessary) copied down to the input line and then executed. However, if the
expression includes a reference to an unlocked defined function or operator, exe-
cution halts at its first line and a Trace window containing the suspended function or
operator is displayed on the screen. The cursor is positioned to the left of the first line
which is highlighted.

Naked Trace

The second way to invoke the Tracer is when you have a suspended function in the
State Indicator and you press Ctrl+Enter (TC) on the empty input line. This is termed
naked trace. The same thing can be achieved by selecting Trace from the Action
menu on the Session Window.

The effect of naked trace is to open the Tracer and to position the cursor on the cur-
rently suspended line. It is exactly as if you had traced to that point from the Input
Line expression whose execution caused the suspension.

Automatic Trace

The third way to invoke the Tracer is to have the system do it automatically for you
whenever an error occurs. This is achieved by setting the Show trace stack on error
option in the Trace/Edit tab of the Configuration dialog (Trace_on_error para-
meter). When an error occurs, the system will automatically deploy the Tracer. Note
that this means that when an error occurs, the Trace window will then receive the
input focus and not the Session window.
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Tracer Options

From Version 10.1 onwards, the Tracer is designed to be docked in the Session win-
dow.

In previous versions of Dyalog APL, the Tracer was implemented as a stack of sep-
arate windows (one per function on the calling stack) or as a single, but still separate,
window.

You can disable the standard behaviour by selecting Classic Dyalog mode from the
Trace/Edit tab of the Configuration dialog box.

If you do so, you may then choose to have the Tracer operate in multiple windows or
in a single window.

These alternatives are discussed later in this Chapter.
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The Trace Window

The Tracer is implemented as a single dockable window that displays the function
that is currently being executed. There are two subsidiary information windows
which are also fully dockable. The first of these (SIStack) displays the current func-
tion calling stack; the second (Threads) displays a list of running threads.

In the default Session files, the Tracer is docked along the bottom edge of the Session
window. When you invoke the Tracer, it springs up as illustrated below. In this
example, the function being traced is [JSE . UCMD, which is invoked by typing a user-
command, in this case Jdisplay.

#n CLEARWS (OSE)- Dyalog APL/W-64

Tools  View

WS 9 o Ml % | Object [T gy @ 2 B[R | Tool £ 51 = @ | Edit 1 & 9 @ | Session 16/%

Language Bar X | X

= BT = O

[E-=[olgfel 2] [[L[ [F=ls<PRl MR (=[] [fel[l Lslelelefs] [F[+].[o[¢] [OOEE[]s[s] [o[a[-]u[slv]2] Eilg
Dyalog APL/W-6% Version 15.0.27293
Serial No : 000042
Unicode Edition
Beta release
Sun May 8 13:5%:45 2016
clear ws

ldisplay 113

~

v

Debugger

-0Ox
66.0O0c 00 B 1 P=|[searcn... ~|% % ® aa||Ost.uck «|| x [UCMD[ 1T~k User Command Processor.
o
[07 r~{THIS}UCMD Tnput:dcl;zinznmasrlbsurznetQ ~
[1] [ User Conmand Processor. The resplt may be assigned to a global varisble.
[2] A Most of the implementation is in LSE.SALTUtils.Spice; this function only® || :
[3] A "assignment syntsx®, i.e. Jvarname-ucmd and  J0-ucmd -
[%+] =
[5] rlb={{+/a\"' '=w)iw} ¢ =(pin=rlb Input)40 =
[6] T
(7] :If 0=0NC'THIS' o THIS+OIOORSI o :EndIf A record calling environment =
[8] =
ral &6 luarefmd arcantad: coa if it makes cance if nracan + N cnarac allauad hal |1 =
2 5
g 2% 2
Function Pos: 1/29,33 | o||w
Ready. . . Ins NUM
Cur0Obj: result (Undefined) B:1 ObQ:0 OTRAP [SI:if [OIO:1 [ML:1

In the default layout, the Sistack window is displayed alongside the main Tracer win-
dow, although this can be hidden or made to appear as a separate floating window, as
required.
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Trace Tools

The Tracer may be controlled from the keyboard, or by using the Trace Tools which
are arranged along the title bar of the Debugger window. Note that the button names
are solely for reference purposes in the description that follows.

Button

G

Ge

H

0 O

—
S

il

44

4 4

=

hd

Name

Exec

Trace

Back

Fwd

Continue

Restart

Restart all

Edit

Key

Code

ER

TC

BK

FD

BH

RM

ED

Keystroke

Enter

Ctrl+Enter

Ctrl+Shifi+Bksp

Ctrl+Shift+Enter

~{LC

Shift+Enter

Description

Execute expression

Trace expression

Go back one line

Skip current line

Stop on next line of calling
function

Continue execution of this
thread

Continue execution of all
threads

Edit name
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Key

Button Name Code Keystroke Description
Exit EP Esc Quit this function
o | X
" T Intr Ctrl+Pause Interrupt
# ﬂ Reset CB Clear trace/stop/monitor for
this object
EE (-] LN Toggle line numbers
* i) Search for next match
"'J:- i) Search for previous match
Search hidden text
Jb aA Match case

Using the Trace Tools, you can single-step through the function or operator by click-
ing the Exec and/or Trace buttons. If you click Exec the current line of the function
or operator is executed and the system halts at the next line. If you click Trace, the
current line is executed but any defined functions or operators referenced on that line
are themselves traced. After execution of the line the system again halts at the next
one. Using the keyboard, the same effect can be achieved by pressing Enter or
Ctrl+Enter.

The illustration below shows the state of execution having clicked Exec 16 times to
reach JSE.UCMD[17].
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Tools  View

WS % &g Ml % | Object (7 5 @ S B R | Tool P FTIZ @ Edit § 5 9D Q| Session 182

Language Bar x X
. — RS o
H R sEe 7] (L] H=s<-l=l] ([s[<[=[0fa]+] :[slelélels] ["[*¥]-[-[s] [DOBBI=|ss| [o]a[-lufe]v]& o
Dyalog APL/W-6% Version 15.0.27293 ~
Serial No : 0000%2
Unicode Edition
Beta release
Sun May 8 13:54:45 2016
clear ws
ldisplay 113
v
Debugger e - _ox
66QO0c 00 %O P = |erch... «| % % M an|Dse.uck «|| X [UCMD[17]sur=(dcL,ZdelsnotQsprma)ll
u}
[10] notQ='IO-"#nma=(~" ‘enma)/nma~(dvib<\{"~"=in)>v\ine' " """} /in ~
[11] del+"="etp[STACK A were we at Desk Calculatore
[12] :If notQal(i<pnma)>0 2 Ge“THIS.ONC ~“i4nma A is the assignment legal?
[13] ur='+ assignment syntax error' ¢ ur [ISIGNAL dcl42 ¢ O-ur ¢ ~
[14] 1EndIf
[15] ~(pin-(pnma)+in) 40 A Iv- is the seme as ]
[16]
[17] [[Gr=(dcl,=dcl<notl=pnma)ISE .SALTULI Ls.5pice in
[18] {0:+ @ s wlsignal 100"},  ° A reset DM =
[19] +If (0 2e<10|0DR ur)aleppur E
[20] tAndIf (2tur)=(0UCS 8),'=" R error signature i
[21] ur [OSIGNAL dcl49it o [=ltur o ~0 A signal error only if callek -
[22] :EndIf ©
[23] E
[24] ~(1=pnma)p0 R J-cmd discard result M
[25]: B :If Oconma o reur A no '+ return result by » ||y _
o o BEenmE O TRRL o e SRk 5
£
Function Pos: 17/29,0 9 e > ||
Ready... Ins NUM
CurObj: result (Undefined) &:1 OpQ:0 OTRAP [sI:1 0OI0:1 0OML:1

Execution Reached [JSE .UCMD[17]

The next illustration shows the result of clicking Trace at this point. This caused the
system to trace into JSE.SaltUtils.Spice, the function called from
OSE.UCMD[17].

Notice how each function call on the stack is represented by an item in the Sistack
window.
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Tools  View

WS % ol W %y | Object 7 G @ S BEIS Tool @ 5= B Edt @1 A D Q| Sesson [GE

Language Bar X | X
g m a
E [ [e[@lo] 7] [ITFIL[[] [ [{[+]<[=]0]a]¥] T-elles] [TT+].1<[¢] [OO@EB[E[<[s] [o[af-ulalv]e =
Dyalog APL/W-6% Version 15.0.27293 ~
Serizl No : 0000%2
Unicode Edition
Betz relesse
Sun May 8 13:5%:145 2016
clear ws
ldisplay 113
v
GO e _ox
6600008 1 P=|[searcn... v|% % @ an|[Dse.sAL v|| X [Spice[1]xa Called by the UCMD pro
a - = %,
[8] Fl=bflist[:clname cMinlen] R reduced L% A|[, UCHD[17] ur—(del, “delsnotlxpnma)l]
9] ~0t<exactvppos+Where b\rl[;1]ecn A find an ex>
[10] pos=Where b\({rL[;2]Tpn)t"rL[:1])e=n A try on alle
[11] SEndIf
[12] v
[0] v {R}~{rgn}Spice msgsarg:c;cmd;com;cs:details;DMXshelp:helpforsismon®
1] [_# Colled by the UCHD progrem. This program cen also be used directly
Trgn ASN)=2t{6::1 © rgn}0 A Is the result used (1) or simply dispF ||
4SN~-(modeBit 5)vlCauto<ASN @ Tn this version we disregard "Allow Sk ||
b=
A Put a stop before the call if requested -
cmd4¥-"2xstop==DEBUGK' -'="2tcmd-rtb msg =
+IF O<i=s/a\'?'=cmd={(']'=1tu)tu}rib cmd e
emd~cmd[1i]," ',rlb idcmd A ensure only one space .
:EndIf A accept 7cmd i _
0ol B aceep B o ] 5
> ) s
Function Pos: 164/1942,0 @ >
Ready... Ins NUM
CurObj: result (Undefined) 8:1 | ObQ:0  OTRAP  [OSI:2 D0I0:1 [OML:3

Execution Reached JSE . SALTUti ls.Spice [1]
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The illustration below shows the state of execution having traced deeper into the sys-
tem.

. CLEAR WS

File Edit View Windows Session Log Action Options Toels Threads Help
W5 T o Wl % | Object (§ &1 &/ 3[R i

AETErmgRET o s x
- - |
[+ [elBle]t 7] [TIL[rFl] [Flels[-Jz[=[¢] o
Dyalog APL/W-64% Version 15.0.27293
Serial No : 0000%2
Unicode Edition
Beta release
Sun May 8 13:54:45 2016
clear ws
ldisplay 113
)si
[OSE.SALT.Load[1]*
DS[.SALTUtiLs.SpicE[UIﬁ]
[SE.UCMD[17]
v
Deb S B B 0 e o =0Ox
66QO0c 00 % Qv P iE[sercn.. “]% % @ aa|[Ose.sAL || x [Load[1]s:Accass Shared Public
[i5] R ~1| 0| spicel146] R+8S,spc~0 ¢ [SE.SALT.
— 1 - = 3
[16] e TS e e @ aee] UCMD[17] ur+(dcl,*delenotQ=pnma)l
[17] cmd='"" class,'" -noname', (OFAVERSION)/' -version=',6AVERSION
[18] ref~#.0ONEW(Load emd),hasargs/cargs
[19] L v
[0] =] v {ref}-{ls}load fname;allpaths;cicname;ext;file;files;fix;fname;fol®
[11 [ :Access Shared Public
[2] R This function returns either a ref/name after defining the object in tw =
[31 R or a VTV if the source was reguested or several fns were defined or a » i
[4] 5] :If isHelp fname iz
[5] ref='Load [path]scriptfile' '' 'Load a class in the workspace' .
[6]1 ‘Modifiers:' T
[71 ref ~c'-target=Namespace Specifies target namespace for Lk || E
[81 ref,~='-disperse[=naml,nam2] Disperse elements in the target » -
Lol A ref,~<'—key= Key to use to decode file' vl _
<B ) i > % g
4
Function Pos: 163/1482,0 “ e >|| W
Ready... Ins NUM
CurObj: result (Undefined) &:1 OpQ:0 [QOTRAP [OsI:3 0OIo:1 [OML:2

Execution reached four levels deep

At this stage, the State Indicator is as follows:

)SI
[OSE.SALT.Load[1]x
OSE.SALTUtils.Spice[146]
(SE.UCMD[17]
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Controlling Execution

The point of execution may be moved by clicking the Back and Fwd buttons in the
Trace Tools window or, using the keyboard, by pressing Ctrl+Shift+Bksp and
Ctrl+Shift+Enter. Notice however that these buttons do not themselves change the
State Indicator or the display in the SIStack window. This happens only when you
restart execution from the new point.

You can cut back the stack by clicking the <EP> button in the Trace Tools window.
This causes execution to be suspended at the start of the line which was previously
traced. The same effect can be achieved using the keyboard by pressing Esc. It can
also be done by selecting Exit from the File menu on the Trace Window or by select-
ing Close from its system menu.

The <RM> button removes the Trace window and resumes execution. The same is
achieved by the expression ~[JLC.

The <BH> button continues execution until the current function has run to com-
pletion and control has returned to the calling function. It leaves the Trace window
displayed and allows you to watch execution progress.

Using the Session and the Editor

Whilst using the Tracer you can skip to the Session or to any Edit window and back
again. While it is docked, you may resize the Tracer pane by dragging its title bar,
and you may use the buttons provided to maximise, minimise and restore the Tracer
pane within the Session window.

Unless you move it, the cursor is positioned to the left of the suspended line in the
top Trace window.

Depending where the cursor is in the tracer window, pressing Shift+Enter (ED) or
selecting Edit from the File menu may cause an edit window to open. If the cursor is
in the first column of the Trace window, or on whitespace, the Editor is opened on
function or operator on top of the stack. If the cursor in on a name, the Editor is
opened on the name under the cursor (point-and-edit). With the cursor in any other
location, no action is undertaken.

When you finish editing, the window reverts to a trace window with the new defin-
ition of the function or operator displayed.

You may also open a new edit window from within the Tracer using point-and-edit.

You can copy text from a trace window to the session for editing and execution or
for experimentation.

It is possible to skip from the Tracer to the Session and then re-invoke the Tracer on a
different expression.
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Setting Break-Points

Break-points are defined by [JSTOP and may be toggled on and off in an Edit or
Trace window by clicking in the appropriate column. The example below illustrates
a function with a [JSTOP break-point set on line [5].

.+ Editor - [BUILD_SESSION]

bFiIe Edit Syntax Window Refactor View - 8 X
= ﬁﬁ[gHEearch... v % [H aa

[0] {FILE}BUILD_SESSION LANG;0BJ;MSG;0I0;[ML;OLD;NEW;FN;MB;SB1;5B2:TB;SB;5Bm A
[1] B Build the session object and save if desired

[2] :If O=0NC'NoPrompt' ¢ NoPrompt+0 ¢ :EndIf

[3] :If O=[ONC'FILE' ¢ FILE+'' ¢ :EndIf

[4]

[5] L OWX-0SE.OWX~1 & OML OIO~! ¢ [OPATH-'#.Trans'

[&] OPW+~122 A allows room for Status Bar

[7] LANG+upCase ,LANG A translation assumes uppercase

[8] UNICODE-20=[0DR"' '

[9]

[10] ("Unknown language, pick one of',sTrans.CODES)OSIGNAL(Trans.CODESe~cLAN®
[11]

[12] :Trap GUI+O

[13] '0SE'OWS 'Coord' 'ScaledPixel’

[1%] T GUI+1

[15] +EndTrap

[1&] ]
£ >
Function Pos: 0/183,1

[0STOP break-points set or cleared in an Edit window are not established until the
function is fixed. JSTOP break-points set or cleared in a Trace window are estab-
lished immediately.

Clearing All Break-Points

o X

You can clear all break-points by pressing the above button in the Trace Tools win-
dow. This in fact resets JSTOP for all functions in the workspace.
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The Classic mode Tracer

If you select Classic Dyalog mode from the Trace/Edit tab in the Configuration dia-
log box, the Tracer behaves in the same way as in Dyalog APL Version 8.2.
However, the Tracer is not dockable in the Session.

Ifyou select the Classic mode Tracer, you may choose between multiple trace win-
dows or a single trace window using the Single Trace Window option.

Multiple Trace Windows

The following behaviour is obtained by deselecting the Single Trace Window
option.

Each function on the SI stack is represented by a separate trace window.
The top window contains the function that is currently executing, other win-
dows display functions further up the stack, in the order in which they were
called.

When you press Ctrl+Enter or click the Trace button on a line that calls
another function, a new trace window appears on top of the stack and dis-
plays the newly called function.

When a function exits, its trace window disappears and the focus moves to
the previous trace window. When the last function in a traced suspension
exits, the last trace window disappears.

If you click the Quit this function button in the Trace Tools window, or
press Escape, or close the trace window by clicking on its [X] button or typ-
ing Alt-F4, the top trace window disappears and the focus moves to the pre-
vious trace window

If you close any of the trace windows further down the stack, the stack will
be cut back to the corresponding point, i.e. to the line of code that called
the function whose trace window you closed.

The <RM> button removes all the trace windows and resumes execution.
The same is achieved by the expression »{JLC. The <CS> button also con-
tinues execution, but leaves the trace windows displayed and allows you to
watch their progress.

If you minimise any of the trace windows, the entire stack is minimised to a
single icon, from which it may be restored.
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Single Trace Window
The following behaviour is obtained by selecting the Single Trace Window option.

o The trace window contains a combo box whose drop-down displays the con-
tents of the SI stack. This box is not provided if there are multiple trace win-
dows.

o The trace window is re-used when tracing into, or returning from, a called
function. This means that there is never more than one trace window
present.

« When the last function in a traced suspension exits, the trace window dis-
appears.

o Ifyou click the Quit this function button in the Trace Tools window, or
press Escape, the current function is removed from the stack and the trace
window reused to display the calling function if there is one.

« Closing the trace window by clicking on its [X] button or typing Alt-F4
removes the window and clears the current suspension. It is equivalent to
typing naked branch (=) in the session window.

« If you move or resize the trace window, APL remembers its position, so that
it reappears in the same position when next used.
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The Threads Tool

The Threads Tool is used to monitor and debug multi-threaded applications. To dis-
play the Threads Tool, select Show Threads Tool from the Session Threads menu, or
Threads from the Session pop-up menu.

. Threads

Tid Location State Flags Treg
Tid:0 {(Run) *RUN[63] OTGET ... Session MNormal

Tid:1 (GUI) SHOW[22] ODQ'F' doo Paused

Tid:2 (Lift 1} GOTO[10] OOL o0.2 0ODL Paused

Tid:=3 (Lift 2} GOTO[10] ODL 0.2 oL Paused

Tid:i% (Lady 14%) PERSON[7] OTGE... OTGE... Paused 31
Tid:20 (Lady 20) PERSON[7] OTGE... OTGE... Paused L2
Tid:21 (Man 21} PERSON[7] OTGE... QOTGE... Paused 22
:Tid:23 (Man 23) PERSON[&] Lift... [OTGE... Paused 2

< >

“Ox

Token Pool

1001.5

The above picture illustrates a situation using the 11 ft . dws workspace after execut-
ing the function RUN. The Pause on Error option was enabled and a Stop was set on
RUN[63]. When RUN suspended at this point, all other threads (1-8) were auto-
matically Paused. Note that all other threads happen to be Paused in the middle of
calls to system functions

The columns of the Threads Tool display the following information.

Column

Description

Tid

The Thread ID (OTID) and name (OTNAME) if set

Location

The currently executing line of function code

State

Indicates what the thread is doing. (see below)

Flags

Normal or Paused.

Treq

The Thread Requirements (OTREQ)
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Thread States
State Description
Pending Not yet running
Initializing Not yet running

Defined function

Between lines of a defined function

Dfn Between lines of a dfn
Indicates that the thread is suspended and is able to
Suspended . . .
accept input from the Session window.
. Indicates that Session window is connected to this
Session
thread.
Indicates that the thread has no SI stack and the Session
(no stack) is connected to another thread. This state can only occur
for Thread 0.
Exiting About to be terminated
tHold Waiting fora :Hold token
:EndHold Waiting fora :Hold token
doL Executing (DL
H[p]e} Executing (JDQ
ONA Waiting for a DLL ([NA) call to return.
OTGET Executing OTGET, waiting for a token
OTGET

(Ready to continue)

Executing JTGET, having got a token

OTSYNC

Waiting for another thread to terminate

Awaiting request

Indicates a thread that is associated with a NET system
thread, but is currently unused

Called NET

Waiting for a call to .NET to return.
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Paused/Normal

In addition to the thread state as described above, a thread may be Paused or Normal
as shown in the Flags column. A Paused thread is one that has temporarily been
removed from the list of threads that are being scheduled by the thread scheduler. A
Paused thread is effectively frozen.

Threads Tool Pop-Up Menu

Switch to
Interrupt

Ignaore Interrupts

Refresh Mow
Auto Refresh

" Pause Threads on Error

+ Paused
Pause 4ll

Resume All

Restart All
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Selecting this item causes APL to attempt to suspend (if

Switch to necessary) and switch to the selected thread, connecting
it to the Session and Debugger windows.
Causes a (STRONG) interrupt in the selected thread the
Interrupt next time it is scheduled, essentially it allows you to

target an interrupt at a specific thread.

Ignore Interrupts

Allows you to specify that the selected thread should
ignore weak interrupts.

Refresh Now

Refreshes the Threads Tool display to show the current
position and state of each thread.

Auto Refresh

Selecting this item causes the Threads Tool to be
updated continuously, so that it shows the latest
position and state of each thread.

Pause Threads on
Error

If this item is checked, APL automatically Pauses all
other threads when a thread suspends due to an error or
an interrupt.

This item toggles a thread between being Paused and

Paused Normal. It Pauses a Normal thread and resumes a
Paused thread.

Pause All This item causes all threads to be Paused.

Resume All This item resumes all threads.

Restart All This item resumes all Paused threads, restarts all

suspended threads, and closes the Debugger.
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Debugging Threads

The Debugger provides a tabbed interface that allows you to easily switch between
suspended threads for debugging purposes. To keep things simple for non-threaded
applications, Tabs are only displayed if there is a thread suspended that is other than
Thread 0. The following picture shows the Debugger open on a multi-threaded
application (LIFT.DWS) when only Thread 0 is suspended. This has been achieved
by setting a stop on RUN[63]

/A C\Program Files\Dyalog\Dyalog APL-64 13.0 Unicode\ws\lift.dws - Dyalog APL/W-64

File Edit View Windows Session Log Action tions  Tools Threads Help

WS % ) gl Wl Oy | Object (7 41 @ Fi[R | Teol P 5T IZ B Edt @ @ P Q| Session 182

Language Bar X | X

=T= EEEENE me | O
(] ELlelofglo 2] L[] [f=[<[<-[ol=le] [t]+[=[=[0fa[¥] [s[e]u[-] Tl [EFLF] DOREE: R Hg
Unicode Edition ~
Beta release
Sun May B8 16:16:21 2016
clear ws
C:\Progrem Files\Dyalog\Dyalog APL-6% 15.0 Unicode\ws\lift.dws saved Thu Apr 28 17:23:52 2016
Lift simulation designed to illustrate multi-threading
lend thread synchronisation, using the Token Pool.
To run it:

RUN 20 & Simulate 20 arrivals

RUN 20 a Simulate 20 arrivals

RUN[631
v
Debugger _Ox
6600000 1 P §EHEearch... v|% % @ aa|[RUN[63] || x [RUN[63]-OTGET 2pJobDone A Wa
[n}
[56] OTGET GUIReady ~
[57] F.LIFTY F.LIFT2 LIFTR =FLOORS CAPACITY m Start Lift threads
[581 :For I :In 1N A Start <N> people threads
[59] PERSON&FLOORS -
[60] ObL 0.2x710 A Simulate random(ish) arrival =
[61] iEndFor =
[62] OTPUT Al LDone A Tell Lifts "that’s it" s
[¢3] ® [OTGET ZplobDone A Wait until Lifts have finished delivering men =
[64] OTKILL OTNUMS A Zap any threads =
vl .
g 5
< > @ ]
Function Pos: 63/65,0 | NI
Ready. .. Ins NUM

CurObj: RUN (Functien) &:8 OpbQ:0 OTRAP [SI:1 [IO:1 [OML:0
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In the next picture, the user has chosen to display the Threads Tool and then dock it
between the Session and Debugger windows. Note that only one thread, thread 0
(Run)is suspended. All the other threads are Paused (because Pause on Error is
enabled).

& CA\Program

File Edit View Windows Session Log Action Options Tools Threads Help
WS 5 & W % | Object (7 £ &= L [Tool P T i= ¥ it @

9D Q¢ Session APL385 Unicode |  18[2

T Sormm e S S e e e x X
: - R ToE ]
[ F-efe ool ]2] [PLLlll] [=ls[<PPl=le] t3[<[fa]y] [fe]v[o[e[ LLelelels] [TEF].Jo[3] [OOEE[:]s] o[l o
~
RUN 20 m Simulate 20 arrivals
RUN[63]
v
Threads T — e ———— “Ox
Tid Location Stete Flags  Treg
Tid:0 (Run) *RUN[63] OTGET 2pJobDone @ Wait until Lifts have... Session Normal
Tid:1 (GUI} SHOW[22] ODQ'F' Ooa Paused
Tids2 (Lift 1) GoTO[10] ODL 0.2 ooL Paused
Tids3 (Lift 2) GoTO[10] ODL 0.2 oo Paused
Tid:14 (Lady 14) PERSON[7] OTGET Lift REACHED MYFLOOR @ Wait for Lli... [OTGET (Ready to cont... Paused 31
Tid:20 (Lady 20) PERSON[7] OTGET Lift REACHED MYFLOOR @ Wait for Lli... OTGET (Ready to cont... Paused 42
Tid:21 (Men 21)  PERSON[7] OTGET Lift REACHED MYFLOOR @ Wait for Li... [OTGET (Resdy to cont... Paused 22
iTid:23 (Man 23) PERSON[%] Lift-{JTGET GoingUp A Wait for Lli... [DOTGET (Ready to cont... Paused 2
Deb S B B 0 e o =0Ox
66COCO0 %O n P i=|[seeren... v| % % @ aa|/RUN[63]+ | X [RUN[63T+OTGET 2pJcbDone n W2
u}
[56] OTGET GUIReady ~lls
[57] F.LIFTY F.LIFT2 LIFT&"=FLOORS CAPACITY A Start Lift threads
[58] :For T :In N A Start <N> peeople threads N
[59] PERSON&FLOORS o
[60] ODL 0.2x2740 A Simulate random(ish) arrival =
[61] :EndFor E
[62] OTPUT AllDone A Tell Lifts "that’s it" -
[63] [[OTGET 2pJobDone A Wait until Lifts have finished delivering men vl g =
< - - > || @ 2
& 5
Function Pos: 63/65,0 w | > ||
Ready... Ins | NUM

CurObj: RUN (Function) &:3 0pQ:0 [OTRAP [D5I:4 0OIO:1 [OML:0
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The user then uses the context menu to Switch To Thread 6 (whose name is Lady 6)
which was Paused on PERSON[ 7] in the middle of a[JTGET. The act of switching
to this thread caused it to be suspended at the beginning of its current line PERSON
[7] and the Debugger now displays two Tabs to represent the two suspended
threads. Note that both the thread id and the thread name are displayed on the Tabs.

£ c:\Program Files\Dyalog\Dyalog APL 12.1 Unicodews\lift - Dyalog APLAY M=
Ble Edt View Windows Sesson Log Action Options Tols Threads Help
ws O 08 B & G obier: BB Bg v @ T QG W e By W3 O Sesson (B | APL3BGUnicode | [ TE[S
Language Bar Zle1x| ﬁ
[fRleBR ] (L] [F=FEER ABER[EH (=]l [Fleltl=le) [FELL] DR FlaREE [ &)
MYFLOOR K
m
v
Threads =lsl=]
Tid Lacation State Flags | Treq
u: Run  +RUN[631 OTGET 2gJobbons W Wai... Tuspended Paused
10 BUI SHOWI 221 ODY'F' oo Paused
2: Lift 1 BOTO[10] OOL 0.2 ooL Paused
3: Lift 2 BoTol1o] OOL 0.2 ool Paused
5: Man 9 FPERSOM[?] OTBET Lift REACHED MYFLO... QOTBET (Ready to continue) Faused LI
6: lady & *PERSOM[?] OTEET Lift REACHED MYFLO... Session Normal
7t Man 7 PERSOM[W] Lift<OTGET GoingUp ... OTGET (Ready to continue) FPaused 2
8: Lady 8 PERSON[4] Lift<OTGET Goinglp ... OTEET (Ready to continue) Paused 2
Debugger =lol=l
i Run| 6t Lady 6 ﬂ PERSONLTI+OTGET Lift REACHED MYFL
o
STUMDP P PEXNHH ~| B 80 | PERSONL7]+0TGE v | | 2
3] ARRIVE M Arrive at 11ft shaft &
[u] Lift<OTGET Goinglp Wit for 1iFt door to be apsn/fres =
[5] Lift GETIN MYFLOOR«?FLOORS A Get into the Lift, tell the 1ift where I’ » E
[5] MYFLOOR OTPUT Lift.ID+Manln @ Clasr the Lift door for nsxt person =
[?1 OTGET Lift REACHED MYFLOOR A Wait for 1ift to reach my floor =
[s] Lift GETOUT MYFLOOR W De-Lift g
[3] OTPUT Lift. ID+*Man0ut m Tell Lift 1°'m out, thread ends Sl =
< > £ E]
Function Last saved by: Dyalog: 02 July 2004 13:28 Pas: 7/10,0 @ ¢ 5 i
Ready. .. Tns  HUM
CurObj: MYFLOOR (Yariablel &:8 gog:0  OTRAP  [QSI:2  QpIo:1l oMLz o

Note also that the Session window is connected to the thread indicated by the selec-
ted Tab. In this case, typing MYF LOOR into the Session window displays the value of
the local variable MYFLOOR in Thread 6 (Lady 6).
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You can use the Tabs to switch between the suspended threads, so clicking the Tab
labelled 0 : Run causes the display to change to the picture shown below. The Ses-
sion is now connected to Thread 0 (Run), so the value of [JLC is 63.

B C:Program Fi log APL 12.1 Unicodewslift - Dyalog APL/W (=]
Fle Edt Wew Windows Session Log Action Options Tools Thesads telp
s D EME Y o BB RV b = @ Too Q G) O Ed [B ) Cu - Session (B |APL38GUnicode v |[ 16[2]
Language Bar el x| :
FEDEEERE [l FREEREER R0 [eof[=]] [Telelele) CEELLe] o[l FlREblleR] [f] & 2
oLe ~
63
)
Threads P =T}
Tid Location State Flags | Treg
0: Run +RUN[63] OTGET ZpTobbane A Wai... Session Harmal
1t GUI SHOW[22] ODQ'F* ope Paused
2: Lift 1 GOTO[10] ODL 0.2 opL Paused
3: Lift 2 GOTO[10] ODL 0.2 opL Paused
S: Man 5 PERSON[7] OTGET Lift REACHED MYFLO... OTGET (Ready to continue) Faused b1
6: Lady 6 *PERSON[7] OTGET Lift REACHED MYFLO... Suspended Hormal
7i Man 7 PERSON[L] Lift+OTGET Goinglp OTGET (Ready to continue) Faused 2
8: Lady 8 PERSON[L] Lift+OTGET Goinglp ... OTGET (Ready to continue) Faused 2
Debugger =lolx
05 Run | g: Lady 6 ﬂ RUNL631+OTGET ZpJobbane n Ha
- - |
STUW D P PZEXNHE ~| 08 & |[Runles1-OTeeT [+ |
[56]} OTEET GUIReady ~
5711 F.LIFTL F.LIFTZ LIFT&"=FLOORS CAPACITY m Start Lift threads =
[58]} iFor [ iln N A Start <M= people threads =
1591 i PERSON&FLOORS e
[60]] OoL 0.2x710 # Simulate randomish) arrival =
6111 tEndFor =
[62] ! OTPUT AllDone A Tell Lifts "that’s it" v =
= S £
= 2
Function Last saved by: Dyalog: 03 July 2004 08:36 Pas: 63/65,0 o (¢ 5 i
i Ready... Ins | NUM
{ CurObj: MYFLOOR (Yarisble) a8 ODQ:0  OTRAP  OSI:l  [OL0:1 [ML:O
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The Event Viewer

The Event Viewer can be used to monitor events on Dyalog APL GUI objects. To dis-
play the Event Viewer, select Event Viewer from the Session Tools menu.

You can choose:

« which types of events you want to monitor
« which objects you want to monitor

Spy Columns Select Options

ObjectName  Object... ~ EventName Evert... Paameters Agtion ThreadlD  NGed  EventlD Timestamp ™
#.F Form GotFocus 40 0 0 0 317 2016 5 8 16 44 31 947
#.F Form Mouselp 2 26.1437912 32.426303... 0 Q Q 318 2016 5 8 16 44 32 32
#.F Form Mouselp 2 32.35293961 35.82766... O 0 0 319 2016 5 8 16 44 35 17
#.F Form MouseDblClick & 32.35293961 35.82766... 0 Q Q 320 2016 5 8 16 44 35 106
#.F Form Mouselp 2 32.35293961 35.82766... O 0 0 321 2016 5 8 16 44 35 196
#.F Form Configure 31 61.94444275 71.510%1... #.F00 Q Q 322 2016 5 8 16 44 36 922
#.F Form Configure 3 61.98454275 71.45833... #.F00 0 0 324 2016 5 8 16 44 36 973
#.F Form Configure 31 61.94444275 71.40625... #.F00 Q Q 326 2016 5 8 16 44 36 994
#.F Form Configure 3 61.8518524%2 71.35416... #.FO0 0 0 328 2016 5 8 16 44 37 14
#.F Form Configure 31 61.75925827 71.30208... #.F00 Q Q 330 2016 5 8 16 44 37 35
#.F Form Configure 3 61.75925827 71.25 28... #.FOO 0 0 332 2016 5 8 16 44 37 85
#.F Form Configure 31 61.6666679% 71.19791... #.F00 ] ] 334 2016 5 8 16 44 37 96
#.F Form Configure 31 61.57407379 71.14583... #.F00 ] ] 336 2016 5 8 16 44 37 107
#.F Form Configure 31 61.48147964 71.14583... #.F00 ] ] 338 2016 5 8 16 44 37 117
#.F Form Configure 31 61.48147964 71.09375... #.FO0 ] ] 340 2016 5 8 16 44 37 138
#_F Farm Canfinure a1 A1.5R1LTOAL 71.00375. .. # FOO i} i} aug 7016 5 A 1A bk 37 375 ¥

In the example illustrated above, the user has chosen to monitor events on a Form
# . F. Furthermore, the user has chosen to monitor GotFocus, LostFocus, MouseUp,
MouseDblClick and Configure events. Notice that there is a callback #. FOO
attached to the Configure event.
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The Spy Menu
Clear
Copy
& Al

When Placed in Object's Queue

Current Queue State

~*  Enable Logging

Close

The Spy menu, illustrated above, provides the following options and actions.

Item

Description

Clear

Clears all of the event information that is currently
displayed in the Event Viewer.

Copy

Copies the highlighted rows to the clipboard.

All

In this mode all the events are displayed in the Event
Viewer as they occur, whether or not there is an action
associated with them.

When Placed in
Object's Queue

In this mode only events that have associated actions
are displayed in the event viewer. Note that KeyPress
events are always queued and therefore always appear,
even if there is no associated action.

Current Queue State

In this mode the Event Viewer displays a snapshot of
the internal event queue. Only those events that are
currently in the intemal APL event queue waiting to
be processed are displayed.

Enable Logging

This item switches event logging on and off.

Close

Closes the Event Viewer
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The Columns Menu

ObjectMame
ObjectType
EventMame
EventMumber
Parameters
Action
ThreadID
MCed

EventlD

L U A U T U T L

Tirnestamp

The Columns menu allows you to choose which information is displayed for the

events you are monitoring.

Item Description
. If check his i ispl h fth j
ObjectName c ec' ed, this item displays the name of the object
on which the event occurred.
ObjectType If checked, this item displays the #ype of the object on
which the event occurred.
Event Name If checked, this item displays the name of the event

that occurred.

Event Number

If checked, this item displays the event number of the
event that occurred.

Parameters

If checked, this item displays the parameters for the
event that occurred. These are the items that would be
passed in the argument to a callback function.

Action

If checked, this item displays the action associated
with the event, for example the name of a callback
function, or an expression to be executed.

Thread ID

If checked, this item displays the thread id of the
thread in which the event occurred

NQed

If checked, this item displays 0 or 1 according to
whether or not the event occurred naturally or was
generated programmatically by [JNQ.
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Item Description
Event ID If checked, this 1t.err.1 d}splays Fhe event id of the event
that occurred. This id is used internally.
TimeStamp If checked, this item displays the time stamp of the
event that occurred.
The Select Menu
Select All

Select Matching Events
Select All Events on this Object
Select All Events of this Type
The Select menu allows you to highlight certain events in the Event Viewer. For

example, if you are monitoring TCP/IP events on a number of TCPSockets, you can
highlight just the events for a particular socket.

Item Description

Select All Highlights all the events.

Highlights all the events that have the same Object
and Event Name (or Event Number) as the currently
selected event.

Select Matching
Events

Select All Events on | Highlights all the events that have the same Object as
This Object the currently selected event.

Highlights all the events that have the same Event
Name (or Event Number) as the currently selected
event

Select All Events of
this Type

These items are also available from the pop-up menu that appears when you press the
right mouse button over an event displayed in the Event Viewer window.
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The Options Menu

Always on Top
" lUse APL Font

Settings...

The Options menu allows you to choose which information is displayed for the
events you are monitoring.

Item Description

If checked, this item causes the Event Viewer window
Always on Top to be displayed above all other windows (including
other application windows).

If checked, this item causes the information displayed
in the Event Viewer window to be displayed using the
Use APL font APL font (the same font as is used in the Session
window). If not, the system uses the appropriate
Windows font.

Settings... Displays the Event Viewer Options Dialog Box.
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Options Dialog Box

The Event Viewer Options dialog box allows you to select the objects and events

that you wish to monitor.

Event Viewer Options

Options
Everits to view:

[]User defined events

Marme D (
MouzeDown 1

Mouzellp 2

[ tMouseMove 3

[ tMouseClick 4

MouseDbIClick 5

[ MouseEnter 5

[ Mouseleave 7

[ Mouseiwheel 8

[ DragOver 10

[] DraaDrop 1

[ DiagStart 12

[ Diaglistove 15

[ DiaglistCopy 16

1 K el har 19 h

Ireeert Check Selected Check Al Clear Al

E event[z] of 300 selected

Ohjects ta view:

Fird Taol: @

Mame:

Select From List..

Type:
ThreadID:

Handle:

[ Parent Object
[ Child Objects
[15ame Thread
&0 Objects

[ Obiects of Type Select From List...

Cacsl
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Events to view

The list box shows all the events that are support by the Dyalog APL GUI and

allows you to select which events are to be monitored. User defined events may be
selected by checking the User defined events box. Only those events that are selec-
ted will be reported. You can sort the events by name or by event number by clicking
the appropriate column header.

Objects to view

Item

Description

Find Tool
Select from List

This tool allows you to choose a single specific
Dyalog APL GUI object that you want to monitor. To
use it, drag the Find Tool and move it over your
Dyalog APL GUI objects. As you drag it, the
individual objects are highlighted and their details
displayed in the Name, Type, Thread ID and Handle
fields. Drop the Find Tool on the object of your
choice.

Clicking the Select from List button brings up a
dialog box that displays the entire Dyalog APL GUI
structure as a tree view. You can choose a single
object by selecting it.

Parent Object

Enables event reporting on the selected object's
immediate parent.

Child Objects

Enables event reporting on the all selected object's
descendants (at any level).

Same Thread

Enables event reporting on all the objects in the same
thread as the selected object.

All Objects

Enables event reporting on all Dyalog APL GUI
objects.

Objects of Type
Select from List

Activates the adjoining Select button and disables all
other Object selection mechanisms.

Clicking the Select from List button brings up a
dialog box that allows you to choose which types of
Dyalog APL GUI objects you want to monitor.




180 Ul Guide

The Session Object

Purpose: The Session object [JSE is a special system object that represents
the session window and acts as a parent for the session menus, tool
bar(s) and status bar.

Children Form, MenuBar, Menu, MsgBox, Font, FileBox, Printer, Bitmap,
Icon, Cursor, Clipboard, Locator, Timer, Metafile, ToolBar,
StatusBar, TipField, TabBar, ImageList, PropertySheet, OLEClient,
TCPSocket, CoolBar, ToolControl, BrowseBox

Properties  Type, Caption, Posn, Size, File, Coord, State, Event, FontObyj,
YRange, XRange, Data, TextSize, Handle, HintObj, TipObj,
CurObj, CurPos, CurSpace, Log, Input, Popup, RadiusMode,
MethodList, ChildList, EventList, PropList

Methods ChooseFont, FileRead, FileWrite

Events Close, Create, FontOK, FontCancel, WorkspaceLoaded,
SessionPrint

Description

There is one (and only one) object of type Session and it is called JSE. You may use
OWG,OWS and OWN to perform operations on [JSE, but you cannot expunge it with
0EX nor can you recreate it using JWC. You may however expunge all its children.
This will result in a bare session with no menu bar, tool bar or status bar.

[SE is loaded from a session file when APL starts. The name of the session file is spe-
cified by the session_file parameter. If no session file is defined, JSE will have no
children and the session will be devoid of menu bar, tool bar and status bar com-
ponents.

You may use all of the standard GUI system functions to build or configure the com-
ponents of the Session to your own requirements. Y ou may also control the Session
by changing certain of its properties.

Note that the Session reports a Create event when APL is first started, and a Work-
spaceLoaded event when a workspace is loaded or on a clear ws.

The Session also reports a SessionPrint event when certain types of output are about
to be displayed. This may be used to alter the normal default display.
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Read-Only Properties
The following properties of JSE are read-only and may not be set using [JWS:
Type A character vector containing 'Session'
. A character vector containing the current caption in the title bar
Caption . .
of the Session window.
TextSize Reports the bounding rectangle for a text string. For a full

description, see TextSize in Object Reference.

A character vector containing the name of the current object.
CurObj This is the name under or immediately to the left of the input
Ccursor.

A 2-element integer vector containing the position of the input
cursor (row and column number) in the session log. This is JI0
CurPos dependent. If JIO is 1, and the cursor is positioned on the
character at the beginning of the first (top) line in the log,
CurPos is (1 1). IFQIO0 is 0, its value would be (0 0).

A character vector which identifies the namespace from which
the current expression was executed. If the system is not

CurSpace executing code, CurSpace is the current space and is equivalent
to the result of ' '[INS "' *.
Handle The window handle of the Session window.

A vector of character vectors containing the most recent set of
Log lines (input statements and results) that are recorded in the
session log. The first element contains the top line in the log.

A vector of character vectors containing the most recent set of
Input input statements (lines that you have executed) contained in the
input history buffer.

A vector of character vectors containing the types of object that

ChildList .
can be created as a child of [JSE.
MethodList A vector of chfaracter Yectors containing the names of the
methods associated with (JSE.
. A vector of character vectors containing the names of the events
EventList
generated by [JSE
. A vector of character vectors containing the names of the
PropList

properties associated with [JSE.
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Read/Write Properties

The following properties of [JSE may be changed using OWS:

Coord

Specifies the co-ordinate system for the session window.

Data

May be used to associate arbitrary data with the session object
OSE.

Event

You may use this property to attach an expression or callback
function to the Create event or to user-defined events. A callback
attached to the Create event can be used to initialise the Session
when APL starts.

File

The full pathname of the session file that is associated with the
current session. This is the file name used when you save or load
the session by invoking the FileRead or FileWrite method.

FontObj

Specifies the APL font. In general, the FontObj property may
specify a font in terms of its face name, size, and so forth or it may
specify the name of a Font object. For applications, the latter
method is recommended as it will result in better management of
font resources. However, in the case of the Session object, it is
recommended that the former method be used.

HintObj

Specifies the name of the object in which hints are displayed.
Unless you specify HintObj individually for session components,
this object will be used to display the hints associated with all of
the menu items, buttons, and so forth in the session. The object
named by this property is also used to display the message
“Ready...” when APL is waiting for input.

Popup

A character vector that specifies the name of a popup menu to be
displayed when you click the right mouse button in a Session
window.

Posn

A 2-element numeric vector containing the position of the top-left
corner of the session window relative to the top-left comner of the
screen. This is reported and set in units specified by the Coord

property.

Size

A 2-element numeric vector containing the height and width of the
session window expressed in units specified by the Coord property.
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State

An integer that specifies the window state (O=normal,
I=minimised, 2=maximised). You may wish to use this property to
minimise and later restore the session under program control. If you
save your session with State set to 2, your APL session will start
off maximised.

TipObj

Specifies the name of the object in which tips are displayed. Unless
you specify TipObj individually for session components, this
object will be used to display the tips associated with all of the
menu items, buttons, and so forth in the session.

XRange

See Object Reference

YRange

See Object Reference

Special Events

In addition to the events and methods which are provided by JSE in common with
other GUI objects, the following events are unique to JSE.

This event is reported when a value is about to be
displayed in the Session window. The default display of

SessionPrint the value may be intercepted by a callback function and

displayed differently. This event is used by the Jbox
and ]Jrows user commands.

WorkspaceLoaded

This event is generated when a workspace is loaded or
upon )CLEAR.

Special Properties

In addition to the properties which are provided by [0SE in common with other
GUI objects, the following properties are unique to JSE.

StatusWindow

This read-only property returns a reference to the Status
Window. The expression:
(OSE.OWG'StatusWindow').Text retums the (read-
only) contents of the status window.

Editor

This read-only property retumns a reference to the Editor
Window. It is used by SALT and may be changed in future
versions of Dyalog.
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SessionPrint Event 526

Applies To: Session

Description

Ifenabled, this event is reported when a value is about to be displayed in the Session.
It is generated by the display of a variable or the result of a function including system
variables and functions. Error messages and output from system commands do not
generate this event.

The event message reported as the result of IDQ, or supplied as the right argument to
your callback function, is a 2-element vector as follows :

[1] |Object ref or character vector

[2] |Event 'SessionPrint' or 526

The attachment of a callback function intercepts and annuls the normal display of
any value.

Note that this event may be extended in future; in particular the number of elements
in the event message may be increased, and the event may be generated by some sys-
tem commands. You should therefore allow for such extensions in any code which
refers to SessionPrint.

When the event is generated, the left argument of the callback function contains the
value which was about to be displayed. The callback function may display this or
any other value, using default output or by assignment to [. If so, this output will be
processed normally, without generating a subsequent SessionPrint event. If the call-
back fails to explicitly display anything, nothing will appear in the Session.

Example

OVR'OSE.TimeStamp'
V VAL TimeStamp EV
[1] TS VAL

v
'OSE'OWS'Event' 'SessionPrint' '[SE.TimeStamp'
2
2014 9 18 16 20 38 318 2
OA

2014 9 18 16 20 44 668 ABCDEFGHIJKLMNOPQRSTUVWXYZ
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The result (if any) of the callback function is ignored.

You may not disable the event (by setting its action to ~ 1), nor generate the event
using [NQ, nor call it as a method.

WorkspaceLoaded Event 525

Applies To: Session

Description

Ifenabled, this event is reported when a workspace is loaded orona clear ws.
You may not nullify or modify the event with a O-returning callback, nor may you
generate the event using [INQ, or call it as a method.

The event message reported as the result of [IDQ, or supplied as the right argument to
your callback function, is a 2-element vector as follows :

[1] [Object ref or character vector

[2] |Event ‘WorkspacelLoaded' or 525

This event is fired immediately after a workspace has been loaded and before the exe-
cution of JL X.

The callback function you attach should be defined in [JSE.
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Configuring the Session

As supplied, your default session will have a menu bar, a tool bar and a status bar.
There are many ways in which you may configure this set-up, including the fol-
lowing:

You may select a different APL font or character size.

Y ou may alter the appearance of the menus by changing the Caption properties of
the various Menu and Menultem objects. For example, you may prefer the menus to
appear in your own language.

Y ou may alter the structure of the menus. For example, you may wish to create a
Search menu directly on the menu bar rather than having Find and Replace as part of
the Edit menu.

You may add new Menu and Menultem objects to the menu bar, or new Button
objects to the tool bar, that execute APL functions or expressions for you. You can
store the code inside the [JSE namespace so that it is remains available when you
switch from one workspace to another.

You may add other objects to the tool bar to allow you to provide input for your func-
tions or to display output. For example, you may display a Combo object that offers
you a selection of names applicable to a particular task.

Y ou may add additional toolbars.

Y ou may remove objects too; for example, you can remove fields from the StatusBar
or even delete it entirely. Indeed, you may dispense with the menu bar and/or tool
bar as well.

This section illustrates how you can configure your session using worked examples.
The examples are by no means exhaustive, but are designed to demonstrate the prin-
ciples. Please note that the structure and names of the objects used in these examples
may not be identical to your default session as supplied. Before you attempt to
change your session, please check the structure and the object names using JWN and
[OWG. The supplied session was created using the function BUILD SESSION in the
workspace BUILDSE. If you wish to make substantial changes to your session, you
may find it most convenient to edit the functions in this workspace, re-run BUILD
SESSION, and then save it.

Please note that these examples assume that Expose Session Properties is enabled.



Chapter 1: The APL Environment 187

Changing the Font

The APL session font is defined by the Font property of JSE. To change the font per-
manently, you should select a different Font and/or size of Font using the combo and
spinner boxes on the Session toolbar, and save your Session.

Classic Edition is distributed with bitmap fonts suitable for use on your screen, and
TrueType fonts for your printer. You can use the TrueType font on the screen, but it
is less attractive than the bitmap fonts at low resolutions. The bitmap fonts come in
two sizes (16 x 8 and 22 x 11) and two weights (normal and bold). You may select
other sizes, so long as the height is a multiple of 16 or 22. The scaling is performed
automatically by Windows.

Changing Menu Appearance

The name of the Session MenuBar is TISE . mb'. To simplify the specification of
object names, we will first change space to the MenuBar itself:

)CS [OSE.mb
0SE.mb

The names of the Menu objects owned by the MenuBar are given by the expression:

‘Menu' [OWN "'
file edit view windows session Llog action options
tools threads help

The current caption on the file menu is:

file.Caption
&File

To change the Caption to Workspace:
file.Caption«'Workspace'
To change the colour of the New option in the File menu to red:

file.clear.FCol«255 0 0



188 Ul Guide

Reorganising the Menu Structure

This example shows how you may alter the structure of the session menus by adding
a Search menu to the menu bar to provide access to the Find and Find/Replace dia-
log boxes and removing these options from the Edit menu.

To simplify the process, we will first change space into the MenuBar object itself:

)CS [SE.mb
[SE.mb

Then we can begin by adding the Search menu. You can specify where the new
menu is to be added using its Posn property. In this case, Search will be added at pos-
ition 3 (after Edit).

'search'WC 'Menu' '&Search' 3

Next we will remove the Find and Replace Menultem objects from the Edit menu.
Their names can be obtained from [JWN:

‘MenuItem'[JWN'edit'
edit.prev edit.next edit.clear edit.copy edit.paste
edit.find edit.replace

It is worth noting that these Menultems perform their actions because their Event
property is set to execute the system operations [Find] and [Replace] respect-
ively when they are selected.

edit.find.Event
Select [Find]

edit.replace.Event
Select [Replacel

The following statement removes them from the Edit menu:
OEX"'edit.find' 'edit.replace'
and the following statements add them to the Search menu:

'search.find' OWC 'Menultem' '&Find'
('Event' 'Select' '[Find]')
‘'search.replace' [OWC 'Menultem' '&Replace’
('Event' 'Select' '[Replacel]')
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Adding your own Menultem

This example shows how you can add a menu item that executes an APL expression.
In this case we will do something very simple; namely add a Time option to the
Tools menu which will execute JTS. Notice that the statement also defines a Hint.
This will be displayed when you select the option, prior to releasing the mouse but-
ton to action it.

Once again, we will start by changing space into the 7oo/ls menu itself

)CS [JSE.mb.tools
OSE.mb.tools

Then we will define a new Menultem to perform the action we require:

"ts'OWC'Menultem' '&Time'
("Event' 'Select' 'o[TS')
('Hint' 'Display Timestamp')

The ¢ symbol is very important and distinguishes an expression to be executed imme-
diately, as in this case, from a callback function. The resulting Tools menu now
appears as follows:

Explorer...
Search...
Status...

+  AutoStatus

Event Viewer
Properties...
Time

A customised Tools menu

Selecting Time produces the following output in the session:

2007 12 10 17 10 2 O
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Adding your own Tool Button

This example shows how you can add a button to the session tool bar that executes
an APL function called XREF.

XREF analyses the function whose name is under the curosr, listing the names of the
other functions that it calls in a Form.

V XREF;REFS;FN
[1] :If 0<pFN<«'[SE'[WG'CurObj"
[2] :AndIf 3=[NC FN

[3] REFS«[REFS('0SE'OWG'CurSpace'),"'."',FN
[4] REFS<(4REFS)~""
[5] REFS«(3.1=[ONC REFS)/REFS
[6] REFS<«REFS~cFN
[7] :If 0<pREFS
[8] '"F'OWC'Form' ('Functions called by ',FN)
[9] F.FontObj<«[SE.FontObj
[10] '"F.L'OWC'List'REFS(0 0)(100 100)
[11] tEndIf
[12] :EndIf
\'4

XREF [ 1] gets the value of the CurObj property of JSE which reports the name
under the cursor.

XREF [ 3] prefixes this name by its pathname which comes from the CurSpace prop-
erty which reports the user’s current namespace.

To make this function available from a Session tool button, we need to do a number
of things. Firstly, we must install the function in (JSE so that it is always there, regard-
less of the current active workspace. This is easily achieved using the Explorer or
ONs.

'0OSe’ [ONS 'XREF'

Next we will add a new button to the tool bar in the Tools CoolBand. Ideally we
would use a suitable bitmap, but to simplify the example, we will use a standard text
button:

)CS [OSE.cbtop.bandtb3.tb
OSE.cbtop.bandtb3.tb

'xref' [OWC 'Button' 'XREF'
'xref' [OWS 'Event' 'Select' 'e[JSE.XREF'

Tool 2 Fi i= @ | XREF
Adding a tool button

All that remains is to save the new Session.
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User Commands

Dyalog APL includes a mechanism to define User Commands.

User commands are developer tools, written in APL, which can be executed without
having to explicitly copy code into your workspace and/or save it in every work-
space in which you want to use it.

A User Command is a name prefixed by a closing square bracket, which may be
niladic or take an argument. A User Command executes APL code that is typically
stored somewhere outside the current active workspace.

By default, the existing SPICE command processor is hooked up to the user com-
mand mechanism, and a number of new SPICE commands have been added. For
example:

Jdisplay 'hello' (5'world')

7
hello| ‘w

o

£ 0~—7

-€

The implementation of User Commands is very simple: If a line of input begins with
a closing square bracket (]), and there exists a function by the name [JSE . UCMD,
then the interpreter will call that function, passing the input line (without the
bracket) as the right argument.

To add a user command, drop a new Spice command file in the folder SALT\Spice.
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File Explorer Integration
Unicode Edition Only

You can browse the contents of workspaces and Dyalog script files using the pre-
view pane of Windows File Explorer. The following example show what you see in
the preview pane when you select the supplied workspace ddb . dws.

[ } B - | CG\Program Files\Dyalog\Dyalog APL-64 15.0 Unicode\ws

File Home Share View
« “ 4 | ThisPC 5 OS(C) » ProgramFiles > Dyalog > Dyalog APL-84 15.0 Unicode > ws
Dyalog A Name - ~ [# Mame Description
[Fns/Ops]
Dyalog APL-64 14.1 B spleenvice.dws or] Examples 2404 char
Dyalog APL-6415.0 B orachricid i ReadMe 20184 char
. arachnid.dws
* it RefCard 3031 char
aplfmt arachnid.ico p b Nemespace
apltrans £ atfin.cus isp
Base B avuaws display
el 8] bubbles.bmp import
P B buildsedws scripts Namespace
PublicCACerts
B calc.dws test
SALT ] caleultrwmf time
Samples 8] carsbmp
Setup 8] ch2.avi
Syncfusion S congadws
TestCertificates B cprodws
d b
e 1 deomreg.dws
i S ddb.dws
! B dins.dws
st BB display.dws .
UnicodelME v <D < > <

36items  1item selected 267 KB

v| 0

Size
271Kk
38.52Kb
6.023Kb
62.91Kb
153.72Kb
7.03%Kb
14.37Kb
53.62Kb
13.27Kb
4352Kb

Search

Modified en

17/03/2005 19:04
12/03/2005 12:22
18/01/2008 16:40

04/05/2005 10:37
02/11/2001 19:24

(2}
P

Modified by
Dyalog
Dyalog
Dyalog
Dyalog
Dyadic

>

When you move the cursor to the next workspace in the list, dfns . dws, the pre-
view pane is immediately updated to show its contents.

« > ThisPC > OS(C:) » Program Files > Dyalog > Dyalog APL-64 15.0 Unicode » ws
Dyalag A Name - ~ 5 Name
[Fns/Ops]
Dyalog APL-64 14.1 B aplsenvice.dws notes Ehflisky
Dyalog APL-64 15.0 hnid.d t Y
ﬁarac nid.dws scripts NormRand
aplfmt arachnid.ico UndoRedo
spltrans B atfindws %
Base ,@a avu.dws fk
Jd 1
help &l bubblesbmp ace
BB buildse.dws adic
PublicCACerts B coleains alext
SALT # caleultrawmt alrem
Samples 8 cars.bmp a:rar‘ns
- alva
Set &) chavi
uP (8] ch2.vi alvals
Syncfusion b conga.dws ambiv
TestCertificates B cprosus and
w S deomreg.dws apportion
S ddb.dws ary
«flib
5 dins.cws ascan
afsre S display.dws v ascana
UnicodelME ™ <

56items  1item selected 4.88 MB

v O

Description

Search ws

Size
1.873Kb
3.367Kb
1.984Kb
4977Kb
4.285Kb

1.25Kb

Modified an ~
16/06/2015 14:07
07/10/2015 13:53
28/07/2014 15:15
20/05/2014 16:44
21/02/2012 11:13
20/05/2014 16:38
16/05/2005 11:35
29/06/2010 08:54
26/08/2005 16:19
26/08/2005 16:29
26/08/2005 16:22
26/08/2005 16:20
26/08/2005 16:23
29/11/2009 13:29
31/10/2009 09:18
16/06/2013 14:11
06/08/2014 11:33
22/05/2013 08:20
22/05/2013 08:20
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If you open the Fns/Ops node and click on a function name, the function is dis-
played. The next picture shows the function assign.

n B - | C\Program Files\Dyalog\Dyalog APL-64 15.0 Unicode\ws

File Home Share View - @
« < 4 || > ThisPC > 0S(C) » ProgramFiles » Dyalog » Dyalog APL-64150 Unicode > ws v © | searchus F
Dyalog A Name . ~ v [Fns/Ops] ~ assign—{OML~1 P
fk
Dyaleg APL-8414.1 1 apleervice.dws e stepO-{stepi (&I \bpuw)tu} noe
Dyalog APL-6415.0 hnid.d .
1B arechnidus e stepte{step2t(+u)-L/uw} B
aplfmt % arachnid.ice alet
apltrans B atfincws a:rﬁm step2={ .
alrems stars+{ B o»
Base B avudus alval ~lewsa " e
help 5] bubbles.bmp alvals nextes\ ey 5.
B buildse.dws ambiv mask=(rows next)vcols next s
PublicCACerts 1B calc.dws and ) (avnext)v wemask Qe
SALT i B
) calcuttrawmf apportion zeros{u0 stars whu=0 o .
Samples cars.bmp = step3 w zeros Ao
Setup [&] chzavi asean }
ascana
Syncfusion I congadus assign stepd+{costs zeros+w B
TestCertificates £ cprodus at starsezeros=2 b
w S deomreg.dws attrib covers=2xco B
~Decovers:s .
B> ddb.de ol Oecoversist "
i bab, stept costs zeros covers 5>
B dfns.dws ba Y }
UnicodelME wla > N v & e B
-
SGitems 1 item selected 438 ME [EH=

You can also browse Dyalog script files. The following picture shows what you see
when you select the fileUtils.dyalog file.

C:\Program Files\Dyalog\Dyalog APL-64 15.0 Unicode\SALT\tools\code

File Home Share View v @
« « 4 ||« 0S(C) » ProgramFiles > Dyalog > Dyalog APL-6415.0 Unicode > SALT » tools > code ~ & | Searchcode p
Dyalog APL-6414.1 A Name -~ :Namespace fileUtils a ¥1.08 ~
A This nemespsce contains various file véilities. Some requik
Dyaleg APL-6415.0 ) A+SF.dyalog R 2015 05 19 Adsm: dywftt domain note, replfxpr properly retw
e A 2015 06 22 Adems Fixed confusing comment typo
eplfmt  eplutitsdyalog @ 2015 10 31 DanB: filesIn was returning ore Files than necw
apltrans _ bigstring.dyaleg A 2015 17 13 DanB: changed dywiss te FileT5toQTS
Base 7 callingTree.dyalog
help ) codecov.dyalog Oro-fimi~t
PublicCACerts ) compare.dyalog BigEndian—/83 Odr 256
" fileUtils.dyalog
SALT 7 tistsUtils.dyalog [ol ¥ Chars=ReadFile name;nid;signature;nums
core - ) [1] A Read ANSI or Unicode character file
) miscUtils.dyslog [2] s2+[NSIZE nidename ONTIE O
lib 7 partScan.dyalog [3] signature~{JNREAD nid 83 3 0
spice ] Regex.dyalog [4] :IF signature="17 T69 ~65 A UTF-47
e [5] ms-ONREAD nid 83 sz
study * textrils.dyalog 6] ~'UTF-8°0UCS 256 Inums R Signed infs
tools | Windows.dyalog [71 tElself v/b-(2tsignature)a.=2 2p71 "2 "2 a Unicode (UTw
[8] (2, puw)pu}¥(4/b)INREAD nid 83 sz 2
code o] ~'0TF-16'0UCS(2+16} 1163 ODR Chars
data [10] :Else a ANST or UTF-8
[11] ree{11::0UCS w & 'UTF-B'0UCS w}256I0NREAD nid 8w
Inet [12] .
- EeE]
special ol N

13items  1item selected 206 KB =

Note that you may only view workspace objects and scripts in the preview pane, it is
not possible to edif them in the preview pane.
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Editing Dyalog Scripts

You may edit a script file from File Explorer by first selecting the script file and then
choosing Edit from the File Explorer context menu.

Home  Share  View
<« v 4 ]« togls » code v|® | Searchcode »
Dyalog A Name -
Dyalog APL-64 14.1 Unicode 7 AeSFdyslog
Dyalog APL-64 15.0 Unicode ] oplUtils.dyalog
aplfmt 7 bigstring.dyalog
apltrans 7 callingTree.dyaleg
Base 2 codecov.dyalog
el 7 compare.dyslog
 fileUtilsdyalog
Open 1 listsUtils dyalog
L [ miscutils.dyalog
7-Zip > [ partscan.dyalog
CRC SHA > [ Regexdyalog
Scan with Windows Defender. [ textUtils.dyalog
Convert with FLV Converter [ Windows.dyaleg
1 Play with FLV Player
Open with...
¥ Norton Internet Security >
& TortoiseSVN >
Restore previous versions
Sendto >
Cut
Copy
Create shortcut
% Delete
& Rename
Propeties
s < >
T3items 1 item selected 206 KB EH=

This brings up the standard Dyalog Editor, in a stand-alone window, just as it would
appear ifundocked from the Session, as shown in the next picture.

File Edit

I= @ & Q|[search... B e @Eaalt e s

Syntax  Refactor View

5-#. [Nemespace].(| iNamespace fileUtils a V.08 ~
i [Dfns] & This namespace contains various file wiilities. Some require .Net.
[Methods] & 2015 05 19 Adams: dywftt domein note, repléxpr properly returns number of changes (not files), fileRename ¥
G 2015 06 22 Adam: Fixed confusing comment typo
@ 2015 10 31 DanB: filesIn was returning more files than necessary and removed folders from result
G 2015 12 13 DanB: changed dywtss to FileTSto@rs
Dio-Oml+1
BigEndian~/83 [dr 256
[0] v Chars=ReadFile name;nidssignaturesnums;szib
[1] f Read ANSI or Unicode character file
[2] sz+[NSIZE nidename ONTIE O
[3] signature~[INREAD nid 83 3 0
[+] = +IFf signature="17 “69 "65 A UTF-82
[5] nums~{INREAD nid 83 sz
[6] s='UTF-8'0UCS 256Inums A Signed ints
[7] iElseIf v/b=(2tsignature)a.=2 2p"1 ~2 ~2 R Unicode (UTF-16)
(8] Chars={,$(2,52+%pu)pu}¥(+/b)INREAD nid 83 sz 2
[91 ~'UTF-16'0ucs(2+16) | 163 ODR C
[10] ANSI or UTF-§
[11] s={11::0UCS w ¢ "UTF-8'0UCS w}256I0NREAD nid B3 sz O
[12] | 1EndIf
[13] ONUNTIE nid
[14] L v
(0] v {formet}Writefile(nzme s)inidssignaturesnums;typ
[1] " Write ANSI or Unicode character file
[2] R format = ANSI, UTF-8 or UTF-16
[3] OSIGNAL(x10]typ=DR chars)fc('EN' 11}('Message’ 'Does not work in Classic APL')
(4] B :If 0=0NC'format'
[5] format='ANSI' "ANSI' 'UTF-16'2%80 82ityp
[6] iElse
[7] format='ANSI' ‘UTF-8' ‘UTF-16" 'UTF-8' 'UTF-16' '7'=5'ANSI' 'UTF8' 'UTF16' 'UTF-8' 'UTF-16'tefor »
[8] OSIGNAL(format='?')/<('EN' 11)('Message’ 'Invalid file translation format')
[9] | 1EndIf
[10] = :Trap 22
[11] [IJ nid-name [NCREATE 0 v
. | T, R
Namespace

Pos: 0/450,0
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Index

NET Classes
exploring 98

A

ActiveXControl object 71
aedit User Command 39
aligning comments 135
APL fonts 187
Array Editor 39, 66
assemblies

exploring 98
auto_pw parameter 32
AutoComplete 30

B

Browse NET Assembly dialog box 99

C

class constructor 102
Classes
browsing 82
Classic Dyalog mode 154
multiple trace windows 163
single trace window 164
Classic Edition 51,69
ClassicMode parameter 120
ClassicModeSavePosition parameter 120
CloseAll system operation 52
collapsing outlines 132,137,142
compiler errors 132
configuring the session 186
Constructors folder 102

context menu 28

Create (session event) 180
CurObj (session property) 5,181
CurPos (session property) 181
Current Object 5

CurSpace (session property) 181

D

Debugging Threads 169
default wx parameter 57
deleting lines 29
Docking 23

E

edit_cols parameter 117, 120
edit_first x parameter 117,120
edit_first y parameter 117,120
edit_offset x parameter 117,120
edit_offset y parameter 117,120
edit_rows parameter 117,120
editor

class treeview 132,143

collapsing outlines 132

compiler errors 132

edit menu 127

editing classes 141

expanding outlines 132

file menu 124

function line numbers 132

invoking 115

outlining 132,136

refactormenu 131

sections 144

syntax menu 129

toolbar 122

using 133

view menu 131

windows menu 130
Editor

aligning comments 135
endsection statement 138, 144
Enums 97
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Event (session property) 182
Event Sets 96
Events
SessionPrint 184
WorkspaceLoaded 185
executing expressions 31
execution (tracing) 161
expanding outlines 132,137,142

F

File (session property) 182
file explorer integration 192
find and replace dialogs 147
Find Objects Tool 106

Font (session property) 182
function line numbers 132

H

Handle (session property) 181
HintObj (session property) 182

I

ILDASM 98

IME Configuration 7

Input (session property) 181
input codes 16

input line 29

interrupt 6

K

keyboard layout
line-drawing 13
traditional 12
unified 10

keyboard shortcuts 2, 14

L

language bar 30

line-drawing characters 13
line numbers 132-133
Log (session property) 181

M

Metadata 98, 100
Methods folder 104
mouse

using in session 4

N

NET classes 98
Net Metadata 87
New method 102

(0]

Object CoClasses 91
Object Properties
COM Propertiestab 113
Monitortab 112
Net Properties tab 114
Properties tab 110
Value tab 111
Objects 93
OLEClIient object 87,90
OLEServer object 71
outlining 132,136

P

page width 32

Popup (session property) 182
Posn (session property) 182
private 102

Properties folder 103
PropertyExposeRoot parameter 57
PropertyExposeSE parameter 57
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S

section statement 138, 144
session

configuring 3,186

deleting lines 29

file menu 47

help menu 59

options menu 56

popup menu 61

session menu 53

status bar 69

status field styles 69

threads menu 58

tools menu 57

value tips 33
session action menu 54
session colour scheme 20
session log 22,29
session log menu 54
session menubar 47

action menu 54

edit menu 50

file Menu 47

help menu 59

log menu 54

options menu 56

session menu 53

threads menu 58

tools menu 57

view menu 52

windows menu 52
session object 3,22,53
session statusfields 70
session toolbars 64

edit tools 67

object tools 66

session tools 68

tools tools 67

workspace tools 65
session_file parameter 4,22, 180
SessionOnTop parameter 120
SessionPrint 180, 184
SharpPlot Graphics Tools 42, 66

Show trace stack on error 153
Size (session property) 182
SPICE 191

State (session property) 183
Status window 23,71

system operations 4, 53,188

T

Threads Tool 165
TipObj (session property) 183
trace tools 156
Trace on_error parameter 153
tracer
automatic trace 153
break-points 162
Classic Dyalog mode 154
controlling execution 161
invoking 153
naked trace 153
tracing an expression 153
treeview 132,143
Type Libraries 79, 87

U

underscored characters 10

Unicode Edition 69

User Commands 191
aedit 39

A%

value tips 33

view menu
editor 131
session) 52

Visual Styles 64

W

white space 135
WorkspaceLoaded 180, 185
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